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Abacus Introduction

Introduction

There are two groups of people who use computers. The first group

already knows a lot about computers. The second group lacks previous

experience with computers. Commodore designed the Amiga for both

types of computer users.

Most computer manuals aren't written with the absolute beginner in

mind. That's where this book comes in. Here you'll find ideas, tips,

suggestions and more to help you learn about your Amiga.

There are three types of Amigas. The original model, the Amiga 1000,

is no longer manufactured by Commodore Amiga. The Amiga 500 is a

self-contained unit, with a disk drive, central processing unit and

keyboard built into one case. The largest model, the Amiga 2000, has

similarities to both the Amiga 500 and Amiga 1000, except that the

2000 can be made compatible with the IBM PC. The Amiga for

Beginners was written specifically for Amiga 500 and Amiga 1000

owners.

With this book are programming examples as well as instructions for

connecting and operating the Amiga. Programming isn't just for

programmers. This book shows you the basics of simple programming

for your Amiga.

The Amigafor Beginners helps you understand all you need to know as

an Amiga owner, and hopefully entertain you as you learn.

Christian Spanik

Dtisseldorf, February 1987
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Abacus 1. Starting out

i. Starting out

This chapter shows you how to unpack and assemble the components

of your Amiga. Youll learn what components should be in the package

when you open it, how they are connected, and how to torn your Amiga
on and off. This chapter also describes what goes on inside the Amiga.

Instructions appear in the book like this, indicating that you must

perform this step.

Many words appear in the course of this book that you may not

recognize. These new words appear in italics when first mentioned. The

author defines these unknown words in the Appendices which appear

towards the back of this book.



1. Starting out Amiga for Beginners

1.1 Unpacking and setup

Be very careful when you unpack the Amiga. Three polystyrene

cushions in the carton protect the Amiga from damage during

transportation. These cushions can break if you unpack the Amiga

carelessly.

• Open the Amiga carton and remove the polystyrene cushions.

The Amiga carton contains the following:

A centralprocessing unit with an internal disk drive

A keyboard (either separate or connected to the central processing

unit)

A coiled grey cable for connecting the keyboard to the central

processing unit (if you have an Amiga 1000)

A mouse (a hand-sized box with two buttons on it)

A couple of diskettes

Apower supply (Amiga 500) or apower cord (Amiga 1000)

If you don't find all of these things, search the box again. If you still

don't find everything, then contact your dealer about the missing

equipment

Open the monitor (video screen) box, if you bought a monitor. Remove

the top polystyrene cushions and take the monitor out of the box.

Place the central processing unit on a table, allowing about 1 square

Assembling foot of free space around it. If you have an Amiga 1000, which has a
the Amiga small cooling fan, make sure that the fan outlet in the back is clear.

There are air vents in different places on the Amiga models. Keep these

clear as well, because they keep the Amiga running cool.

For Amiga 1000 owners only (Amiga 500 users can continue at the

paragraph called Preparing the mouse):

• Take the keyboard cable (the coiled cable with the clear plastic

plugs)

• Plug the "straight" end of the cable into the jack at the rear of the

Amiga 1000's central processing unit (the jack has a keyboard icon

above it).
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• Feed the cable under the central processing unit and through the

notch underneath the unit

• Plug the free end of the cable into the keyboard.

• Pick up the mouse (the small box with the two buttons on top)

Preparing and turn the mouse upside down.
the mouse

You'll see a ball poking through a hole in the bottom. You must

remove the piece of foam holding the ball in place before the mouse can

be used.

Press on the plastic cover holding the ball, in the direction

indicated by the arrows molded into the plastic. Push until the

cover opens.

• Remove the foam and put the ball back into the mouse.

Slide the cover on by pushing it in the direction opposite the

arrows.

The mouse cable goes into a connector located on the back of the

Amiga 500. The Amiga 1000's mouse connectors are on the right hand

side of the central processing unit Note that there are two of these

connections. The first connector is marked with either 1 or 1

JOYSTICK, and the second one has either 2 or 2 JOYSTICK

above it.

• Plug the mouse into the first joystick connector (marked 1 or 1

JOYSTICK).

Make sure that you have a minimum of 6M by 6" of table space

available for operating the mouse.

• Connect the monitor.

The Amiga accepts three types of monitors:

1. Commodore RGB monitor.

This monitor gives the best picture. It is recommended for those

who use the Amiga seriously and regularly. The monitor

includes a special connecting cable with plugs on each end; one

of these plugs is wider than the other. The wider plug connects

to the Amiga's RGB connector, marked by a monitor symbol

with three circles (more about RGB later). Two small bolts on

the plug fasten the cable to the Amiga once the plug is in place.

The Commodore RGB monitor packaging also has a Y connector

and an audio cable for the audio inputs. The Y connector plugs

into the two jacks at the rear of the Amiga marked L-AUDIO

and R-AUDIO. You'll find these jacks to the right of the

mouse connections (Amiga 500) or the PHONE connection
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NOTE:

Power

(Amiga 1000). The audio cable plugs into the AUDIO jack in
the monitor.

2. Monochrome (black and white) monitor.

The MONO output of the Amiga delivers a composite signal.

That is, the various data, such as color information, picture

information and synchronisation signal, are combined into one

signal. The monochrome signal requires only one cable.

3. A black and white or color television set

For this you need a modulator and an appropriate cable. See the

modulator manual for connection instructions. Otherwise, if you

have a television set that can also function as a composite
monitor, you can connect the television through the MONO

jack on the Amiga. The disadvantage is that color televisions run
through the MONO jack only show monochrome signals.

If your television has no composite video input, or if you prefer seeing

Amiga output in color, you'll need a box that allows RGB video

transmission through a television. This box is the Amiga

modulator 520, When this book was written, the modulator wasn't

available yet for the Amiga 500. Check with your dealer. Also, if you

bought a non-Commodore monitor, you'll need a Y cable and an audio

cable for connecting your monitor to the Amiga's sound output. You
can buy these at any electronics store.

Computers need power to run. Your Amiga operates under normal

house current:

For Amiga 500 owners:

• Make sure that the power supply is switched to 0 (OFF).

• Take the power supply (the box with a cable running from either

side).

• Plug the small square plug into the matching jack in back of your

Amiga 500, and plug the other end into an electrical outlet.

For Amiga 1000 owners:

• Make sure the power switch on the central processing unit is

switched to 0 (OFF).

Take the gray power cord.

• Plug the small square end into the jack marked POWER.

• Plug the other end into your electrical outlet

10
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Your unpacked and connected Amiga looks something like this:

Figure 1:

Assembled

Amiga 500

NOTE:

You may want to purchase a power strip (a multiple-outlet board)
which lets you connect all the electrical equipment to one electrical

outlet.

11
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1.2 Amiga hardware

Central

processing

unit

Disk drives

Mouse

Commodore
monitor

Before you turn the Amiga on, you should learn something about all

the equipment that make up the Amiga. These individual units are

hardware. That is, they are physically here, unlike software, or

programs, which exists but can't be touched.

This book mentioned the central processing unit, or CPU, a number of

times in Section 1.1. This is the computer's brain. This housing

contains the memory chips and basic technology the Amiga needs for

operation. The central processing unit is either a self-contained unit

with built-in keyboard (Amiga 500) or a large box (Amiga 1000).

The Amiga has two LEDs (light emitting diodes). The Amiga 500

LEDs are above the keyboard, beneath the AMIGA brand name. The red

LED marked POWER lights up when the power is on. The green LED

marked DRIVE lights up only when the disk drive runs. The Amiga

1000, has these LEDs on the left and right front of the central

processing unit The left LED lights up when the power is on; the right

LED lights up when the disk drive is operating.

The disk drive built into the Amiga allows you to store and recall

programs and files. This disk drive uses 3-1/2" floppy diskettes. These

diskettes are square plastic cases containing thin plastic magnetic disks.

These diskettes can be bought at any computer store. Look for a slot on

the right side (Amiga 500) or front (Amiga 1000) of the central
processing unit; that's your disk drive.

The mouse is the key to the Amiga's friendliness. You'll use it

constantly for operating the computer. Once the Amiga is up and

running, the Amiga displays the mouse on the screen as an arrow

pointing up and left. This arrow is called the mouse pointer. It moves

around the screen in the direction you move the mouse on the table.

You can then select certain items by using the two buttons on top of

the mouse. See Chapter 2 for detailed instructions on mouse operation.

The keyboard looks like the keyboard you find on any typewriter, with

a few extra keys (more on these keys later).

When you look at the front of the Commodore monitor closely, youll

notice a cover running across the bottom of the monitor's front. There

is a small notch directly below the AMIGA logo or Commodore

nameplate. Reach into the notch with your finger and pull down. The

cover flips down, revealing the various control knobs:

12
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The first knob controls the picture's horizontal position. The second
H.PosI knob adjusts the vertical position. These exist on television sets as

V.Hold horizontal hold and vertical hold.

The next two knobs control color intensity. If you move them, youll

Color/Tint discover that they easily lock into one particular position. That is the

central position.

The next two knobs control picture brightness and contrast. These have

BrightlCont locking central positions like the Color and Tint knobs.

The next knob adjusts the volume. It doesn't need a central position,

Volume since you'll hear immediately if it's set too high.

This switch has three positions: RGB, SEP and COMPOSITE. The

Video Mode RGB postition is the normal setting.

13
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1.3 Interfaces and
expansion

This section describes the remaining hardware interfaces (connections)
of the Amiga.

The Amiga 500 has 512K of memory. Both the Amiga 500 and 1000
have connectors for later memory expansion.

Joysticks and lightpens can be plugged into your Amiga through the
two mouse connectors.

There is a recessed connector on the left side of the Amiga 500, called

the expansion bus. Any hardware expansion added later, such as

memory expansion or hard disks, plugs into this bus.

• Turn the Amiga around if you can, so you can see the rest of the

hardware interfaces.

You are already familiar with the RGB connector, power connector,

MONO connector and audio connectors. The parallel connector, or

Centronics interface, is used mainly for printer interfacing. A printer

symbol above the connector identifies this port. The Amiga easily

connects to other equipment; the Centronics interface connects to

almost any printer. All the information you need to connect the Amiga
to a printer is stored on the diskettes that came with your Amiga. These

printer drivers support three color printers as well as a number of black-

and-white printers. These printers are: Alphapro 101, Brother HR-

15XL, CBM MPS-1000, Diabolo 630, Diabolo Advantage D25,

Diabolo C-150, Epson FX/RX series, Epson JX-80, HP LaserJet, HP

LaserJet Plus, Okidata 292, Okidata 92, Okimate 20 and Qume
Letterpro 20. A generic printer setting also exists.

^ If your printer isn't on the above list, most printers are Epson
TVCM h : compatible, since many companies consider Epson the standard printer

configuration. Try the Epson printer driver before you try any other

printer driver (see Section 2.10 [Preferences] for more information). If

you haven't bought a printer yet, ask your dealer if he knows whether

the Amiga has a printer driver for the printer you plan to buy. Or ask

your dealer whether the printer will work with the generic driver.

14
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Before you connect any printer, or before you use any printer cable, talk
CAUTION: to your dealer first Some pins (the little metal prongs inside the plug)

carry up to 5 volts of electrical current. One wrong connection could
seriously damage your Amiga. Also, be sure you buy a printer cable
specifically for your Amiga (a cable for Amiga 500 or Amiga 1000,
etc.). The best thing to do is tell your dealer you want a printer cable

for your Amiga model, not just an Amiga.

The disk connector stands to the right of the audio connectors. This port

accepts an external Amiga disk drive.

The serial connector is to the right of the disk connector. The serial port
connects a modem to the Amiga. Modems (short for modulator/

demodulator) allow you to exchange computer data by telephone lines.

Some printers also use the serial connector.

15
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1-4 Booting the Amiga

NOTE:

NOTE:

If you connected everything according to the descriptions in Section
1.1, you're ready to turn on, or boot up, the Amiga.

• Turn the monitor on (see your monitor manual for instructions)

• Turn the Amiga on. The Amiga 500 power switch is on the power
supply; the Amiga 1000 switch is on the left side of the central
processing unit.

The screen blinks and goes gray. The Amiga performs a self-test
(checks itself out to see that everything is in working order). Eventually

a picture appears on the screen—a hand holding a diskette named either
Workbench or Kickstart. The Amiga 1000 model needs this Kickstart
diskette to supply it with some basic operating information.

The Amiga 500 has this Kickstart information built into the computer,
so it doesn't need this diskette. Whenever you see a reference like "insert
the Kickstart diskette", here or in any other book, ignore it and go to
the next set of instructions.

For Amiga 1000 owners only:

• Take your Kickstart diskette, making sure that the label is up and
the metal part of the diskette faces the drive.

• Push it gently in the disk drive.

A picture appears on the screen—a hand holding a diskette named
Workbench.

• When the drive stops, press the button underneath the disk drive
slot. The diskette partially ejects.

• Remove the partially ejected Kickstart diskette.

For all Amiga owners:

• Insert the Workbench diskette. The Amiga automatically loads the
Workbench from this diskette.

Never eject a diskette while the disk drive is in operation (the drive

light is on). The Amiga may destroy the contents of the diskette.

16
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The Workbench diskette

This chapter explains the concept of Intuition, the Amiga user

interface. Along with Intuition are instructions for using the

mouse, and the basic terms used in connection with Intuition, such

as icons, drawers, windows, pulldown menus and menu items. The

main subject of this chapter, though, is the diskette you'll use most

often in the Amiga; the Workbench diskette.

This chapter also leads you through the contents of the different drawers

in the Workbench diskette. You'll learn how to put information into a

program, format diskettes, copy diskettes, set a clock, and even change

the Amiga's screen colors.

Youll also use the Amiga's utilities in this chapter. The Notepad and
Calculator are practical utilities for the user interested in adding

things up or scribbling notes.

Most important, you'll learn how to make a backup of your Workbench

diskette. You should use the original diskettes that came with your

Amiga only when absolutely necessary. Backing up diskettes gives you

copies of original diskettes that you can use without worrying about

possibly destroying the original data.

19
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2.1 Intuition

As the Amiga boots for the first time, a white border around a blue

screen appears. The top part of this border displays the words

AmigaDOS. The disk drive runs and the following is breifly displayed

on the screen, your screen display may differ:

Copyright © 1985, 1985 Commodore-Amiga, Inc.

All rights reserved.

Release 1.2

A500/A2000 Workbench disk. Release 1.2 version 33.xx

This is the Startup-Sequence which loads (or boots) the Workbench

program.

A computer is dumb. And it stays dumb until a program tells it exactly

Operating what to do. This is true of any computer. One of these programs
system permanently resides in the Amiga 500's memory. When you switch the

Amiga 500 on, this program tells it how to do certain basic chores,

such as what diskette it needs next (these are the chores handled by the

Kickstart diskette in the Amiga 1000). This "housekeeping" program is

called the operating system.

Software, or programs, tell the Amiga to perform a certain sequence of

commands in a certain order. The first software the Amiga 500 reads is

from the Workbench diskette when booting up. As the Workbench

loads, the Amiga tells time, senses whether an external disk drive is

connected, computes the amount of available memory and more (see

Chapter 4 for more information).

Intuition, loaded during the Workbench booting process, has the

Intuition most influence on your work and play with the Amiga. Intuition is

a user interface. A usej interface acts as the simplest form of

communication between man and computer. This is important, since

Intuition is part of the operating system. It displays text, windows

and graphics on the screen. Intuition stays in the background as it

does its work. You can open many windows at once, and perform

different tasks in these windows. You can display graphics in one

window, calculations in a second and text in a third, all at the same

time. Like the desk in your office, Intuition lets you open drawers,

page through your work, or watch the clock.

After the Workbench loads, the following appears on the screen:

Amiga Workbench. Version 1.2. 406400 Free Memory

20
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Icons

These numbers may be different from the numbers that appear on your

screen. The amount of free memory changes because of memory

expansion, the number of disk drives in use, and the number of screens

in use.

When the Workbench finishes loading, a blue screen appears with the

words Workbench Screen in the top white border. This top border is

called the title bar. You'll see two drawings of diskettes at the right of

the screen. These drawings are called icons. Intuition draws icons,

which are the basis of the Amiga's operating system.

Each disk drive icon has a name. One drive icon is currently called

Workbench 1.2, and the other drive icon is named RAM Disk. If

you have an external disk drive connected to the Amiga, and this

external drive has a diskette in it, a third diskette icon appears below the

first two. The name under each diskette icon describes the title of the

diskette currently in that drive.

The mouse pointer described in Section 1.2 appears in the upper right

corner of the Workbench screen.

21
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2.2 Mouse control

NOTE:

Moving the

screen

If you've never worked with a computer mouse before, it takes a little

practice at first. This section helps you perform your first mouse input.

Clear some space on the table or desk on which your Amiga is set

up.

Put your right hand on the mouse so that its two buttons face up

and the wire leading from the mouse to the Amiga points away

from you. Your forefinger and middle finger should rest on the

buttons.

Move the mouse, keeping the bottom of the mouse in contact with

the table.

The pointer on the screen moves in the same direction as the mouse.

Moving the mouse away from you moves the pointer up on the screen;

moving the mouse toward you brings the pointer down. When this

book tells you to move the mouse in a certain direction, move your

mouse so that the pointer moves in this direction.

• Move the mouse so that the pointer moves somewhere onto the

blue field of the screen.

Press each mouse button once.

Nothing happens, not even when you move the mouse at the same

time. There is an exception to this rule:

Move the pointer up until it rests on the title bar (the white bar

running across the top of the screen).

• Press and hold down the left mouse button.

• Move the pointer.

The entire screen moves. If you move the mouse down, the screen

moves down as well. If you move the entire screen down, youll see

that there is nothing behind the screen. Everything, including the title

bar and the mouse pointer, disappears below the screen.

Move the whole screen downward, then release the left mouse

button.

• Now try to move the pointer up onto the screen.

22
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Workbench

pulldown

menu

NOTE:

Nothing happens. As long as you move the mouse without pressing

the left mouse button, the pointer cannot move up.

• Press and hold the left mouse button, and move the pointer up.

The screen moves back up. You can move almost the entire working

surface in this way. Advantages of moving screens appear in the next

few pages.

Move the pointer up onto the large blue field again and press the

right mouse button.

Watch the title bar change. As you press the right mouse button, three

words appear—Workbench, Disk and Special. Whenever

you press the right mouse button while in the Workbench screen, these

words appear at the top border. This top border is called the menu bar,

because it lists menu titles.

• Press and hold the right mouse button and move the pointer up

onto the word Workbench.

If you run out of room for mouse movement, and the pointer still

hasn't reached its target, lift the mouse off the table, and put it on the

table a little closer to you. Now you can continue moving the pointer

up.

When the tip of the pointer reaches the word Workbench, a set of

words appear below the word. This set is a pulldown menu, because it

pulls down like a window shade. Each word in a pulldown menu is a

menu item, or item for short.

• Keep holding down the right mouse button (this keeps the

pulldown menu open).

Move the pointer onto the Workbench menu title.

• Move the pointer up and down inside the Workbench menu.

You select items this way. Even when you leave the pulldown menu,

the Amiga keeps the pulldown menu open until you release the right

mouse button.

Move the pointer out of the open Workbench menu.

Move the pointer onto the word Disk.

As soon as the pointer reaches Disk while the right mouse button is

pressed down, the Disk pulldown menu appears. Any previously open

pulldown menus close automatically.

23
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Keeping the right mouse button depressed, move the pointer to the

word Special.

You'll note that two items in the Special menu Redraw and

Version, appear in clearer print than the others.

• Move the pointer from the word Special to the Redraw menu

item.

Redraw behaves differently from the gray items in this pulldown

menu. When you move the pointer over Redraw, its letters and

background change colors.

• Release the right mouse button.

Select a menu item from a pulldown menu by moving your pointer to

Select the desired item and releasing the right mouse button. The term select is

used throughout this book to refer to the procedure above.

If you look at the screen, you'll notice that the disk icons flickered

slightly. Redraw recreates the current screen if the Amiga screen

display malfunctions. Although this shouldn't happen, but could,

Redraw is a function available virtually anytime.

The Last Error item works in a similar way. As soon as the Amiga

displays an error message on the Workbench screen, the message

appears in the title bar until a mouse key is pressed. If you accidentally

press a mouse key without reading the error message, select Last

Error to redisplay the error.

You can select any easily read menu items. The gray, poorly visible

items on the screen cannot be accessed at the moment These gray menu

items are called ghost items. A good rule of thumb is: If you can read it

clearly, you can select it.

You now know how to recognize an available menu item, and how to

select an available menu item.

You can move the pointer around from the keyboard as well as with the

Keyboard mouse. Look at the bottom part of your keyboard. Two keys stand to
pointer the left and right of the spacebar (the long key at the bottom of the

movement keyboard). The key on the left has either a C= or an A painted on it;

this is the <Commodore logo> key, also called the left <Amiga> key

on some Amiga models. The key on the right has an A painted on it;

this is the right <Amiga> key. This book refers to <Commodore logo

and right <Amiga> keys, so when the book tells you to press the

<Commodore logo> key and you only have a left <Amiga> key, press

the left <Amiga> key instead.

Four keys with arrows stamped on them stand between the typewriter

keyboard and the numeric keypad. These arrow keys are the cursor keys.

Ghost items

24
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The <Cursor up> key's arrow points up, <Cursor left> points to the

left, <Cursor right> to the right and <Cursor down> points down.

Move the pointer to the bottom edge of the screen.

• Press and hold either the <Commodore logo or right <Amiga

key>, then press and hold the <Cursor up> key.

The pointer moves straight up without even touching the mouse. The

pointer moves slowly at first, then picks up speed.

• Press each of the other cursor keys while holding either the

<Commodore logo> key or the right <Amiga> key.

Hold the cursor key down to move the pointer quickly. Pressing the

NOTE: <Caps Lock> key makes the pointer move even faster. The <Caps
Lock> key is on the far left of the keyboard, diagonally above the

<Commodore logo> key. Remember to press the <Caps Lock> key

again when you no longer need it (the <Caps Lock> key is active when

the red LED built into the key is on).

You can activate the menu bar by pressing the right <Amiga> key and

the right <Alt> key at the same time. Select the Redraw item from

the keyboard as follows:

Press and hold the right <Amiga> key and the <Alt> key.

• Move the pointer with the cursor keys until the pointer is on

Special.

• Move the pointer to Redraw with the cursor keys.

• Release the right <Amiga> key and the <Alt> key to select

Redraw.

Intuition is mouse-oriented, so this book concentrates on using the

mouse.

Press and hold the right mouse button, and move the pointer to the

Special menu title.

• Move the pointer down to the item named Version and release

the right mouse button.

A message appears in the title bar telling you which version of the

Workbench diskette is currently in use. The title bar displays this or

something similar to it:

Kickstart version 33.180. Workbench Version 33.56

Your version of Workbench may be different from this: Any version

above 33.56 works well.

25



2.2 Mouse control Amiga for Beginners

Version makes it easy to distinguish between Workbench diskette

releases. The higher the version number, the more recent the version. If

you have any version less than 33.56 (33.47, for example), take it back

to your Amiga dealer to get a copy of the latest Workbench.

Looking at the contents of a diskette isn't the same as ejecting the

diskette from the disk drive and looking at it. Intuition lets you

view, access and organize a diskette.

The diskette icon on the screen shows you which diskette is currently in

your drive. But what can you do with it? You could move the icon

around, for example. As mentioned earlier, the Amiga can be thought of

as an electronic desk: You can move things around to get a better view,

reorganize things and put extra objects away, just as you do with a real

desk and office space.

• Move the pointer to the Workbench diskette icon, press and

release the left mouse button.

The act of pressing and releasing the left mouse button when the

Clicking pointer is on an icon is called clicking. Clicking normally selects
icons icons. Clicking the diskette icon changes its color to black, signifying

that the icon is active.

Aside from turning black, the diskette icon does nothing. Even when

you move the pointer, nothing happens. If you click the left mouse

button on the blue field, the diskette icon turns white again.

• Move the pointer onto the Workbench diskette icon.

• Press and hold the left mouse button.

• Move the pointer and release the left mouse button.

You selected an icon, clicked on it and moved it to another place on the

screen. Moving an icon or symbol with the mouse is called dragging.

The Amiga turns a selected icon black. This principle applies to all

Amiga icons. This book uses the word active to describe a black icon or

word.

• Activate the Workbench diskette icon by clicking on it.

• Select the Info item from the Workbench pulldown menu.

The disk drive operates, and a black box appears on the screen. The title

Info bar on the top of the screen reads Info Release 1.2.

The Info window is used to supply information. It lists diskette data

such as whether a file is read-only (you can't add data to the file). It also

tells the memory available on a diskette, memory in use, and a few

other things. Here's a typical Info window:
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Figure 2:

Info

window

Notice since you activated the Info window, the Workbench

window has changed its title to Info release 1.2 as well. Before

you can see what is in the Workbench, you must close the Info

window.

Move the mouse pointer to the small white box in the upper left

corner of the Info window. This box has a black dot in its

center.

Click on that square with the mouse.

The square is a close gadget. Close gadgets close the currently active

window when you click in them. Most (not all) windows have a close

gadget

Your Workbench screen returns. One thing changes, though—the

amount of free memory lowered since the last time you looked at it.

• Select the Info item from the Workbench pulldown menu.

The Info window returns without any diskette activity. The Amiga

remembers the info from you opening the diskette before. This requires

a little memory space, and the memory indicator shows exactly how

much memory is left.

Close the Info window again by clicking on its close gadget.
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2.3 Windows

Opening the

Workbench

window

Now that you have a little experience with opening icons and Info

windows, you can open the Workbench window.

• Click on the Workbench diskette icon so that the icon turns

black.

Select the Open item from the Workbench pulldown menu.

The disk drive begins to run. The mouse pointer changes into two

clouds with Zs drawn on them. This pointer is the wait pointer, and

tells you that the Amiga is busy. After the wait pointer changes back

into the regular mouse pointer, a window appears on the screen.

You opened the Workbench window by selecting the Open item.

This window contains drawer icons, a clock, a trash can and a question

mark standing in front of a box. Before you look at the contents of the

window, look at the window itself:

Figure 3:

Workbench

diskette

window and

components

Close

gadget

Title bar

Scroll arrow Scrollbar

Sizing gadget

You should recognize the close gadget in the upper left corner of the

window.

• Move the pointer onto the close gadget and click on it.
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Double-
clicking

The window closes, and the blue Workbench screen returns. The
Workbench diskette icon turns white again. Selecting the close gadget

signals the Amiga to close the window.

There's an easier and faster way to open diskettes and programs than

using the Open item. Icons also open if you move your mouse pointer
onto an icon and press the left mouse button twice in rapid succession.
This process is called double-clicking.

• Move the pointer onto the Workbench diskette icon.

• Press the left mouse button twice in rapid succession (double
click).

The Workbench window opens. At the top of this window is a
close gadget and the name Workbench 1.2 in ghost print.

\m if* t- Gadgets in a window can appear in ghost print, indicating an inactive
Multitasking gadget. The ghost print in Workbench 1.2 means that the window

itself is inactive. The reason for this difference is the mouse pointer.
The multitasking system of the Amiga causes this difference in active

and inactive windows. Intuition recognizes the window in which

you are working, because clicking the mouse while in one window can

have a completely different effect from clicking it in another. Active and

inactive windows help the Amiga avoid conflicts between programs.

• Move the pointer anywhere inside the Workbench window, and

click the left mouse button.

This activates the Workbench window.

Look closely at the top border. You can now easily read the

Workbench window title. Note the two horizontal lines next to the

window title. This top border is the drag bar, which allows you to drag
(move) the window around on the screen.

• Move the pointer onto the drag bar of the Workbench window.

• Press and hold the left mouse button.

Move the mouse around.

• Release the left mouse button when the window is in the desired
position.

An orange border appears as you move the mouse with the button

depressed. This border helps you see whether the window you're moving

would cover over any other windows. The entire window reappears
when you release the left mouse button.
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Front I back

gadgets

More front

and back

Look at the upper right corner of the Workbench window. These
two pairs of boxes control the foreground and background status of the

window. The left pair of boxes is the back gadget, and the right pair of

boxes is thefront gadget.

• Move the pointer onto the Empty drawer icon.

• Double-click on the Empty drawer icon to open it

A new window named Empty opens. The ghost print tells you that

the Empty window is inactive.

• Move the pointer onto the Empty window, and click on the

window to activate it.

• Move the pointer onto the drag bar (the top border) of the Empty

window, press and hold the left mouse button.

• Drag (move) the Empty window so that it blocks part or all of
the Workbench window, and release the left mouse button.

The orange border shows the location of the window as you drag it
around the screen. Look at the back and front gadgets. The back gadget
has a black square in the foreground, and the front gadget has a white

square in the foreground.

• Click on the front (right) gadget of the Empty window.

The gadget changes color for a moment Nothing else happens.

• Click on the back (left) gadget of the Empty window.

The back gadget changes color for a moment, and the Empty window

seems to disappear.

• Click on the Workbench window to activate it.

• Move the pointer to the drag bar, press and hold the left mouse

button, and drag the Workbench window down.

The back gadget moved the Empty window behind the

Workbench window.

Click the Empty window's front gadget to return it to the front.

These gadgets let you page through overlapping windows as if they
were sheets of paper. The front gadget always brings windows to the

front.

• Close the Empty window. This activates the Workbench

window.
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n u The window's right lower border displays arrows, and a tall, thin white
Utner box in between the two arrows. Also, one gadget in the lower right
gadgets corner looks like a pair of squares connected at one corner.

The arrows are scroll arrows and the thin box is a scroll bar. The scroll

arrows and scroll bar let you move around inside a window whose

contents take up more space than the current window size. The lower

right corner gadget is the sizing gadget, which lets you change a
window's size.

• Move the pointer onto the Workbench window's sizing gadget
(the bottom right corner), press and hold the left mouse button.

• Drag the pointer up and to the left

The orange border appears, just as it did when you dragged the window.
This time, though, the border gets smaller as you move the mouse
toward the upper left corner of the window.

• Drag the sizing gadget toward the upper left corner until the orange

border is about two inches square, and release the left mouse
button.

As soon as you release the mouse button, the window border changes.

Part of the window now hides from view. Look at the bottom and right

borders of the window. The scroll bars now appear in two colors, white

and blue. The white sections of the scroll bars are the currently visible
parts of the window.

There are three ways to move around a window using the scroll arrows
and scroll bars:

Move the pointer onto the blue section of a scroll bar and click on
it.

Move the pointer onto a scroll arrow closest to the blue section of

a scroll bar, and click on it.

• Move the pointer onto the white section of a scroll bar; press and

hold the left mouse button, and drag the scroll bar into the blue

field; release the left mouse button.

The blue sections of the scroll bars show how much of the window you

can't see. The scroll bars and scroll arrows work the same for both

vertical and horizontal positions. Now enlarge the size of the window.

Move the pointer onto the Workbench window's sizing gadget,

and press and hold the left mouse button.

• Drag the pointer down and to the right (away from the close

gadget).
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When you think the window can display everything, release the left

mouse button.

Look at the right and bottom scroll bars. If neither bar shows any blue
sections, then the window is back to full size. If there is still some blue

visible, repeat the last three steps.

The Amiga has two kinds of left window borders. Most left borders are

narrow white lines. However, diskette windows display a disk gauge
along their left borders. These disk gauges indicate the amount of
memory used on the diskette. Like a gas gauge on a car, E=empty and
F=full. The higher the orange bar, the fuller the diskette.
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2.4 The Demos drawer

There are several drawer icons inside the Workbench window. These
drawer icons open like diskette icons.

• Double-click the Demos drawer icon to open it.

. . As soon as you do this, the disk drive runs and the pointer changes into

Wait pointer the wait pointer (the clouds with Zs written on them). The inactive
Demos window appears on the screen. You can tell that the window is

inactive by the title, which is displayed in ghost print.

• Move the pointer into the Demos window.

A quick review of window components, going clockwise from the top
left:

Close gadget, for closing the window

Drag bar, which lists the title and lets you drag (move) the

window around the screen

Back gadget, for sending a window behind another window

Front gadget, for bringing a window in front of another window

Right scroll arrows and scroll bar, for moving around vertically
inside a window

Sizing gadget, for reducing and enlarging the size of a window

Bottom scroll arrows and scroll bar, for moving around
horizontally inside a window

Disk gauge, which tells the amount of memory used on a

diskette (appears on disk windows only)

.... There are at least three balloon-shaped icons inside the Demos
Window window. The three files you'll need for this section are Dots, Lines
icons and Boxes.

• Open Boxes by moving the pointer onto the Boxes icon and
double-clicking it

The disk drive runs for a few seconds. The screen then displays a small
window filled with boxes, rapidly changing in color and size.
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Move the mouse pointer to the Boxes window drag bar (the top

border), press and hold the left mouse button.

Drag the window up over the Workbench window and release

the left mouse button.

• Move the mouse pointer to the Boxes window sizing gadget (the

lower right corner), press and hold the left mouse button.

• Drag the sizing gadget down and right to make the Boxes

window large enough to cover the Workbench window.

• Release the left mouse button when the Boxes window is the

desired size.

When you change the window size, the window clears and starts again.
Notice the name of the window, now that the window is large enough

to display the title: Boxer Window. The filename and the window

name can differ from each other.

Watch what happens when you move the open Boxer window

behind the Workbench window and the Demos window.

• Move the pointer to the Boxer Window back gadget (the

upper right gadget with the black box in front) and click on it.

The Boxer Window runs while behind the other windows. Try

Using back moving the other windows behind the Boxer Window using the

gadgets back gadgets on the other windows.

• Click the Demos window back gadget to put it behind the

Boxer Window.

• Now click the Boxer Window back gadget to move it behind
the Demos window. Or, click the Demos window's front gadget

if you can reach it (drag the Demos window or reduce the

Boxer Window to reach the front gadget if necessary).

You have just learned how to run a program (Boxes is a program). Try

each of the other demos.

• Close Boxes by clicking on the close gadget (bring the window

forward with the front gadget if necessary).

Open Dots by double-clicking on the Dots icon.

Dots displays dots in every imaginable color in its window.

• Enlarge the Dotty Window by using the drag bar and the

sizing gadget
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When you change the window size, the window clears and starts again.
Notice the name of the window: Dotty window.

Close Dots by clicking on the Dotty window close gadget.

• Open Lines by double-clicking on its icon.

The Lines window displays different patterns and color of lines. You

can only see part of the demo right now; you'll need to enlarge the
window.

Enlarge the Lines window by using the drag bar and the sizing

gadget. Drag the sizing gadget as far to the right as you can.

You may be wondering why computer companies see graphic
demonstrations as so important. Graphics take the most time for a
computer to execute, because of the enormous amount of numbers that

have to be created in the shortest possible time. Since a computer
doesn't recognize lines or circles or squares, a computer can only

understand graphics conveyed as numbers. Colors, line lengths, etc.
have numbers assigned to them.

Graphics are actually hard work for a computer, and proof of its
abilities. These demos show the Amiga's skill at processing numbers

faster than many other computers, not its artistic abilities.

The Amiga's high speed also affects the Amiga's version of the
computer language BASIC. BASIC is an interpreted language: The

computer translates BASIC commands into its own language, executes

the commands, and translates the results from its own language into
ours. Like graphics, these processes need numbers and time. The faster

a computer handles numbers, the faster it performs complex commands.

M Multitasking was mentioned earlier in this chapter. A multitasking
More about computer carries out more than one task at a time. You can see a
multitasking simple example of multitasking using the three demos you've run in

this section.

• Double-click the Dots icon. Double-click the Lines icon.
Double-click the Boxes icon.

Leave the windows the same size at which the Amiga opened them.

• Drag the Dots, Lines and Boxes windows so they stand
side by side.

Now you can see all three programs running at the same time. The

Amiga could just as easily look up an address while its performing a
calculation.

• Double-click the Dots icon. Double-click the Lines icon.

Double-click the Boxes icon.

BASIC
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You now have two copies of each demo on the screen. Each copy runs

independently of the other. You can open these three demos again and
again if you wish. Remember that they use the Amiga's internal

memory size. In general, the Amiga runs as many programs at once as

can fit into memory. The number of programs at a time varies with the

lengths of the programs.

• Drag the new Dots, Lines and Boxes windows next to the

old ones.

Notice that the Amiga moves somewhat slower than it did. It takes

more time before the pointer drags the window, and before the window

reappears in the new position.

• Drag one of the Lines windows to the top row, and enlarge it

with the sizing gadget

The Amiga definitely moves slower. Remember, all these programs

share internal memory.

• Close all the small Dots, Lines and Boxes windows one

after the other, except the large Lines window.

Watch the large Lines window as you close the other windows. The

speed increases as you close the other windows.

You can see the amount of memory increase during this demo. Each
time you close a demo file, the memory indicator goes up.

• Close the last Lines window.

Close the Demos window.
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2.5 The System drawer

Formatting

disks

WARNING:

The System drawer contains a number of useful programs. One of the

most important is the Diskcopy program, which lets you copy

diskettes.

• Double-click the System drawer icon.

A window opens. The System window contains a number of

programs. For now, two programs are of the most interest:

Two diskette icons numbered 1 and 2, are separated by an arrow.

This icon has the name Diskcopy.

A diskette icon with fuel gauge pointing to E. This icon has the

name Format.

Initialize andformat mean the same thing when talking about floppy

diskettes. Both terms describe a computer's preparation of a diskette for

accepting data. Say you have a diskette with data which you no longer

need, or you buy a diskette from the store. The computer prepares the

diskette so that you can put new information on it

Every Amiga disk drive has a magnetic head that deletes any

information on a diskette and creates the new data tracks and sectors

needed for adding information. However, once the computer formats a

diskette, any data previously on a diskette disappears forever. Therefore,

when you format diskettes which have already been used, be absolutely

sure that you will never need the information on them again. This

doesn't matter with new diskettes, since they have no information on

them anyway.

Perhaps you want to know why new diskettes need formatting. Each

diskette manufacturer wants to serve as many computers as possible, so

they sell "blank" diskettes. The computer adapts blank diskettes by

formatting (initializing).

Formatting a previously formatted diskette destroys all

data previously stored on that diskette.

This book assumes that you only have one disk drive. If you have two

drives, the procedures stay more or less the same except that the Amiga

won't constantly ask you to change diskettes. When formatting with

two drives, place the Workbench diskette in the internal disk drive (drive

0) and the new diskette into the external drive (drive 1).
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NEVER remove a diskette from the drive while the disk

WARNING: drive LED is on. The Amiga may destroy all the data on
that disk. If you do, go to Appendix A for instructions on using the

diskdoctor program. This program might rescue some of the data.

• Double-click the Format icon.

A requester appears. A requester, as the name suggests, tells you of a

Requesters problem, error or unfinished task, and requests information or data. For
example, requesters tell you to change diskettes. Follow the requester's

instructions, or you may risk a system crash. This means that the

computer restarts itself, and forgets everything input up until then.

This requester tells you to select the icon of the diskette you want

formatted, and select Initialize from the Disk menu.

• Click on the OK gadget to continue.

Remove the Workbench diskette from the disk drive and replace it

with the blank diskette. A new diskette icon appears DFO: BAD.

Click on the diskette icon you want initialized, usually DFO: BAD.

The icon turns black, indicating an active icon. Go to the Disk menu

and select the Initialize item. A requester appears asking you to

replace the the Workbench diskette. Remove the blank diskette and

insert the Workbench diskette. The formatting program will be loaded

and then a requester appears asking you to insert the diskette to be

initialized:

Figure 4:

Insert

disk

requester

ISysteH Request!

(Please insert disk

to %e initialized in

dpiue SFB:

1ContinueI [Cancel]

Once you have the diskette in the drive select the Continue gadget.

After a short period of time another reguester appears verifying the

initialization of the diskette. If your sure you have the correct diskette

in the drive click on the Continue gadget. The Amiga asks this to

ensure that you don't accidentally delete important information. Even if

you have the correct diskette, you might want to think about what
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you're going to do. Remember, all data on the diskette is lost when

formatting. If you're absolutely sure that you want this disk formatted,

then:

Click on the Continue gadget in the requester.

Figure 5:

Ok to

Initialize

requester

SysteH Request

Ok to Initialize disk in

drive DFB:

(all data will be erased) ?

[Continue 1

As soon as you give the Amiga the OK to initialize, the requester

changes to a window displaying the status of the initializing process.

You may be wondering why two diskette icons appear on the screen

when you only have one disk drive. The Amiga keeps the icons of the

Workbench diskette and the new, DFO : BAD diskette in memory. There

may be a third diskette icon on die screen, called RAM Disk (more on

this later).

One hint for two disk drive Amiga owners: If the Amiga requests a

certain diskette to be inserted in "any" drive, it actually means the

internal disk drive. Therefore, if you did what the Amiga asked and

nothing happened, remove the requested diskette and insert it in the

internal drive.

The disk drive makes some noise, and the Amiga displays the message

DFO : BUSY underneath the selected diskette icon. This means that the

built-in drive (know internally as DFO :) is doing something (=BUSY).

After, a short time, the disk drive stops. And instead of DFO : BUSY,

the diskette icon has the name Empty underneath it. You've just

formatted your first Amiga diskette.

Double-click the Empty diskette icon.

A window named Empty opens. The Empty window contains only

one icon; the Trashcan (more on this later). Otherwise, the Empty

window looks and acts exactly like any other window.

Close the Empty window and remove the Empty diskette from

the drive.
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. The following instructions explain how to copy the Workbench diskette

Copying using the Diskcopy program. Copying diskettes safeguards you from
diskettes unpleasant surprises. It doesn't take much to accidentally erase an

important file, or pour beer on the Workbench diskette. Always make

backup copies of diskettes. Backup copies are copies of an original

diskette. Use backups for your work, and keep the original diskettes in a

safe, non-magnetic place.

Make sure your write protect is enabled on your Workbench diskette.

The write protect is the small sliding piece of plastic in one corner of a

floppy diskette. If you can see through the write protect hole, you can't

write to the diskette.

Write enable Write protect

Figure 6:

Write

protects

• Move the write protect slider on the Workbench diskette so you

can see through the hole (write protect it).

• Insert your Workbench diskette in the internal disk drive.

• Click on the Workbench diskette icon, press and hold the

<Shift> key (<T>).

• Double-click the Diskcopy icon in the System window and

release the <Shift> key.

This process of holding the <Shift> key down while selecting icons is

extended selection. Extended selection lets you select two or more icons

at a time.
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A requester appears:

Figure 7:

Disk Copy

requester

• Click on the Continue gadget

Another requester appears, asking you to insert the destination diskette

(the blank diskette to which you're copying):

Figure 8:

Disk Copy

requester

I Disk Copy

IPut DESTINATION disk
( TO disk ) in druve DF8:

• Click on the Continue gadget

The Amiga tells you which diskette it needs through requesters.

A two disk drive Amiga system requires no diskette changes when

Two'drive copying. The procedure is much the same as copying diskettes with one
Copying drive, with a few changes. The procedure is as follows:

• Move the write protect slider on the Workbench diskette so you can

see through the hole (enable it).

• Insert the original Workbench diskette into the internal disk drive,

and the blank diskette into the external disk drive.

• Click on the Workbench diskette icon.

Press and hold a <Shift> key (<T>).

• Click on the external disk drive's diskette icon. If this diskette is

blank, its name is probably DF1: BAD.
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Storing

original

diskettes

CLI

IconEd

Say

• Double-click the Diskcopy icon in the System window and

release the <Shift> key.

• Follow the Amiga's instructions through the requesters and click

on the proper gadgets to continue.

• Make backup copies of the Extras diskette that came with your

Amiga using the above instructions.

• Close the System drawer when you finish making backup copies.

Now that you have a backup of the Workbench diskette, test it out as

follows:

• Insert your backup copy of the Workbench diskette into the

Amiga's internal disk drive.

• Press the <Ctrl> key (on the far left of the keyboard), the

<Commodore logo> key (or the left <Amiga> key) and the right

<Amiga> key at Ihfe same time.

The Amiga acts as if you switched it on. The screen turns gray, it reads

your Workbench diskette and displays the Workbench screen.

If your backup diskettes work, take your original diskettes and put them

in a safe place. "A safe place" means a location shielded from extreme

heat and cold, far away from magnetic objects, food and drink, animals

and children (the top shelf of a linen closet, for example). Use your

original diskettes only if you need to make copies. However, you can

always make backups of backups, so you may never have to get your

originals out again.

The System window displays a few other programs. For example, a

box icon containing >1 and the name CLI. This is the Command Line

Interface. If you don't see this icon, don't worry about it; you won't

need it for a while. If there is such an icon, leave ii alone for now (see

Chapter 4 for information on the CLI).

Another System drawer program is the box-of-crayons icon named

IconEd. A few basic parameters have to established before you can

use it. Appendix £ discusses IconEd in detail.

Look at the rest of the programs in the systems drawer. The program

Say demonstrates the speech synthesis features of the Amiga.

Double-click on the Say icon.
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The following text appears in a window called the Phoneme window:

SetMap

Type your message,

Options are:

-M (Male)

-R (Robot)

-S## fSoeed)

then Return.

-F (Female)

-N (Natural)

-P## (Pitch)

A second window (the Input window) appears below this one. The
Amiga converts everything you type in this window into speech.

• Click inside the Input window.

• Enter the following from the keyboard:

Hello, user. I'm your Amiga.

• Press the <Return> key.

Commodore Amiga programmers wrote the speech synthesizer to
imitate the English language as closely as possible, but some words
just don't come out right. Say's pronunciation improves when you

spell the word phonetically instead of literally.

Say not only says what you type in; it also lets you change the

Amiga's voice.

• Enter -s 40 0 and press the <Return> key.

• Enter Peter Piper picked a peck of pickled

peppers. and press the <Return> key.

You must enter speed or pitch changes before entering the specific text
Precede all speech changes with a dash (-) and the corresponding letter
as listed in the Phoneme window. Pitch and speed changes require a
number as well. Acceptable speeds range from 40 to 400, while pitches
range from 65 to 320. Experiment with the different parameters.

• Press the <Return> key without entering anything else to end the

program. ^

The SetMap program lets you access special and foreign characters
from your keyboard, as well as assign specific character sets to the

keyboard.

• Click on the SetMap icon.

Select the Info item from the Workbench pulldown menu.

• Click the Add gadget (in the same line as the Tool Types string

gadget).
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• Click on the Tool Types string gadget (the blue area).

An orange cursor appears.

• Type KEYMAP=D (in capital letters) and press the <Retum> key.

Make sure your write protect is off on your Workbench backup (do
not use the orginal Workbench diskette).

• Click on the Save gadget in the lower left hand corner.

As soon as you click Save, the Info window dis^pears.

Double-click on the SetMap icon.

• Double-click on the Uti1ities drawer icon.

• Double-click on the Notepad icon.

• Type a few keys, like <Y>, <Z>, <)>, <;> and <:>.

The above procedure assigns the German character set to your keyboard
(the D in KEYMAP=D stands for MDeutschM, or German). To return to
the USA character set reboot your system or:.

• Close the Notepad window.

• Click on the SetMap icon.

• Select the Info item from the Workbench pulldown menu.

• Change the KEYMAP=D to KEYMAP=USA (in caps) and press the
<Return> key.

• Click on the Save gadget in the lower left hand corner.

• Double-click on the SetMap icon.

The keyboard returns to the English character set

The GraphicDump program produces hardcopies (printouts) of the
Graphic - screen contents. You can only use this program if your printer prints
Dump graphics. If you have a printer connected and operating:

Double-click the GraphicDump icon.

The printer reproduces the screen picture on paper. GraphicDump

waits 10 seconds after your double-click before it starts printing, so you
have some time to move screens or windows where you want them.
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2.6 The Utilities drawer

The Utilities drawer contains two items: the Notepad and the

Calculator.

The Calculator utility opens like any other program. Since it
Calculator behaves like a window, you can place it in front of or behind other

windows. On the whole, it works exactly like a pocket calculator.

However, this calculator has three special features:

1. You can access calculator functions from both the mouse and the
Amiga keyboard. For special functions such as CE, press the
necessary letter keys (press the <c> key, then the <e> key).

Notepad

2. This Calculator has a delete function. Click on the <

key (on the bottom row of the Calculator window, next

to the <+->) to delete numeric input from right to left. Pressing

the <Backspace> key (or «-> key) or <Del> key on the

keyboard also deletes numbers from the calculator.

3. The CE function lets you delete the last entry only. For example,
if you make a mistake when typing in a long list of numbers,
click CE. This deletes the current input while keeping the
previous computation in memory. Click CA (Clear All) when

you want to start a new calculation.

• Double-click on the Uti1it ies drawer icon.

• Double-click the Notepad icon and make sure the Amiga

keyboard is in easy reach.

While the disk drive runs, a window named Notepad V 2 . 0

appears. Then some text appears in the top border of the window,
stating that the program is searching for fonts. The Notepad gives
you some idea of the capabilities of even the simplest Amiga word
processor. A word processor like TextPro or BeckerText lets you

write text, similar to working with a typewriter. That's where the
similarity ends. Word processing also allows you to move, delete,

rewrite and edit text on the screen.

First, enlarge the Notepad window as much as possible.

• Move the pointer onto the drag bar of the Notepad window,

press and hold the left mouse button.
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Drag the Notepad window to the upper left hand corner of the
screen and release the left mouse button.

Move the pointer down to the Notepad window sizing gadget,
press and hold the left mouse button.

Drag the sizing gadget to the lower right hand corner of the screen
and release the left mouse button.

Figure 9:

Notepad

Notepad is for making notes. You need some text to demonstrate the
Notepad's abilities. What you type is up to you. For this example,
you could use:

The Amiga for Beginners

by Christian Spanik

• Input your Notepad text from the keyboard.

Note the narrow bar that follows the text as you type it in. This bar is
the cursor.

You can correct any mistakes you make using the <Del> and

<Backspace> (or «->) keys.

• Use the <Del> or <Backspace> (or «->) keys to erase unwanted

text.

Type in the new text

. Now that there is text in the Notepad, you can try out individual
Moving text functions. First of all, move the text, since the text is stuck in the

upper left hand corner.

• Move the pointer to the left of the first letter of the first line.
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Press the left mouse button.

In the example above, the letter would be a capital T. Pressing the left

mouse button brings the cursor to the same area as the pointer, if the

pointer is in the text area. You can also move the cursor with the four

cursor keys located between the normal keyboard and the numeric

keypad.

Press the <Return> key.

Press the <Return> key to signal the end of a line, or the end of an

input.

Press the <Return> key until the two lines reach the middle of the

Notepad window.

Now center the text. Make sure the cursor is still to the left of the first

letter of text.

Press the spacebar.

Do this until the text is centered in the window. Now you can change

Font s thefont, or typeface.

Press the right mouse button and move the pointer to the Fonts

menu title.

The Fonts pulldown menu appears. The top menu item, Topaz, has

a checkmark to its left.

Move the pointer to the Topaz menu item.

A list of options appear to the right of the Topaz menu item. Options

Options contain further selections for menu items. This option contains a

number 8 with a checkmark to its left, and a number 9 without a

1 checkmark. The checkmarks indicate the font and font size currently in

use. Topaz 8 is the font you see on the screen. Change the size of this

font from 8 to 9.

Move the pointer to the options for topaz (be sure you move in a

horizontal line to the right).

Move the pointer onto 9 and release the right mouse button.

The type changes to a larger size immediately. Look again at topaz.

• Press the right mouse button and move the pointer to the Fonts

menu title.

Move the pointer to the Topaz menu item.
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NOTE:

Style

Keyboard
shortcuts

Topaz still has a checkmark in front of it. But now the number 9 has
a checkmark next to it, instead of 8.

Now experiment a little with the different fonts. You have seven fonts
and different sizes available. Select them as you did above for Topaz.

You must select both a font and a font size, the Amiga refuses your
selection if you choose only a font.

Part of your text may go past the right border of the window if your
Notepad is too small. Enlarge the size of the Notepad with the
sizing gadget if this happens.

• Select different fonts and sizes using the procedures listed above.
Try out each font and font size to see how you like them.

• When you're done experimenting, select the Sapphire 19 item
from the Fonts menu.

The Notepad lets you select different fonts and sizes. In addition, you
can add different typestyles to text

• Press and hold the right mouse button and move the pointer to the
Style menu title.

Style displays its menu items. You can make your text Italic,

Underlined. Bold or Plain. Select a typestyle exactly the same

way as you select a font.

Select the Italic item from the Style pulldown menu.

The typestyle changes.

Press and hold the right mouse button and move the pointer to the
Style menu title.

Notice that a light A on a dark background stands to the right of each

item, and each A has a letter to its right. The A represents the right

<Amiga> key; the letter after it represents a normal letter key on the

keyboard. You can access the menu items marked in this way directly
from the keyboard. These are keyboard shortcuts, or key combinations.

Release the right mouse button.

• Press and hold the right <Amiga> key

• Press the <P> key (uppercase or lowercase).

The type changes to plain text.
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The Plain item cancels any special typestyles. There are some

Combining exceptions, though. If you position the cursor in the middle of an

typestyles already bold line and select the Underline item, the second part of
this line becomes bold and underlined. This is one trick: combining
styles. Now if you employ the Plain item at the beginning of the

line, only the bold function cancels out. The underlining remains intact.

However, if the underline is now applied to the rest of the line and this
is followed by another Plain, only the latest underline section cancels

out. The original underlining stays. This creates a protective border for

the underline item. This lets you highlight text in the middle of lines

while leaving the rest of the line plain, even if the style starts and ends

in the middle of a line.

All Style menu functions are performed from the current cursor

NOTE: position only. That is, if you change your typestyle with the cursor

halfway down your text, only the last half of the text changes to the

new typestyle.

• Press and hold the right <Amiga> key.

Press the <I> key (uppercase or lowercase).

The changes to italics. You can use the mouse for selecting these styles
if you wish. However, once you learn the key combinations, the

keyboard is faster for applying styles:

Key combination

Right <AmigaxP>

Right <AmigaxI>

Right <AmigaxB>

Right <AmigaxU>

Stvle

Plain (normal) style

Italic style

Bold style

Underlines style

You can experiment some more if you like. You can also combine

typestyles if you wish.

• Press the right <AmigaxI> key combination.

Press the right <AmigaxB> key combination.

Now you have bold italic type.

You can draw attention to a text using different typestyles. Before you

start typing, make some room on the window:

• Move the pointer to the lower left hand corner of the Notepad

window.

The window has a dogear in that comer.

Click on the blue dogeared corner.
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Page turns

Notepad

news article

Suddenly you have an empty page. You should see a number (in this
case it should be 1) in this corner.

Click on the number in the upper right hand corner of the
Notepad window.

When you click the upper right hand corner, your old text reappears and
the number changes to a 0.

These dogears let you page forward (bottom left) and back (top right).

Place the cursor to the right of the last letter of your text.

There are two ways of bringing the text cursor past the last letter.

Move the pointer to the required position and click. The text

cursor is already there. Or you use the arrow keys on the

keyboard.

Move the cursor by using the cursor keys.

Press the <Backspace> («->) key.

The previous letter disappears when you press the <Backspace> («->)

key. Since the key repeats, press and hold the <Backspace> key to erase

a number of characters

Hold down the <Backspace> key until the entire text disappears.

There's another way to clear your Notepad for new text:

• Select New from the Project pulldown menu (see below).

When your notepad is clear, type in the following sample text, freely

drawn from a certain magazine. Select the smallest possible font size

(Topaz 8 works well). Remember that unlike a typewriter, the only

time you need to press the <Return> key is when you finish a
paragraph:

Man bites dog

In a fit of frustration, Ken F., a postman, bit his wife's dog.

Ken F. lived for years with the fact that his wife's dog growled

every time it saw him. Every dog on his route liked him; it

always bothered him that his wife's dog Nicki didn't. On Sunday

evening, Ken F. bit Nicki on the leg. His wife has started

divorce proceedings against "this animal," referring to her

husband after the event. Mr. F. was unavailable for comment.

You can format this story in the style of a news article using the
Notepad.

50



Abacus 2.6 The Utilities drawer

Once the article is on screen, you can manipulate it in any way.

Both fonts and styles can be controlled locally. That is, you can use

different fonts in Notepad text. To select local fonts:

Select Global Font from the Format pulldown menu.

This item defaults to on, and prevents you from using more than one

font throughout a text. You can easily tell when it is off, since no
checkmark appears next to the item. When Global Font is off, you
are allowed more than one font in a document

The Notepad requires much more memory when it uses multiple

NOTE: fonts. You can save memory by using just one font and style in your

Notepad texts.

The most important thing is the title: Man bites dog. This title should
have special emphasis, as you want to get the reader's attention.

Separate the text into paragraphs.

Insert at least one blank line between the title and the text, and a blank

line after "...bit his wife's dog."

• Place the text cursor to the left of the title.

Select the Topaz 8 item from the Fonts pulldown menu.

Select the Bold item from the Style pulldown menu, or press

Bold type the right <AmigaxB> key combination.

• Place the cursor to the left of the first paragraph.

Select the Ruby 8 item from the Fonts pulldown menu.

Ruby 8 looks the most like "newspaper type" of the Amiga's diskette

fonts.

• Move the cursor to the left of the main text body (the second full

paragraph).

Select the Plain item from the Style pulldown menu, or press

the right <Amiga><P> key combination.

The first paragraph, which is a summary of the events involved, would

Italics look best in an italic typestyle.

Select the Italic item from the Style pulldown menu, or

press the right <AmigaxI> key combination.
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You might be wondering why the Style pulldown menu items only
change the leading paragraph. A Style item affects all the text up to
the next style command. If no other style command exists, the style
affects the remaining text.

Jr . ... You can add a style to the title for even more emphasis. Try out
Underlining underlining.

• Move the cursor to the left of the headline. Select the Under1ine

item from the Style pulldown menu, or press the right
<AmigaxU> key combination.

The Notepad underlines the entire text. The headline is bold and
underlined.

• Move the cursor to the left of the first paragraph.

Select the Plain item from the Style pulldown menu, or press
the right <Amiga><P> key combination.

Maybe you'd like more emphasis on the first paragraph, now that the

headline is bold and underlined. If you would prefer the first paragraph
in bold type, proceed as you did above for style selection.

Once you have the news article in a format you like, you need to know
how you can store your work.

Press and hold the right mouse button, and move the mouse

pointer to the Project pulldown menu title.

The Project pulldown menu items manage Notepad files. The
P ro j ect menu items are as follows:

prepares the Notepad for new text. If there was

text on the Notepad, New deletes the old text. Be

sure that you save (store) your old text on diskette

before selecting New.

loads (recalls) a new document from diskette. Open

deletes any old text on the Notepad. Be sure that

you save (store) your old text on diskette before

selecting Open.

saves (stores) a document generated with Notepad

on diskette. However, Save assumes that you plan

to select New immediately after Save (write a new

document). If you select Save again, Save retains

the name of the document previously saved. This

means that Notepad deletes the old text and

replaces it with the new text. Save works best the

first time you use Notepad, or when you edit and

resave old text.

New

Open

Save
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Save As is the safest way to store Notepad texts. This

item requests the name under which you want the

text saved. If you called the text through Open, the

text already has a name, then the Amiga suggests

that name. If you want another name, click inside

the string gadget (the field in which the name

appears). Delete the old name with the cursor and

<Backspace> keys, and type in the new name.

Print sends the text to a printer. You can select the

printout's size. Auto-Size produces a printout

the same size as the text on the screen; Small is

one-fourth the size of the printer paper width;

Medium is half the size of the paper width; and

Large is the full paper width.

Print As distinguishes between two types of printout.

Draft prints the text without fonts or typestyles,

giving a faster printout. Graphic prints the

message exactly as it appears on screen, including

special fonts and typestyles.

Read fonts recalls fonts from diskette.

Quit terminates the Notepad.

• Select the Save As item from the Project pulldown menu.

A requester appears, requesting the name of the text:

Enter name and press <Return>

Move the mouse pointer to the Name string gadget and click on

that string gadget

The Save As description mentioned string gadgets. These are gadgets

which let the user enter groups of characters (strings). When you click

on the Name string gadget, a cursor appears.

• Type in the name of your text.

• Press the <Return> key.

If you don't like the name you typed in, or if you typed it in

incorrectly, you can still change it. The Notepad only accepts names

when you press the <Return> key and click the OK gadget in the

requester. If you typed in the wrong name:

Click on the Name string gadget.

• Delete the name with the <Backspace> («->) key, or add to the

old name by moving around with the cursor keys.
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• If the name is correct, press the <Return> key, then click on the
OK gadget

The disk drive runs. The Amiga saves the file, although it doesn't
appear immediately in the Utilities window.

Close the Utilities

Utilities window.
window, then reopen the

The Utilities window contains a new icon with your text's
filename.

. _ There is a simple way to save your Notepad texts in other drawers.
More on Double-click the icon of text in another drawer. Notepad
saving and automatically starts, and all new texts save to the new drawer in which
loading text this first document exists. Another thing: if this doesn't work for some

reason, click the Notepad icon once, press a <Shift> key and click
the particular text icon to boot the Notepad.

There are two ways to recall this text. The first method is similar to
saving text.

• Open the Utilities drawer.

• Open the Notepad.

• Once the Notepad loads, select Open from the Project
pulldown menu.

Click on the Name string gadget and type in your filename.

• Click on the OK gadget.

The second method is simpler and much faster.

• Open the Utilities drawer.

Double-click on your Notepad text icon.

Sometimes you have to adjust the type and size of the Notepad
window to its size when you saved the file.

• Press and hold the right mouse button, and move the mouse
pointer to the Format menu title.

The Format menu brings a little color to your Notepad. Here are
its options:

Paper Color Each item has a option with four colors. One

Pen Color color in each option has a checkmark to its left;

this color is currently in use by the Amiga.

Format
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• Move the mouse pointer onto one of these items.

The checkmark in Paper Color marks white, and the Pen Color

checkmark indicates black. You now change these colors as needed.

Select the "white" option item from the Pen Color item.

The Notepad changes to white text on a white background.

• Select the "black" option item from the Paper Color item.

Your text becomes readable again, but in reverse (white on black).

Type sizes and styles are unaffected.

Word Wrap activates when the Notepad loads. As mentioned

before, you don't need to worry about ending lines

with carriage returns. If a word doesn't fit into the

rest of the line, the Amiga simply moves that word

to the beginning of the next line. Deactivating

Word Wrap makes the Amiga print characters to

the last column of the line and carry on text at the

beginning of the next line.

Global Font controls the global/local font setting (see above).

Remove Font s deactivates all font types used in a Notepad text.

Remove Styles deactivates all typestyles used in a Notepad text.

Select the Remove Fonts item.

Select the Remove Styles item.

These items remove all your font and typestyle formatting.

One pulldown menu remains—the Edit menu. To select text:

Edit

• Place the cursor to the left of the text to be selected.

Select the Mark Place item from the Edit pulldown menu.

Move the mouse pointer past the end of the last paragraph and

double-click.

An orange bar appears, marking the selected text. What happens to this

selected text depends upon the next function chosen. The menu options

are as follows:

Cancel cancels any editing.

Cut removes selected text, at least temporarily.
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Paste

Copy

places cut or copied text at a marked location.

duplicates the selected text, for later duplication

using Paste.

The remaining four items of the Edit menu require no text marking.

Find searches for specific words throughout a text.

Although Find accepts two parameters (a find

string and a replace string), the second parameter

remains inactive unless you select Replace as

well.

Find Next searches for the next occurrence of the search string.

Find Prev searches for the previous occurrence of the search

string.

Replace changes the string specified with Find to the

replace string. Select Replace using the mouse

or the keyboard (right <Amiga><R>).

• Close the Notepad window by clicking on its close gadget.
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2.7 An Intuition glossary

Active

Clicking

Double-

clicking

Dragging

Drawers

Enlarging

Gadgets

This book uses many words that may be new to you. The summary in

this section defines terms used when talking about Intuition.

Active windows or pulldown menu items appear in clearly legible type.

Inactive window titles and pulldown menu items display ghost print
(gray, hard-to-read). Active pulldown menu items have dark backgrounds

as you pass the mouse pointer over them. Active icons also turn dark

when selected. Items, windows and icons all activate when clicked one

or more times with the mouse. Active menu items have checkmarks

next to them (e.g., Word Wrap in the Notepad's Edit pulldown

menu).

The user selects and activates programs and icons by clicking (pressing

the left mouse button). A single click turns an icon black, while a

double-click activates the programs represented by the icon.

Double-clicking runs programs and opens windows. The user moves the

pointer onto the desired icon and presses the left mouse key twice in

rapid succession.

Windows and icons can move. For example, the user moves the pointer

onto the icon, or onto the window's drag bar, and presses and holds the

left mouse button. When the user moves the mouse, the selected object

moves with it. The user releases the left mouse button when the object

is in the desired position.

Drawers contain programs and files having some relationship with one

another. For example, the Demos drawer contains all the Workbench

demonstration programs.

In principle, this function works exactly like dragging. The user places

the pointer on the sizing gadget in the lower right hand corner of the

window, presses and holds the left mouse button, and drags the sizing

gadget away from the upper left corner of the window. The window size

changes in the direction of the pointer movement

Gadgets are objects built into windows to help the user move, adjust

and manage windows.

Sizing gadgets enlarge or reduce window sizes. Scroll bars and scroll

arrows move the contents of the window around, so you can see

programs and drawers not visible in the normal window.

Windows move to the background when the user clicks the back gadget,

and to the foreground when the user clicks the front gadget. The back
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Icon

Info bar

Info

window

Memory

meter

Menu items

Menu titles

Open

Options

Program

Project

gadget is in the upper right of the window drag bar, and looks like a
black square in front of a white square. The front gadget is to the right

of the back gadget, and looks like a white square standing in front of a
black square.

Users can move windows with the drag bar (the top border with two

dark horizontal lines across it). Moving the pointer onto the drag bar

and pressing and holding the left mouse key allows window movement.

Close gadgets (the small box with a dot in its center, in the upper left

hand corner of the window) close windows.

Icons are pictures on the Amiga screen. They can be tools (programs),

projects (files), drawers, or objects that don't fit into any of the above

categories, such as the Trashcan or diskette icons.

The info bar stands at the top of a full Amiga screen. It displays the

amount of free memory, or the current version of the Workbench

diskette. The Amiga can operate several screen planes at once. In

addition, when pressing the right mouse button, the info bar displays

menu titles. Certain programs can affect and therefore change the info

bar (the Notepad is an example).

Every icon has an info window. This window list filenames, file size,

comments, etc. Diskette info windows list the amount of free memory

on the diskette.

This line contains the screen name and the amount of free memory in

the Amiga. It appears across the top of the screen when in the

Workbench.

Menu items are individual commands found beneath menu titles. For

example, the Notepad's Italic item from the Style menu

italicizes text.

Pressing the right mouse button activates menu titles at the top of the

screen. Each menu title contains a list of menu items for user selection.

Tools (programs) and projects (files and documents) open, or execute.

When you double-click a project, the tool used to create the project also

opens.

These are additional menu options stemming from menu items. For

example, the different sizes from the Notepad' s Font menu.

Everything the Amiga does has its basis in a program. However, with

Intuition running, programs generally perform a service, and allow

user access from Intuition (see also Tools).

Projects are data files generated from within a program. For example,

Notepad texts are projects written in the Notepad program,

accessible from the Project pulldown menu of the Notepad.
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The user selects pulldown menus by pressing the right mouse button. If

Pulldown you press and hold this button, a set of menu titles appear at the top of
menu the screen. A pulldown menu listing a number of items appears when

you move the pointer onto one of the menu titles. Move the pointer

onto the desired menu item. The selected menu item executes when you

release the right mouse button.

In principle, this function works exactly like dragging. The user places

Reducing the pointer on the sizing gadget in the lower right hand corner of the
window, presses and holds the left mouse button, and drags the sizing

gadget toward the upper left corner of the window. The window size

changes in the direction of the pointer movement

Requesters are windows of different sizes, containing different texts and

Requester gadgets. These requesters all have one thing in common: They ensure
that the Amiga obtains the information it needs for performing certain

tasks. For example, if you want a diskette copied onto another one, the

Amiga must know which is the original diskette and which is the

destination diskette. It requests this information using a requester. These

requesters include gadgets for user response.

Tools help the user do certain things. Basically, you could call the

Tools Workbench and Intuition tools. Programmers and people with
intimate knowledge of computers define a tool as a program that helps

the user program. For example, Diskcopy copies diskettes—that

makes it a tool. There are tools for users at all levels, from the new

user to the expert programmer.

The entire Amiga screen area is a user interface. The user interface of a

User computer varies in size and user-friendliness, depending on the task it
interface performs. You presently know only one user interface on the Amiga

(the Workbench). The Amiga can manage several user interfaces at the

same time.

Windows can contain data or programs which you can start or view. In

WindoW addition, windows have gadgets which perform different functions (see
gadgets).
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2.8 The Trashcan

The Amiga's Trashcan acts as a file disposal. When you no longer

need a drawer, tool, project or program, drag it to the Trashcan. For

demonstration purposes, create a Notepad text you don't need (Section

2.6 has instructions on Notepad operation).

• Double-click the Utilities drawer.

Double-click the Notepad icon.

• Create a simple text in the Notepad (one word is enough for

this).

• Select the Save item from the Project pulldown menu.

Click on the Name text gadget and type in the name Garbage.

• Click on the OK gadget or press the <Return> key.

• Select the Quit item from the Project pulldown menu.

• Close the Utilities window.

• Double-click on the Uti1ities drawer.

A text file named Garbage appears in the Utilities window.

• Make sure the Trashcan icon is visible in the Workbench

window. Move around inside the window with the scroll arrows and

scroll bars until you find the Trashcan icon.

• Move the pointer onto the Garbage text icon, press and hold the

left mouse button.

• Drag the Garbage text icon until it covers the Trashcan icon

in the Workbench window.

• Release the left mouse button.

The Amiga's disk drive runs. The file still exists, though. If you look

at the Workbench diskette's info window, the amount of available

memory has decreased. The Garbage file is in the Trashcan for

now.

• Double-click the Trashcan icon.
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A window named Trashcan opens. The Garbage icon appears in

this window. This lets you remove any file in the Trashcan before

you dispose of it by mistake.

Move the pointer onto the Garbage icon, press and hold the left

mouse button.

• Drag the Garbage icon back to the Notepad window and

release the left mouse button.

Now that you know how to remove files from the Trashcan, dispose

of the Garbage text permanently.

Move the pointer onto the Garbage text icon, press and hold the

left mouse button.

Drag the Garbage icon until it covers the Trashcan icon in the

Workbench window.

Release the left mouse button.

The disk drive runs again.

• Activate the Trashcan icon.

Select the Empty Trash item from the Disk pulldown

menu.

The disk drive runs again. The memory meter increases, and the

Garbage text disappears. Activating the Trashcan icon before you

can Empty Trash gives you one last chance to think before you

dispose of the Trashcan's contents. You can put almost anything
into the Trashcan, but not diskette icons.

Be extremely careful when using the Trashcan. Once

NOTE: you select Empty Trash, the file you trash is gone
forever.
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2.9 The Clock

Type

Mode

Seconds

The Amiga has a fine sense of timing. In fact, the Amiga has a

working clock. Look for an icon in the Workbench window named

Clock, that looks like a clock.

Double-click the Clock icon in the Workbench window.

The disk drive runs and an analog clock appears (a clock with hands).

The time and date are incorrect right now. Before setting the Clock,

experiment with the current Clock window:

Move the pointer onto the Clock window's sizing gadget, press

and hold the left mouse button.

Drag the sizing gadget as far to the right as you can and release the

left mouse button.

The clock expands in the direction you pull the sizing gadget

• Move the pointer onto the Clock window's sizing gadget, press

and hold the left mouse button.

Drag the sizing gadget back to its original position and release the

left mouse button.

The Clock program has five pulldown menus:

This offers you three different clock displays: Analog, Digital 1

and Digital 2. The Analog clock has one disadvantage: It takes up

too much screen space. You may prefer using the digital clocks.

Digital 1 is a standard digital display, like the ones you see on

wristwatches. However, it's three times the height of the title bar, and

takes up almost as much space as the analog clock window. Digital

2 is the most compact of the three clock types. The Amiga defaults to

the Analog clock, indicated by the checkmark to the left of that menu

item.

The Mode pulldown menu lets you choose between 12 hour and 24

hour (military) time standards. The Analog 12 hour system displays

am or pm in the upper right hand corner of the Clock window. The

two digital clocks display the am or pm to the right of the time.

This menu sets the seconds display on or off. The analog clock uses a

second hand; the two digital displays use two-digit second displays. The

Amiga clock defaults to Seconds Off, indicated by the checkmaik to

the left of that menu item.
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Date

Alarm

Date sets the current date display on or off. The Amiga defaults to

Date On, indicated by the checkmark to the left of that menu item.

Alarm sets and activates or deactivates the Amiga alarm clock. Set

opens the Alarm Set requester in which you set the alarm time.

Alarm On and Alarm Off turn the alarm on and off. The Amiga

defaults to Alarm Of f, indicated by the checkmark to the left of that
menu item.

Here are some experiments to help acquaint you with the clocks. First,
select another clock type.

Press and hold the right mouse button and move the pointer up to

the Type menu title.

• Select the Digital 2 item from the Type pulldown menu.

The Analog clock vanishes, and the smaller Digital 2 clock

appears. Digital 2 alternates between date and time display—each

appears for about two seconds, then changes to the other display.

Press and hold the right mouse button and move the pointer up to

the Mode menu title.

Select the 2 4 Hour item from the Mode pulldown menu.

The Digital 2 clock changes to 24 hour mode (military time).

Press and hold the right mouse button and move the pointer up to

the Date menu title.

• Select the Date Off item from the Date pulldown menu.

Digital 2 immediately stops displaying the date.

Press and hold the right mouse button and move the pointer up to

the Seconds menu title.

Select the Seconds On item from the Seconds pulldown

menu.

Digital 2 now shows a two-digit second display.

Press and hold the right mouse button and move the pointer up to

the Alarm menu title.

Select the Set item from the Alarm pulldown menu.

A requester named Alarm Set appears.

Move the pointer onto the hour digits (the two left numbers).
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NOTE:

Move the pointer to the gadget containing the up and down arrows.

• Click twice on the up arrow of this gadget to move the time to

1400 hours.

For setting minutes, click on the minute digits, and proceed as you

did when you set hours.

Click the Use gadget to set the alarm, or the Cancel gadget to

cancel the setting.

You must turn the alarm on before it will go off at the prescribed time.

Press and hold the right mouse button and move the pointer up to

the Alarm menu title.

Select the Alarm On item from the Alarm pulldown menu.

The alarm clock deactivates when you select Alarm Of f from the

Alarm pulldown menu.

The Digital 2 clock has no alarm: Digital 2 ignores any alarm
time input in the Set Alarm item of the Alarm pulldown menu.

Analog and Digital 1 have functional alarms.

The clock itself still needs the proper time setting. The next section

explains the use of Preferences for setting the clock and more.

Figure 10:

Amiga clock

types

Analog
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2.10 Preferences

Preferences is one of the Workbench's most powerful tools. You

can install and adjust nearly any Amiga setting.

• Double-click the Preferences icon in the Workbench

window.

The disk drive loads the program, and a new window named

Preferences appears. Note that this window has no close gadget

or sizing gadget

Pl>«f

Figure 11:

Preferences

Move the pointer to the Preferences window drag bar, press

and hold the left mouse button.

• Try moving the window down.

The window won't move down; it stays in the same position.

Release the left mouse button.

Look at the title bar as you press and release the right mouse

button.

The Preferences window has no menu bar. The drag bar

disappears when you press the right mouse button.
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Date

Time

NOTE:

Click on the back gadget of the Preferences window.

The Workbench window appears in front of the Preferences

window, along with any other windows left open. If you left the

Clock window open from the last section, it is also in the

foreground. The Preferences window's back and front gadgets

operate the same as other back and front gadgets.

There are two gadgets toward the upper left corner of the

Preferences window, just below the Last Saved gadget.

These gadgets let you set the current date and time. The date gadget lists

the day, month and year, with each part of the date separated by spaces.

The time gadget lists the hour and minute, separated by a colon.

Double-click the Clock icon in the Workbench window, if

the Clock isn't open right now.

Click on the Workbench window to activate it, and double

click on the Preferences icon.

Move the pointer to the number you want changed, and click on

that number; the Amiga highlights that number for a moment.

Click the up arrow to increase the number and the back arrow to

decrease the number.

Repeat the above two steps as needed for the other numbers.

When you have the time correctly set, move the pointer to the

lower right corner of the Preferences window and click on

the Use gadget.

Click on the Clock window.

The clock time runs a few seconds later than the Preferences

setting. Preferences uses the saved time setting as the starting

time. If you start your Amiga every morning at eight o'clock, then you

can set this time to 8:00. The Amiga clock then starts at eight o'clock

every time you turn it on.

You can change the active number with the up and down arrows. The

up arrow increases the number by one, while the down arrow decreases

the number by one.

Time adjustments can affect both time and date. Moving the hour from

23 to 0 increases the day by one. Also, increasing the minutes from 59

to 0 increases the hour by one.

• Open the Preferences window.

Change the time to something different, following the above

instructions. Do not click the Use gadget after setting the time.
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• Click the Preferences window's back gadget.

• Click on the Clock window and check the time.

The clock stays set at its old time. You must tell Preferences to

use the changes.

• Click the Preferences window's front gadget.

Note the three gadgets in the lower right corner of the

Cancel Preferences window. The Cancel gadget cancels any changes

Save made to Preferences in this session. The Save gadget saves your

Use changes to diskette for later recall. The Use gadget tells the Amiga to

use the current Preferences settings without saving them. These

settings remain in effect until you switch off the Amiga.

Click on the Use gadget.

The Preferences window disappears and the clock digits move to

the time you set. The second counter begins at 00.

• Double-click the Preferences icon to reopen Preferences.

Here are the individual gadgets and settings available in

Preferences.

This returns all values in Preferences to the settings that

Reset All originally came with your Workbench diskette. This is useful when you

can't remember the original settings after too many changes.

This gadget recalls the most recently saved settings. This is useful if

Last you make an error and want the P re fe rences most recently stored to

Saved diskette.

This gadget sets the date. Set the date by clicking one of the numbers or

Date the month, and clicking on the up or down arrow to change. The up

arrow increments the number or month by one, and the down arrow

decrements the number or month by one.

• Double-click the Clock icon in the Workbench window, if

the clock isn't open right now.

• Click on the Workbench window to activate it, and double

click the Preferences icon.

• Click on the day, year or month you want changed; the Amiga

highlights that object for a moment.

• Click the up arrow to increase the day, year or month; click the

down arrow to decrease the day, year or month.
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• When you have the date correctly set, move the pointer to the

lower right corner of the Preferences window and click on

the Use gadget.

Click on the Clock window to see the new date.

Moving the day up from 31 to 1 increases the month by one. For

example, Jan changes to Feb. Also, increasing the month from Dec

to Jan increases the year by one.

This gadget sets parameters for data transfer through the serial port.

Change Selecting Change Serial opens a new window, containing gadgets

Serial named Baud Rate, Buffer Size, Read Bits, Write Bits,

Stop Bits, Parity and Handshaking. These settings depend

totally on the device performing the transfer (see the devices manual for

information). In general, you may never need this window.

This gadget determines the number of characters per line. The Text

Text gadgets allow either 80 characters per line or 60 characters per line.

Preferences highlights the active gadget in a different color. The

Commodore RGB monitor works best with 80 characters per line.

Other monitors read more clearly when the Amiga is set to 60

characters per line.

Click on the Workbench window and double-click the

Preferences icon.

• Click on the opposite text gadget number from the one currently

set.

Click on the Use gadget.

The character widths change on the screen.

• Click on the Workbench window and double-click the

Preferences icon.

• Click on the opposite text gadget number from the one currently

set.

Click on the Use gadget.

This gadget switches the CLI on or off for access from the

CLI Workbench window. CLI is the abbreviation for Command Line

Interpreter. The CLI allows file access, command execution and many

other commands not reachable from the Workbench. Chapter 4

discusses the CLI in detail.

Click on the Workbench window and double-click the

Preferences icon.

Click the Of f gadget next to the word CLI.
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■ ■■.■■• Click on the Use gadget.

This area has no gadget name. Adjust your colors by using the four

Workbench boxes and three sliders across the bottom of the Preferences

Colors window. Each color box matches a color on the screen. The sliders

control the amount of red (R), green (G) and blue (B) in each color.

• Click on the Workbench window and double-click the

Preferences icon.

• Click on the left hand color box, and look at the positions of the

sliders.

The sliders change position as you click on each color box. These

sliders show the degrees ofred, green and blue in each color.

• Click on each of the color boxes, and look at the slider positions

for each color box.

The sliders handle primary colors. The three primary colors in light are

red, green and blue. Dragging the sliders left or right increases or

decreases the amount of primary colors in die selected color.

• Click on the black color box.

• Move the pointer onto the white dot in the blue slider (the slider

marked B), press and hold the left mouse button.

• Drag the blue slider all the way to the right.

The areas that were black change to blue. Note that the other two sliders

are all the way to the left

• Click on the Reset Colors gadget.

The Reset Colors gadget returns any color changes to the colors

loaded in by the Workbench.

• Move the pointer onto the white dot in the green slider (the slider
marked G), press and hold the left mouse button.

• Drag the green slider all the way to the right

The black areas turn bright green.

• Move the pointer onto the white dot in the red slider (the slider

marked R), press and hold the left mouse button.

• Drag the red slider all the way to the right.

The green areas change to bright yellow.
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Drag the blue slider all the way to the right.

The yellow areas change to white, and hides any white text.

• Click on Reset Colors.

• Try the above color change procedures with all four color boxes.

There are three ways to change colors back to their original settings:

1. Clicking on the Reset Colors gadget

2. Clicking on the Reset All gadget. This sets every change

back to the Workbench settings as they were from the factory.

3. Dragging the sliders to their original positions.

This gadget adjusts the time delay between a keypress and the key

Key repeat. The Amiga waits for the amount of time you set here between

Repeat your pressing a key and the first key repetition.

Delay

Move the pointer onto the Key Repeat Delay slider.

• Press and hold the left mouse button.

Drag the slider all the way to the left to Short.

Click on the Preferences window's back gadget.

• Open the Utilities drawer and double-click on the Notepad

icon.

• When the Notepad finishes loading, press and hold a key for a

second.

The key begins repeating almost immediately.

Click on the Preferences window.

Move the pointer onto the Key Repeat Delay slider.

Press and hold the left mouse button.

Drag the slider all the way to the right to Long.

Click on the Notepad window.

• Press and hold a key until the key starts repeating.

The Amiga waits a second or two before it repeats the key.
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Key

Repeat

Speed

Display

Centering

This gadget adjusts the speed at which keys repeat when held down. For

example, if you press and hold a key in the Notepad, the Amiga

waits a moment then prints the letter until you release the key.

Click on the Preferences window.

Move the pointer onto the Key Repeat Speed slider.

• Press and hold the left mouse button.

• Drag the slider all the way to the right to Fa st.

Click on the Notepad window.

• Press and hold a key for a few seconds.

The Amiga prints the same letter on the Notepad a number of times,

even after you release the key. The computer stores the number of key

repeats in a keyboard buffer. This is an area in memory where

keystrokes are stored before the Amiga uses them. After you release the

key, the Amiga continues printing the repeated letter until this buffer

empties.

• Drag any windows out of the way of the Preferences

window's Key Repeat Speed slider.

• Move the pointer onto the Key Repeat Speed slider.

Press and hold the left mouse button.

Drag the slider all the way to the left to S low.

• Click on the Notepad window.

Press and hold a key for five or more seconds.

The letters repeat very slowly.

Click on the Reset All gadget to restore the original settings.

This area has no gadget name. Dragging the corner shaped character

moves the upper left corner of the screen.

Move the pointer onto the corner shaped character in the box in the

center of the Preferences window.

Press and hold the left mouse button and drag the corner shaped

character.

The corner shaped character moves, and so does the entire screen.
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These gadgets set interlace mode on or off. Interlace mode is the

Workbench Amiga's special setting for high-resolution graphics. This mode works

Interlace with very high quality monitors only; most monitors only show a

jittery picture. You may never need this mode.

Click on the On gadget for Workbench Interlace.

Click on the Save gadget.

When the disk drive stops, hold down the <Ctrl> key and press the

<Commodore logo> (or left <Amiga>) and right <Amiga> keys at

the same time.

Watch the screen display.

When the Workbench finishes loading, double-click the

Workbench disk icon.

• Double-click the P references icon.

Click on the Off gadget for Workbench Interlace.

• Click on the Save gadget

• When the disk drive stops, hold down the <Ctrl> key and press the

<Commodore logo> (or left <Amiga>) and right <Amiga> keys at

the same time.

Open the Workbench window by double clicking on the

Workbench icon.

• Double-click on the Preference icon.

This area has no gadget name. It sets the mouse pointer speed. Each

Mou s e number (1,2 or 4) represents the number of inches of mouse movement

Speed to move the pointer one third of a screen.

Move the pointer onto the Mouse Speed gadget (the vertical bar

with the numbers 1, 2 and 4 displayed in it).

• Click on the 4 gadget and move the pointer around.

The 4 setting makes the pointer move very slowly.

Move the pointer onto the Mouse Speed gadget.

Click on the 1 gadget and move the pointer around.

Click on the Reset All gadget.
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Double

Click

Delay

Change

Printer

This has no gadget name. It sets the time delay allowed between the

first and second clicks of a double-click. It lets you adjust the time

between the first click and the second click of a double-click.

Move the pointer onto the Double-Click Delay gadget (the

vertical slider with checkmarks next to it) and press and hold the

left mouse button.

• Drag the slider to the bottom.

Click on the Utilities window.

• Click once on the Calculator icon, wait a few seconds, and

click again.

The bottom setting allows up to four seconds1 delay between the first

and second click.

• Close the Calculator by clicking on its close gadget.

• Move the pointer onto the Double-Click Delay gadget

Drag the slider to the top.

This item lets you set the parameters that match the Amiga to your

printer.

• Click on the Change Printer gadget

freftrtncts

Figure 12:

Change

Printer

The Change Printer screen opens. This window contains a number

of options for setting printer parameters (more on these parameters

below).
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Amiga

printer

support

Parallel/

Serial

Printer

Type

Paper

Size/

Length

Paper

Type

Quality

Left

Margin/

Right

Margin

The Amiga includes drivers for the following printers: Alphapro 101,
Brother HR-15XL, CBM MPS-1000, Diabolo 630, Diabolo Advantage
D25, Diabolo C-150, Epson FX/RX series, Epson JX-80, HP LaserJet,

HP LaserJet Plus, Okidata 292, Okidata 92, Okimate 20 and Qume

Letterpro 20. There is also a generic printer setting.

• Click on the up arrow and down arrow in the top center of the

Change Printer screen until you find the name of your printer.

• Click the OK gadget when your printer appears in the upper right

window in highlighted text, or click the Cancel gadget to exit
without changing printer parameters.

• If you own a printer not on the list, try the generic printer
or Epson setting and click on the OK gadget.

If the printer still doesn't work see your dealer, new printer drivers are

available for many different printers.

The Change Printer screen contains the following printer

parameter options:

Click the printer icon for parallel printer output, or the telephone icon

for serial printer output. Unless you have a laser printer, or your printer

interface requires a serial port, the printer output port can stay set to
Parallel. Very few printers use the serial port.

Click the up arrow and the down arrow to look through the list of

printers. The printer marked for selection appears in highlighted type in

the center of this window. Custom is the name chosen for a custom

printer.

There are five paper sizes supported by the Amiga: U.S. Letter (8

1/2" x 11"), U. S . Legal (8 1/2" x 14"), Narrow Tractor (9 1/2"

x 11"), Wide Tractor (14 7/8" x 11") and Custom. If you select

Custom, you must also specify the Length of the page (default of 66

lines).

The Amiga accepts two types of paper: single and Fanfold.

The Amiga prints in two degrees of quality: Draft (low-quality) and

Letter (high-quality).

This area lets you adjust the margins. The numbers control the starting

and ending columns or printed matter. Usually this setting will only

need adjustment if you work with a typestyle smaller than the standard

10 characters per inch.
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Pitch

Spacing

Graphic

Select

Figure 13:

Graphic

Select

This controls the character size. You can choose Elite (12 characters

per inch), Fine (15 characters per inch) or Pica (10 characters per

inch). Click the desired field to select the pitch, if your printer supports

that pitch. See your printers owner's manual for that information.

This controls the spacing of lines on the page. Select either the 6 lpi

(lines pre inch) or 8 lpi gadget

This gadget opens the Graphic Select screen, which allows fine-

tuning when printing graphics.

Click on the Graphic Select gadget.

Preferences:

Threshold

Aspect

Shade

Image

The Graphic Select

gadgets:

screen opens. It contains the following

This determines which colors are printed as black or white. The farther

right the controller is positioned, more colors are printed as black.

Usually the default setting of two works quite well. Dragging the

triangle positioned above the number bar changes the Threshold

setting.

This gadget sets either horizontal or vertical printing.

Sets the printer shading for Black and White, Gray Scale

(shades of gray simulating color) or Color printing (if your printer

prints in color). Black and White often gives a better printout than

Gray Scale.

Prints a hardcopy as Positive (black is black and white is white) or

Negative (white becomes black and black becomes white).

• Click on the OK gadget to accept new values, or the Cancel
gadget to exit without changes. Either gadget returns you to the

Change Printer screen.
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Edit

Pointer

Figure 14:

Edit

Pointer

Click on the OK gadget of the Change Printer screen to accept

new values, or the Cancel gadget to exit. Either gadget returns

you to the Preferences window.

This option lets you change the appearance of your mouse pointer. This

is useful if you have your own ideas of how the mouse pointer should
look.

Click on the Edit Pointer gadget.

Preferences:

The Pointer Editing window appears. This window displays

five copies of the mouse. Four of these copies are normal size, one is

magnified

• Click on the magnified pointer window's blue background. Look at

the magnified pointer window, and the four duplicate windows to

the right of the magnified view.

Note that a dot appears on each window at the location you clicked in

the magnified view. This large window is where you edit your pointer.

• Click somewhere else in the blue background.

Each time you make a dot within the magnified window, the same dot

shows itself within the smaller windows.

Press and hold the left mouse button, and move the pointer around

in the magnified view. Make the window as messy as you can.

Release the left mouse button.

Move the pointer onto the small black box just above the RGB

sliders and click on it.

The sliders all move as far left as they can go. Also, a border appears

around the black box, indicating that black is the currently active color.

• Move the pointer into the magnified view.
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• Press and hold the left mouse button, and move the pointer in a

circular motion.

• Release the left mouse button.

The pointer now draws black dots instead of read ones. In addition, the

circle you made looks round in the smaller windows, although the

drawing looks squared off in the magnified view. The many dots form

lines and, of course, more or less smooth shapes when viewed in actual

size. Your current cursor stays unchanged until you click on the OK

gadget

Click on the Restore gadget

This gadget changes the magnified pointer to its original form.

Click on the Clear gadget

This clears the magnified view, except for one dot.

This single dot is called the point. It marks that part of the mouse

cursor which must be on the object for clicking or dragging.

You can move the point using the Set Point gadget.

Click on the Set Point gadget

• Move the pointer into the magnified view and click.

The point reappears at the spot you clicked.

Change colors using the sliders, the same way that you changed colors

in Preferences. A border surrounds the currently active color.

Clicking the OK gadget returns you to Preferences window. If

you make a mistake with the mouse, you can still fix it from

Preferences by selecting the Reset All gadget

Draw in the magnified view—make the pointer as messy as you

can.

Click on the OK gadget to return to Preferences.

Click on the Reset All gadget

The pointer returns to its original appearance.

This gadget stores your changes to diskette. You should only do this on

Save a copy of the Workbench diskette (not the original).
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This gadget tells the Amiga to use these changes for now. You can

Use always save these to diskette later on in this session if you want to
keep them.

This exits Preferences without any changes. The Amiga ignores

Cancel your changes, and the Workbench screen reappears with original
settings.
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2.11 Other Workbench tools

Reset

WARNING:

The start of this chapter described the pulldown menus of the actual

Workbench screen. This screen has three menu titles: Workbench,

Disk and Special. These functions were partialy explained in the

preceding sections. However, some of their items still need more

explanation, and a few things not on the menu need defining.

The last section demonstrated a reset. A reset is almost like switching

the power to the computer off and on. All values are reset and the

memory clears.

Make sure that you have a copy of the Workbench diskette in the

internal drive, that all data is saved, and that the disk drive LED is OFF

before trying this procedure.

Never reset the Amiga while the disk drive is running.

This could destroy data on the diskette.

Press and hold the <Ctrl> key.

Press and hold the <Commodore logo (or left <Amiga>) key.

Press the right <Amiga> key.

The screen goes blank, the drive runs and the Workbench screen

reappears. This lets you restart the Amiga whenever you want.

At first sight your Workbench screen looks exactly as it always did.

However, the name of the diskette icon says Copy Of Workbench,

not Workbench. If it only says Workbench, you're still using the

original diskette. Make a backup before you do anything else (see

Section 2.5 for information on copying diskettes).

Double-click the Copy Of Workbench diskette icon.

A window appears containing all the visible icons. Unlike the original

More Workbench diskette, you can save changes and programs to this

Workbench diskette.

• Press and hold the right mouse button.

Move the pointer onto the Workbench menu title.
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Select the Close item from the Workbench pulldown menu.

The Workbench window disappears.

As mentioned previously, Open is an alternate method of opening files

Open / and icons. The Close item is an alternate method of closing files and
Close icons.

Click once on the Workbench diskette icon.

• Press and hold the right mouse button.

Move the pointer onto the Workbench menu title.

Select the Open item.

The Duplicate item from the Workbench menu copies files and

Duplicate entire diskettes, provided the destination diskette has enough free
memory.

• Double-click the Demos drawer icon.

• Click once on the Dots icon.

Press and hold the right mouse button.

Move the pointer onto the Workbench menu title.

• Select the Duplicate item from the Workbench pulldown

menu.

The drive runs, and an icon named Copy of Dots appears.

Duplicate Copy of Dots following the above steps.

The copy of the copy receives the name Copy 2 of Dots.

If you want to make more than two backup copies, you must make

each from the last copy made.

You may prefer to change the name Copy 2 of Dots to something

Rename else. Use the Rename item for this.

• Click on the Copy 2 of Dots icon.

• Select the Rename item from the Workbench pulldown

menu.

When you have finished this, a requester appears on the screen. This

requester contains a string gadget listing the name Copy 2 of Dots.

• Click on the string gadget.
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• Press the <Del> key or <Backspace> key until the old name

disappears.

• Type in your new name.

Only letters to the right of the cursor can be deleted with the <Del>

key. The <Backspace> key deletes letters to the left of the cursor. If you

make a mistake, you can delete with these two keys. Also, if you want

to erase the name in the window completely, use the right

<AmigaxX> key combination.

The <Cursor left> and <Cursor right> keys move the cursor inside the

string gadget without deleting anything.

• Press the <Return> key.

The Amiga drive runs. The new name appears under the Copy 2 of

Dots icon. You can change any icon's name with the Rename item,

whether the object is a tool, project or diskette icon.

The Info item allows you to read and insert all sorts of information

Info on icons and programs.

Click on the Copy 2 of Dots icon whose name you changed.

• Press and hold the right mouse button.

Select the Info item from the Workbench pulldown menu.

The Info window appears for this icon. The window displays the

name you assigned this program. Below Name is the file or program

Type (in this case, a Tool). Type also lists the SIZE of the program

in question. This file is 16896 bytes, or 7 blocks long (see the

Appendices for a definition of block).

The last item is the STACK information. This item is of no interest to

most users, but don't touch it A wrong setup here could cause all sorts

of problems, most of which can only be solved with a reset

There is also a STATUS gadget. This states whether a file can be

thrown away or not A DELETABLE file can be thrown away. STATUS

can also be either Read/Write or Read only, depending on the

position of the write protection tab on the diskette. This status cannot

be changed through the mouse. The Amiga will not delete an

undeleteable file.

Another gadget has the name COMMENT. Here you can enter anything

you like. This way you can give yourself small reminders.

Click on COMMENT.
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• Type in Copy of a demo program and press the <Return>
key.

There is a Save gadget and a Quit gadget Selecting Save stores all

changes to the Info window. Selecting Quit exits the window

without making changes. The third method of exiting the Info
window is the Close gadget

Click on the Close gadget of the Info window.

The normal Workbench screen reappears. If you call Info for one of
the drawers, the Type is Drawer.

If you call Info for texts made with Notepad, DEFAULT TOOL

contains Workbench 1.2: Utilities/Notepad.

Open the Utilities drawer and double-click on the Notepad

icon.

Do not change the size of the Notepad.

Select the opal 12 font from the Fonts pulldown menu.

Type a short note in the Notepad and save it under the name

Test.

Select Quit from the Project pulldown menu.

• Click on the Test icon.

Press and hold the right mouse button.

• Select the Info item from the Workbench pulldown menu.

Scroll through TOOL TYPES using the up and down arrows until

you find the line Font=opal.l2

• Delete opal.12 using the <Backspace> («—>) key.

Type ruby.15 in its place.

• Click on the Save gadget

Double-click on the Te st text icon.

Now all the text that previously appeared in opal.12 should now

display in ruby.15.

The Discard item performs the same task as the Trashcan icon.

Discard

• Activate one of the two copies of Dot s.

82



Abacus 2.11 Other Workbench tools

Select the Discard item from the Workbench pulldown

menu.

A requester appears:

Figure 15:

Warning:

Harninffl you

cannot get back
uhat you discard

Discard is a delete function which cannot be undone. If you

accidentally select Discard, click on the forget it! gadget

Click on the ok to discard gadget to proceed.

The icon disappears and the disk gauge drops a little.

There is still a copy of Dots in the Demos window. Here is a

different way to move icons.

• Drag the copy of Dots icon outside the Demos window.

Place it somewhere on the Workbench screen.

The copy of Dots disappears from the Demos window and

reappears somewhere on the Workbench screen.

Close the Demos window.

The copy of Dots stays on the Workbench screen.

• Double-click copy of Dots.

You can remove files, programs or other things from the windows in

which they belonged, and open them outside the windows. This is a

practical feature. For example, say you use the Notepad very

frequently. Each time you must open the Utilities drawer to open

Notepad. Instead, open the Utilities drawer once, drag the

Notepad and texts onto the Workbench screen, and you're all set.

Another advantage to movable icons is easy file copying.
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Single drive Amiga owners must exchange diskette often when

WARNING: copying. Remember to remove diskettes from the drive when the disk
drive LED goes out. Even if the requester prompting you to take a

diskette out of the drive appears, make sure that all the drive operations
have finished. Never take a diskette out of a drive while the drive is in

operation.

Insert a formatted diskette into your drive.

An icon appears on the Workbench screen named Empty.

• Drag copy of Dots onto the Empty icon.

The Amiga requests that you insert your Workbench diskette.

Insert the requested diskette.

Amiga now gets the necessary information from copy of Dots on

your Workbench. A hint for those with two drives: Simjply insert the

Empty diskette into the second drive and drag the copy d>f Dots icon

onto the Empty icon.

Remember the warning above when copying diskettes, otherwise the

Single drive data on your Empty diskette can be destroyed. Once the copy procedure
users: finishes have a look at the Empty diskette window.

Open the Empty diskette icon.

Somewhere in the window is the copy of Dots icon just copied. The

original copy of Dots still appears on the Workbench screen because

it was only copied, not moved. You can also move icons from one

window to another.

• Click on the Workbench window to activate it.

Open the Empty drawer in the Workbench window.

If the Woikbench diskette is not in the drive, the Amiga requests it

• Drag the Clock icon into the Empty window.

The drive runs, and after a short while the Clock icon disappears from

the Workbench window and reappears in the Empty window. If

you close the Empty window, the Clock icon disappears as well.

Drag the Clock icon back into the Workbench window.

When you drag an icon from one diskette window into another diskette

window, the Amiga copies the program and icon. You now have a

number of copies of Dots. It's time to dispose of some of them.

• Take a copy of Dots.
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Empty

Trash

Special

Clean Up

Drag it onto the Trashean icon.

Make sure that the Trashcan icon is in the same window as the Dots

file. This means that if you want to delete an icon from the

Workbench window, then you must place this icon onto the

Trashcan in the Workbench window.

The disk drive runs, and the copy of Dots disappears. The

Trashcan stores the file in another area of the diskette, before you

discard the file using the Empty Trash item from the Disk menu

(see Section 2.8).

Activate the Workbench diskette icon.

• Select the Special pulldown menu.

The Special menu has five items. Most of these items are ghost

items right now.

This item puts icons in a selected drawer or diskette into neat order.

• Double-click the Workbench diskette icon.

• Double-click the System drawer to open it.

• Drag a few icons to different places in the System window.

• Click once on the System drawer icon to activate it.

Select the Special pulldown menu.

• Select the Clean Up item, and watch the System window.

The Amiga automatically tidies up the System window. You can

also clean up entire diskettes:

• Double-click the Workbench diskette icon.

• Drag a few icons to different places in the Workbench window.

• Click once on the Workbench diskette icon to activate it.

• Select the Special pulldown menu.

Select the Clean Up item, and watch the Workbench

window.

Remember that Clean Up works only on active diskettes or drawer

icons.
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• Open the Utilities drawer.

Drag the icons to different places in the Utilities window.

• Select Clean Up from the Special pulldown menu.

Nothing happens, because the Utilities drawer needs activation. An

active window is not enough.

• Click on the Utilities drawer to activate it.

• Select Clean Up from the Special pulldown menu.

This item redisplays the last error made. If this item appears in ghost

Last print, then there is no error. Here's a self-made error to demonstrate this

Error item:

Drag the Workbench diskette icon up to the top of the

Workbench screen.

The screen flashes, the Workbench diskette icon reappears at its old

location, and the title bar displays the message Icons cannot be

moved into this window.

• Click somewhere on the Workbench screen.

The message disappears. Suppose you didn't see that error message, and

wanted to know what it said:

• Select Last Error from the Special pulldown menu.

The error message reappears on the title bar, and reappears every time

you select Last Error. The message changes when another error

occurs.

This book mentioned Redraw in Section 2.2. If for any reason the

Redraw screen needs restoration, select Redraw from the Special

pulldown menu. The original screen reappears. This is one of the few

Amiga items that can be accessed at any time.

The Snapshot item takes a "screen photo." This is easier to

Snapshot demonstrate than describe:

• If the Utilities drawer is still open from above, close it.

• Double-click the Ut i1it ies drawer icon.

Extended selection lets you activate several icons at the same time.

Simply press down one of the <Shift> keys and click once on every

icon you want selected.

Press and hold a <Shift> key.
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Version

RAM disk

• Select all the icons inside the Utilitites window.

Select the Snapshot item from the Special pulldown menu.

The disk drive runs, and nothing appears to happen.

• Close the Utilities window, and reopen the Utilities
drawer.

Everything looks in order. Snapshot, however, lets you determine

the positions of the individual icons within a window, as well as the

window size and the point on the screen at which it appears.

Reduce the size of the Utilities window as much as possible

using the sizing gadget.

• Drag the Utilities window to the lower right corner of the

Workbench screen.

• Click once on the Utilities drawer icon in the Workbench

window.

• Select Snapshot from the Special pulldown menu.

Close and reopen the Utilities window.

Snapshot ensures that the window reopens at the size and location at

which you set the window when you selected Snapshot. It's

unnecessary to select all the icons. Most of them are usually correct,

and only one may need moving to a better position. The fewer the icons

you select and move into position, the quicker Snapshot executes.

This item is of interest only if you want to know the version number

of your Workbench diskette.

• Select the Version item from the Special pulldown menu.

Version numbers of Workbench change as the developers of the Amiga

improves the Workbench programming. As long as your version

number is higher than 33.S6, there should be no problem.

The Amiga 500 Workbench produces a diskette icon named RAM disk.

This icon behaves like a normal floppy diskette, with three differences:

1) It is incredibly fast, much faster than floppy or hard diskettes.

2) It is temporary; anything saved or copied to the RAM disk

disappears once you turn the Amiga off, unless you save the

RAM disk's contents to a floppy diskette or hard disk.

3) You cannot format a RAM disk with Initialize.
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4) RAM disk capacity is small compared to floppy diskettes.

• Drag the Clock icon from the Workbench window to the

RAM disk icon.

Double-click on the RAM disk icon.

Double-click the Clock icon in the RAM disk icon.

See how quickly the RAM disk opens the window and starts the

Clock; much faster than normal diskettes. Notice, also, that the disk

gauge on the left of the RAM disk window is full.

Drag the entire Demos drawer from the Workbench window to

the RAM disk window.

Watch the memory bar on the top of the Workbench screen.

The disk gauge still says the RAM disk is full, but the Demos drawer

is copied to the RAM disk. The Amiga's RAM disk is always full, but

it's dependent on the computer's memory; the RAM disk is virtual.

That is, RAM (Random Access Memory), the memory used for your

programs and working space, supplies the space needed for the RAM

disk—as much as is available.

There is a disadvantage to the RAM disk, however. The more memory

occupied by the RAM disk, the slower programs run.

These are the advantages and disadvantages of the RAM disk: It is

Summary extremely fast, but it takes up large amounts of RAM. Unless you have
memory expansion built into the Amiga, use the RAM disk sparingly.

It makes sense to use the RAM disk when copying diskettes on a

single-disk system, since it saves diskette changing.
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2.12 Amiga additions

This section talks about hardware changes that you can eventually make

to your Amiga configuration. There are quite a few pieces of hardware

available for improving your Amiga.

The modulator mentioned in Section 1.1 allows you to connect your

Modulator Amiga to a color television through the RGB output jack on the back
of the Amiga. The one end of the modulator's cable plugs into the

modulator, while the other end connects to the television's antenna

input

The modulator has three connections:

1. RF-Out sends the combined audio and video signals to

the television.

2. Video Out connects the modulator to a color video

recorder. This lets you record special effects and animation

onto videotape from your Amiga.

3. Audio In transmits the Amiga's sound system to the

television, monitor or video recorder. You remember

working with the Y cable in Chapter 1. Instead of

plugging the single end of the Y cable into a monitor,

you plug it into the Audio In jack.

One alert you may see the message Not Enough Memory. This

Memory occurs at different times on a 512K Amiga. The Amiga 1000 came with
expansion 256K, so this happened much more often on the 1000 models. More

and more Amiga programs come on the market requiring 512K, so if

you own an Amiga 1000, memory expansion is a necessity.

For Amiga 500 users, there's another advantage to purchasing more

memory. The memory expansion currently available for the Amiga 500

allows more use of the RAM disk, and a permanent clock. Since this

expansion is battery-powered, the clock stays on constantly.

Memory expansion can be added by your local dealer. The expansion

board plugs into the housing underneath the Amiga 500, and the Amiga

1000 accepts an expansion board on the front of the central processing

unit.

Some software may not run with the added memory on the Amiga 500.

NOTE: If this happens, use the program NoFastMem from the System drawer
before running the problem program. This program disables the

memory expansion in the Amiga 500.
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A external disk drive makes copying, initializing and program and file

Disk drives storage much easier. See Section 1.3 for informationon connecting an
external disk drive.
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3. AmigaBASIC

AmigaBASIC is a computer language—an implementation of the

BASIC language. BASIC (Beginner's All-purpose Symbolic Instruction

Code) is only one of the many computer programming languages

available, and is slower than C or assembly language. AmigaBASIC,

however, can easily be learned by a new user, and runs programs fast

enough for most people.

This chapter prepares you for your first contact with the AmigaBASIC

language. However, don't expect a complete tutorial of BASIC. There

isn't enough room in this book to include a complete guide to BASIC

for the beginner. Just consider the fact that Abacus* AmigaBASIC

Inside and Out is over 500 pages long. If you're interested in a BASIC

book that will teach you the language to advanced levels, AmigaBASIC

Inside and Out is the book for you.

This chapter covers three major subjects. Section 3.1 introduces the

demo programs on the AmigaBASIC diskette. These will give you an

idea of what AmigaBASIC can do. Many of these demo programs were

written by Commodore development personnel, and they demonstrate

the Amiga's extensive capabilities.

Sections 3.2-3.4 describe writing programs in AmigaBASIC. Even the

simplest listing becomes impossible if you don't know where and how

to enter it. This applies especially to the Amiga, which is very different

from other computers' BASIC versions. This second part gives you

enough background to enter AmigaBASIC listings from computer

magazines or books.

The remaining sections of this chapter contain short and easily entered

programs involving graphics, sound and animation. These programs

give you a chance to understand the program structure in your

AmigaBASIC manual. The author recommends that you study that

manual and its sample programs before vou try the programs in

Sections 3.5-3.10. Figure out the major program logic on your own

using this chapter, the AmigaBASIC manual and the short explanations

in the listings.

If you discover that you won't get much further in BASIC without

help, many books on the subject of AmigaBASIC can help.

The main thing to keep in mind during this chapter is: Programming is

the only way to learn programming.
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3.1 The Extras diskette

The diskette named Amiga Extras contains AmigaBASIC and more.

Insert the Extras diskette into the drive.

As usual, a diskette icon appears on the Workbench window. It has

the name Extras.

• Double-click the Extras diskette icon.

Figure 16:

Extras

window

All the things you see in this illustration should be on your Extras

diskette. The contents of this diskette change occasionally at the

factory, so it's hard to say exactly what your particular copy of the

Extras diskette may have. However, only two icons on this disk are of

real importance to us right now: AmigaBASIC and BasicDemos.

The drawer labeled FD1.2 is also extremely important None of these

files are of direct use to you, but the programs contained in the

BasicDemos drawer won't function without them. Never experiment

with the FD1.2 drawer.

Usually the rest of these icons become interesting once you have

experience in programming AmigaBASIC.

If you haven't already done so, please make a backup

copy of the Extras diskette.

See Section 2.5 for information on Diskcopy. This chapter assumes

that you have a copy of the Extras diskette.
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BASIC

icons

Interchange

File Format

This window contains several icons. There is a Trashcan icon, which

appears on all Amiga diskettes. There are also two drawer icons. One

has the name BasicDemos, and the other has the name Tools.

• Double-click the BasicDemos icon.

Your disk drive runs, and a window named BasicDemos appears.

Enlarge the BasicDemos window so that you can see

everything on it

A number of icons with dog-eared pages appear on the screen. Some of

these icons look like typed pages, while others have drawings on them.

The typed pages are data files generated by and read from a program.

Some of these are function libraries that allow AmigaBASIC to do even

more than it already can. As a beginner you really don't need to know

much more about them. See your Amiga's BASIC manual for more

information.

Double-click the Music icon in the BasicDemos window.

If your Amiga is near your stereo system, you can connect the Amiga

sound outputs to the auxiliary inputs of the stereo. To write something

like this you almost have to know more about music than

programming. But the most important thing about this program is that

it is written in BASIC.

Close the Music window by clicking on its close gadget.

• Double-click the LoadlLBM-SaveACBM icon in the

BasicDemos window.

Most of the directions are on the screen already. You may wonder what

ILBM files are. All you really need to know for now is that a few

inventive programmers created a standard format for saving and loading

data. This format, known also as the Interchange File Format (IFF), is

often a critical factor in drawing and painting programs, since it allows

you to interchange drawings between programs. IFF pictures can even

be used in animation programs! This makes you, the consumer,

independent of individual manufacturers. If you like manufacturer X's

drawing program, but prefer manufacturer Y's animation program, they

will still be just as compatible as if you has bought both programs

from the same company. Just be sure the programs use IFF format

Also, you can use the IFF pictures created by these programs in your

own BASIC programs. Back to the original topic. If you want to write

a game that uses pictures made with another graphic program, you can

use one of the programs on the Extras diskette designed for transferring

graphics from one program to another.

Enter Heart.ILBM and press the <Return> key at the ILBM

filespec? prompt.
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NOTE:

Screen

NOTE:

ObjEdit

NOTE:

Library

• Press the <Return> key at the prompt ACBM-filespec?

The disk drive runs, and loads pictures of the Jarvik-7 artificial heart and

a natural heart. A simple drawing program created this picture. This

gives you an idea of what you can achieve after you've worked with

your Amiga for a while.

The movement you see here is cycle animation, not true animation.

Almost every Amiga drawing program in existence has this feature.

The program shows the picture for only 20 seconds. To change this,

you'd have to change the program itself. You're not advanced enough

yet to do that, and this is one of the more complicated programs on the

diskette.

The functions of the other demos you'll find here become more

interesting once you get more involved in AmigaBASIC. If you'd like

to know what each program does, load the file named List-ME. It

gives you details about the programs not described here. All of the

demos start with a double-click, just like any other Amiga program.

This is a good demonstration of the Amiga's object graphics and color.

If you change the window's size, the sizes of the squares change

proportionately. The Amiga selects colors at random.

It is possible that while you run these demos, a program stops at a

certain point. Then the Amiga beeps, and a requester saying Illegal

function call or a similar error message appears. A window

labeled LIST appears, and another window may appear as well.

Click the OK gadget in the requester.

• As soon as the close gadgets of the two windows become visible,

click on them.

The normal Workbench screen reappears, and you can restart the same

program or start another program.

ObjEdit is the abbreviation for Object Editor. This program can be

used to create bobs and sprites on the Amiga. Bobs and sprites are

graphic shapes that you can move across the screen quite easily using

BASIC commands without disturbing the background.

When you work with ObjEdit, be sure to save your work at regular

intervals.

This program shows that different fonts, font sizes and typestyles can

be called in an AmigaBASIC program. However, this requires a certain

amount of programming knowledge, as with most of these demo

programs. Clicking on the close gadget ends the program.
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The Amiga can also speak. The BASlCDemos window has a demo

Speech program for this as well.

Double-click the Speech icon in the BASlCDemos window.

The Amiga says, Please—type what you want me to say. A

string gadget appears, into which you type a sentence.

• Type in any sentence and press the <Return> key at the end of your

input.

The voice quality changes when you adjust the sliders underneath the

string gadget. These parameters are for voice quality:

Pitch The voice's pitch (frequency).

Inflection Type of vocal inflection.

Rate

Voice

Tune

Volume

Rate of speed for speech.

Voice gender.

Sets changes in voice quality.

Loudness.

The best way to find out the uses for these controls is to use them.

• Type in the sentence I 'M WORKING WITH WINDOWS and press

the <Return> key at the end of your input.

Now let's go through the controls one by one.

Click on the right of the P itch slider, or drag it all the way to the

right.

Press the <Return> key.

The Amiga voice now sounds high.

• Set P itch to the level you like best.

• Click on the right of the Inflection slider, or drag it all the

way to the right

Press the <Return> key.

This moves all the way to the right or all the way to the left only. The

right hand setting makes the Amiga speak with no inflection.

Click on the right of the Rate slider, or drag it all the way to the

right.
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• Press the <Return> key.

• Once you've heard how fast the Amiga can say things, set the slider

to a speed you can understand.

• Click on the right of the Voice slider, or drag it all the way to the

right.

Press the <Return> key.

This slider can be all the way left or all the way right only. It controls

the gender of the voice (male or female).

Click on the left of the Tune slider, or drag it all the way to the

left.

Press the <Return> key.

The Tune slider alters the pronunciation speed of individual letters.

The last slider, the Volume slider, turns the volume up or down.

Remember that its maximum is only as loud as the monitor's volume

setting.

Each parameter which you set with the sliders can be operated with

BASIC commands (more about this later).

Click on the close gadget to close Speech.

• Double-click on the Picture icon.

An oval forms in the upper left corner of the screen, and nothing else

seems to happen.

Move the pointer onto the screen and press the left mouse button.

The upper left corner of the picture appears at the pointer's current

location. Keeping the left mouse button pressed lets you drag the

picture around.

The programs behind these demos are often not so difficult to write as

they might seem. This chapter is here to help you in the first steps of

BASIC programming.

Click on the Picture window's close gadget.

• Close the BASlCDemos window.
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Demo

This program demonstrates some neat color graphics. The Amiga opens

four windows each drawing seperate graphics

Don't worry if your Extras diskette does not contain all of the programs

mentioned. The Extras diskette is extra and does change. See the

README and list me files on the diskette for more information.
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3.2 Starting AmigaBASIC

Now that you have seen more or less of everything in the Extras

window, it's time to start AmigaBASIC.

Double-click the AmigaBAS IC icon.

The disk drive runs, and two windows appear on the screen: The LIST

window and the BASIC window.

Figure 18:

BASIC and

LIST

windows

• Click once on the BASIC window.

In principle these windows work just like the Workbench window.

Move the pointer anywhere in the BASIC window and click once. If

you did this right, the Amiga confirms it by displaying OK.

The Workbench is in the background. If you want to see it, you only

have to close the LIST window and the BASIC window. For now,

though, keep the BASIC and LIST windows open.
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3.3 First steps in BASIC

This section covers the principles of BASIC programming, starting

with a few basic rules, and takes you up to the first programs. Each

command appears in the left margin of the text, followed by the

command's description.

For example, this is the format for a command and its description. Any

COMMAND program lines you should type in appear indented, in a typewriter-style

font.

PRINT "This is a sample program line. "

The BASIC window has several functions. First, it displays

everything which a program produces as output

Close the LIST window.

The BASIC window automatically becomes active. After starting

AmigaBASIC, a certain text appears in the BASIC window. It gives

the BASIC name (Commodore AmigaBASIC), its version number,

when it was made, the developer (Microsoft Corp.), and the number of

bytes free in the system and in BASIC (see the Appendix for a

definition of bytes).

• Enter CLS ftom the keyboard and press the <Return> key.

You can type these letters in either uppercase or lowercase lettering.

Pressing the <Return> key after a command executes, or performs, that

command.

CLS (CLear Screen) clears all text and graphics from the BASIC

CLS window. Perhaps you're wondering why you need to press the <Return>

key. AmigaBASIC is an interpreted language. The interpreter in

AmigaBASIC takes your BASIC commands and translates them into a

form the Amiga understands. Pressing <Return> sends the command to

the interpreter.

The language the Amiga understands is one of numbers. Two numbers,

to be exact—0 and 1. Computers understand two conditions; power on

and power off. Each time you input CLS, the interpreter translates it

into a set of binary numbers (numbers in base 2), which looks

something like 00000111010011001010011010101.

• Type in My name is Napoleon.
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Nothing happens. The Amiga accepts this. Now tell the BASIC

interpreter to translate this sentence:

• Press the <Return> key.

The Amiga beeps once, changes the screen color and displays an error

requester which says Undefined Subprogram, or something

similar.

• Click on the OK gadget in the error requester.

When you press <Return>, the BASIC interpreter looks to see whether

or not My name is Napoleon. is a BASIC command. Since there

is no such command, then the Amiga gives an error message and tells

you why it can't execute this line. This error requester disappears when

you click on the OK gadget.

When you entered the sentence above, you noticed the small orange box

which moved along as you typed. This is the BASIC cursor, which

shows your position on the screen.

PRINT performs output in the BASIC window. The word comes from

PRINT the early days of computing, when output went directly to a printer

instead of a screen.

• Enter the line:

PRINT Christian Spanik

• Press the <Return> key.

The Amiga displays two zeros. The Amiga assumed here that

Christ ian Spanik was a pair of variables. Variables are letters or

even combinations of letters given values. Since neither Christian

nor spanik contains a number, the Amiga returned two zeros.

If you want the Amiga to display exactly what you input, then you

must enclose the words in quotation marks. Any text you put between

quotation marks appears on the screen.

• Enter the line:

PRINT "Christian Spanik"

• Press the <Return> key.

The words Christian Spanik appear in the BASIC window.

Enter your own name if you prefer.

You can also calculate with PRINT:
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NOTE:

Direct mode

• Enter the line:

PRINT 10/21

Note the paragraph marker (SI) at the end of this line. Any time you see
this marker, press the <Return> key. This format is used for the rest of

the book.

The Workbench Calculator showed you that the standard character

for computer division is the slash (/), instead of the normal division
sign (+). The Amiga displays the result of 10 / 2 on the screen.

There is a difference between 0 (zero) and O (the letter O) inside the
computer. Make sure that you always type <0> for zero and <O> for

the letter O.

The result of our calculation is 5. If you wanted 10/2 and not 5
displayed, the line would read PRINT "10/2WI. The output

reproduces the figures entered between the quotation marks. Now

combine both types of output

Enter the line:

PRINT "10/2="10/23[

? is the abbreviation for PRINT.

• Enter the line:

?" 10 dividedby 2 is" 10/251

You see it works just the same. And something more, the text between

the quotation marks can be quite free, whatever you put there. You can
even display the + in quotation marks as a sign for division, press the
<Alt> <Shift> and <x> keys to display this character. Remember,

though, to use the slash (/) for the calculation itself.

Entering commands which the computer carries out at once is called
direct mode. You can do much more than that in direct mode, though.

X and Y are universal variables in math. They crop up again and again

wherever two variables are needed.

• Enter the line:

7X/YSI

The Amiga beeps once, changes the screen color and displays an error

requester which says Division by Zero.

Division by zero cannot be done, by you or by a computer. The

computer read the above line as: Divide X by Y.
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• Click on the OK gadget in the error requester.

The Amiga responds with OK.

By the way, if you are slowly running out of space at the bottom of the
A croiling window, don't worry. AmigaBASIC allows you to scroll. When there is

no more room at the bottom, the Amiga lets one of the lines at the top

disappear, and goes on using the space made available at the bottom.
This is called scrolling. In direct mode, the line rolls up out of the top
of the screen, but that doesn't matter.

Like the example above (PRINT Christian Spanik), the Amiga
views X and Y as variables. Try division with combinations of letters:

?Christian/SpanikSI

The Amiga again displays an error requester, telling you that you tried
to divide by 0.

AmigaBASIC assigns each variable which doesn't have a value of 0.

This means that BASIC reads ?X/Y as "Print 0/0." Christian and

Spanik were read as variables above, and AmigaBASIC assigned them

zeros. If you want to check the value of each variable:

?X:?Y:?Christian Spanik

All four variables come up 0. You can change this by assigning values

LET to variables. There are two ways to assign values to variables, but the
most common method is with LET.

LET y=5Sl

Make sure that there is a space between the LET and the y. The Amiga

responds with OK. When an OK appears, this means that AmigaBASIC
accepted this input

Enter the line:

This time the result is 0.

• Enter the following:

LET y=2SI

LETx=10SI

You can calculate using these placeholders.

Enter the following:

104



Abacus 3.3 First steps in BASIC

Program

mode

let christian=100SI

let chris=501

?(x/y)+(christian-chris)*y*x5

The parentheses force the Amiga to process the individual math

functions in the right order. The result is 1005.

By now it should be clear that the direct mode also has its
disadvantages. It's very good for short statements, but it just doesn't
work when more complex things are involved. Plus, you can't make
corrections in direct mode; incorrect lines have to be retyped. Finally,
once a line scrolls up past the top of the BASIC window, it's gone.

The LIST window lets us operate in program mode. That is, you can

enter programs in the LIST window, correct them, look through the

entire program, and scroll through program code.

• Press and hold the right mouse button.

A pulldown menu bar appears at the top. This menu bar has four titles:

Project Edit Run Windows

• Select the Show List item from the windows pulldown

menu.

The LIST window reappears and becomes active. The BASIC cursor

appears in the LIST window.

• Enter:

? "Hello" 91

Press the <Return> key.

The text doesn't appear in the BASIC window, but the "7" turns into
the word PRINT. The BASIC cursor moves down one line. Still no

output.

• Enter:

print "Hello"

• Do not press the <Return> key yet.

The word print remains in lower case.

Press the <Cursor up> key.

print becomes PRINT, and the remainder of the text stays as it was.

The program still hasn't run.
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Program mode is the mode in which you write a program. The lines
above are a simple program.

You may have already looked at some books on BASIC programming.

Most BASICs use line numbers to help the computer process

commands in order. AmigaBASIC doesn't use line numbers.

The Amiga doesn't need or use line numbers because it has a separate

window for entering programs: the LIST window. A normal BASIC

listing could look like this:

10 PRINT "Hello"

20 PRINT "Hello"

Anyone who knows a little about BASIC knows that this program
prints Hello on the screen twice.

The BASIC window is also called the output window, which is a

window used for output (display).

You now, therefore, have two windows; one for output, and one for

entering the program lines.

• Activate the BASIC window.

The BASIC cursor reappears, and you can again make direct mode

input.

• Enter the following in the BASIC window:

RUN9I

The LIST window disappears and the word Hello appears twice on

the BASIC window.

• Enter the following in the BASIC window:

RUNS!

The screen clears and the word Hello appears twice on the BASIC

window.

BASIC programs have a command that runs, or executes, them. The

RUN word is RUN. You can now enter RUN as often as you like. The Amiga

processes your program whenever you enter this command.

In summary, write programs in the LIST window. The computer

automatically notes die commands and their sequence there. Carry out

commands directly by writing them in the BASIC window.
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After the start of the program your listing vanishes. But you now know

how to retrieve it.

Press and hold the right mouse button.

Select Show List from the Window pulldown menu.

The LIST window appears on the screen.

Press and hold the right mouse button.

• Move the pointer to the Window menu title.

Note that a A and an L appear to the right of the Show List menu

Keyboard item You remember keyboard shortcuts from your work with the
Shortcuts Notepad in Chapter 2. A stands for the right <Amiga> key; the L

is quite simply the <L> key.

• Type RUN or run in the BASIC window and press the <Return>

key.

You can use uppercase or lowercase letters, or both in combination. As
soon as the program runs, the LIST window disappears. Now you can

try the keyboard shortcut

• Press and hold the right <Amiga> key and press the <L> key.

Immediately the listing appears again. Sometimes it's more practical to
work with keyboard shortcuts than with the mouse. The mouse can be

used at any time.

The LIST window and the BASIC window now stand next to each
other on the screen. Let's look more closely at this first BASIC

program.

There is nothing in the LIST window but PRINT "Hello" twice.
Just Hello appears twice in the BASIC window. The listing appears

in the LIST window, while the BASIC window shows the results of

the program.

• Press and hold the right mouse button.

Select Show List from the Window pulldown menu.

• Activate the LIST window by moving the mouse pointer into the
LIST window and pressing the mouse button.

Your BASIC cursor should now be somewhere within the List

window. It is not easy to see at first.
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Working on a BASIC program consists of two parts: writing and
C ursor keys correcting. This paragraph is about the correction phase, or editing. The
and editing <Return> key is important when programming in most versions of

BASIC, since it ends a line of input and sends the line to the

interpreter. In the AmigaBASIC LIST window, all you need to press

is a cursor key when editing to accept an edited line. There are a few

exceptions to this rule, which are discussed below.

You have already learned one of the basic functions of the editor:
moving the BASIC cursor by using the cursor keys.

Activate the LIST window.

Press and hold the <Cursor down> key.

Soon the Amiga beeps, and the screen changes color. The reason for

this is that you cannot move the BASIC cursor past the end of a

program with the cursor keys. Only the <Return> key allows that,

since it extends to the end of the program.

The computer has to know a program's length and ending point. Each

time you need more space, you must tell the computer by forming a

new line (pressing the <Return> key). This saves space when later

saving the program to diskette.

• Position the BASIC cursor directly below the last line.

Type in:

?"Hello"SI

The Amiga now displays ?"Hello" three times on the LIST

window. Run this program again to check this out. This time, don't

type RUN in the BASIC window. Instead, use the Start item from

die Run pulldown menu:

• Press and hold the right mouse button.

• Select the Start item from the Run pulldown menu.

If your LIST window is active when you select Start, then the

following happens: The Amiga displays Hello in the BASIC

window three times, the program ends and the LIST window activates

again. Up to now the listing disappeared as soon as the program ran. If

the BASIC window is active, die LIST window disappears and

remains hidden. If the LIST window is active, it reappears after the

program executes. You'll see the advantages of this in the course of the

next few pages.

The Start item of the Run pulldown menu also has a keyboard

shortcut: right <Amiga><R>.
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Copying

text

Marking

blocks

Cut

Paste

Assume you want the program to display Hello 10 times in the
BASIC window. You have two choices: You can type the same
sentence in seven more times, or you can use the editor. The editor
copies program text. Go to the Edit pulldown menu and select the
Copy item. This item allows you to copy anything that is selected

within the shaded area.

Activating so far has meant clicking an icon. With Amiga's BASIC
editor, this technique can mark and use certain parts of the screen, even

for programming and editing programs.

• Move the mouse pointer to the left of the P in the first line.

Press and hold the left mouse button.

• Drag the pointer past the last line.

Note that parts of the LIST window are now a different color. This
color change is called highlighting, and this process is used in marking
blocks for editing. You could have marked only one line or word as
easily as you marked the entire program. If you make a mistake, click
again somewhere to get rid of the highlighting. If you only want to
maik a single word, double-click on that word. Try this with PRINT or

Hello in your listing.

There is a second method of marking whole blocks, which is somewhat

more accurate:

Move the pointer to the required position and click once.

Make certain that the BASIC cursor which then appears is in the right
place (before the first letter to appear inside the marking).

• Move the cursor to the position after the last letter to appear inside

the marking.

• Press a <Shift> key and click the left mouse button.

• Mark the three PRINT "Hello" lines as a block.

• Select the Cut item from the Edit pulldown menu.

The three program lines seem to vanish.

Select the Paste item from the Edit pulldown menu.

Your program reappears. Now produce 10 program lines from these

three.

• Mark the three PRINT "He 1lo " lines as a block.

Select the Copy item from the Edit pulldown menu.
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The Copy item only makes a copy of the marked program area. The
Copy Amiga doesn't know where you want the copy placed.

• Position the cursor to the beginning of the line after the last
program line.

• Select the Paste item from the Edit pulldown menu.

You now have six lines of PRINT "Hello".

• Select Paste again.

Now you have nine lines of PRINT "Hello" in your program.

• Select Paste again.

Now you have two lines too many; this was an intentional move.

• Mark the two extra PRINT lines as a block.

• Press the <Backspace> («->) key once.

. Now you have ten PRINT commands after deleting the two extra
Deleting text program lines. Unlike Cut, which "removes" the maiked block for later

pasting, deleting removes text permanently. You cannot recover text
removed by the <Backspace> key.

Remember one thing when working with the Edit menu items: As

soon as you put anything new in the memory used by Copy and Cut,

any previous data is deleted. This means that the Edit items store a
block only once.

You may feel as if you've spent too much time on this program.
FOR...NEXT There's an easier way to put the same message on the screen ten times.

The solution is the FOR...NEXT loop. The word loop means that

FOR...NEXT is placed round part of the program. Here's the easy way of

writing a program that has the same result:

• Mark all the PRINT "Hello" lines except one as a block.

Press the <Backspace> (<«->) key once.

• Position the BASIC cursor (with the cursor keys or the mouse) to

the left of the PRINT of the remaining command and press the

<Return> key.

• Position the BASIC cursor to the top line (now blank) and type in:

for x=l to 10

• Position the BASIC cursor (with the cursor keys or the mouse)

past the bottom line.
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Note that the words for and to, written as lowercase letters,

automatically change into uppercase letters. This is another one of the
editor's tricks. It prints all BASIC command words in uppercase. Letters
or words which aren't BASIC commands remain as the programmer has
entered them. This way you can quickly tell variables and placeholders

from BASIC commands.

• Enter the line:

NEXTfl

The finished program should look like this:

For x=l To 10

PRINT "Hello"

NEXT

Run the program.

The same result, with a third of the programming effort and space as

before.

END closes a program which works properly. If you do not use END to

END finish the program, the program does in fact stop, but for this
demonstration an END is better.

• Be sure your LIST window is active.

• Position the BASIC cursor (with the cursor keys or the mouse)

past the bottom line.

• Enter the line:

endSI

Your program should now look like this:

FOR x=l TO 10

PRINT "Hello"

NEXT

END

Select the Step item from the Run pulldown menu.

The BASIC window clears, and the LIST window remains at first
sight as it was, except an orange frame surrounds the first program line.

Select the Step item again, or press right <AmigaxT>.

Now Hello appears in the BASIC window, just once. Nothing else
happens. But the program hasn't ended, otherwise there would be an OK

under the Hello and the cursor would be visible. But the LIST
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window changed as well. Now the second program line has a frame.
And that line is the one with the PRINT "Hello". That is the
command which the program executed, as you could see in the BASIC
window.

Step lets you follow the program sequence line by line, as quickly or
as slowly as you like. Selecting step carries out the next command. If
you want to run the whole program a little faster press the right

<AmigaxT> key combination as mentioned above.

The frame moves to the third line (NEXT). The more often you press it,
the better you can observe the program sequence.

• Press right <Amiga><T> until the program ends.

You know the program ends when END is framed, and when you see 10

Helios in the BASIC window. Now use the command Step to see
how the FOR...NEXT loop works.

Select Step again.

The frame surrounds the first program line.

This line is the first command, as well as the first program step.

• Activate the BASIC window and enter:

The Amiga returns a value of 1. The variable x clearly contains 1 now.

So that you do not have to restart the program after this interruption, do
the following:

Click on the LIST window.

• Select Step again.

The Amiga goes on working from the point where it stopped before.
Select Step until the frame is around NEXT.

• Click in the BASIC window.

• Enter:

?xSI

The value returned for x is now 2. The program hasn't returned to the

first program line yet. So the addition to x must be in the middle two

lines.

The second line writes Hello on the screen. Otherwise there is

nothing there that makes the value for x increase. This leaves only the
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Program

structuring

third line. And this can't be right, since it only says NEXT. To confirm

this, do the following:

Click on the LIST window.

Select Step again until the frame returns to NEXT.

• Enter in the BASIC window:

You get the expected 3, before the third Hello appears on the screen.

The variable previously determined in the FOR instruction always

increases by one when the NEXT instruction occurs.

• In the active BASIC window enter:

x=10Sl

Reactivate the LIST window.

Select Step three times.

The computer accepts your input, which assigns the variable x a value

of 10 and stops further execution of the program. This is because the

maximum value determined in the first line has been exceeded. To sum

up, everything in a FOR...NEXT loop repeats and executes until the loop

surpasses the loop limit set In this case, PRINT "Hello" repeats ten

times, as the loop only ends at the value 10. The variable could also
have been y. Or a or b. Or even X. The Amiga considers X and x two

different variable names.

Click within the LIST window.

The BASIC cursor appears. The parts of the program belonging

together should be set apart for better readability. This can be done by

indenting lines.

• Move the BASIC cursor before the F in the first line. Press the

spacebar once.

The NEXT belongs with the FOR, so indent this line one space to the

right as well.

• Position the cursor in front of the N in NEXT. Press the spacebar

once.

Now move the statement PRINT "Hello" to the right past the FOR

and the NEXT.

Position the cursor in front of the P in PRINT. Press the spacebar

once.
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The END can stay where it is. Now when you look at the program, it is
certainly more readable. As long as you look at a short program like
our Hello program, you can of course review it quite easily. But the

longer and more complicated the program, the better program structures
can help you to quickly understand the connection between individual
program sections.

• Position the cursor in front of the P in PRINT.

• Press the <Return> key.

The Amiga automatically inserts the correct number of blanks between
the left edge and the PRINT.

• Move the cursor back to this blank line and enter:

? " I am the program" SI

If you indented this instruction two spaces, like the other PRINT
instruction, then you understand the principle of structured
programming.

• Start the program.

If you want, you can indent the Hello a little more in the third
program line, so that it fits in better with the I am the program.

Simply insert a few spaces between the opening quotation mark and the
Hello.
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3.4 Saving programs

It only takes a moment to lose an entire day's work. All it requires is

someone tripping over the power cord. There are thousands of other

dangers which can kill or ruin a program. Tired programmers, angry

mothers, little sisters, dogs, cats and electrical storms can all cut the

power on computers. For this reason you should get into a habit when

programming; save a& often as, possible.

The Amiga offers you simple and convenient options for saving

Save and programs. It also tries to ensure that you do not accidentally forget to

exit save your program. For example:

Select the Quit item from the Project pulldown menu.

A requester appears, asking whether or not you want the program in

memory saved before quitting.

• Click on the Yes gadget.

This tells the Amiga that you want to save the program. A new

requester appears. Since the program isn't saved yet, the string gadget

under the heading Save Program As : remains empty. If you had

saved the program before, this string gadget would list the same name

that you last assigned the program.

Click in the string gadget.

Type the name BasicDemos/Hello.

• Press the <Return> key or click on the OK gadget.

The program is saved in the drawer named BASlCDemos and can be

called from there, provided the Extras diskette is in the disk drive. When

saving ends, the Workbench screen reappears.

Open the BAS ICDemos drawer.

Double-click the Hello icon.

The program runs at once. As soon as it is finished, you have the

normal BASIC window in front of you.
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The menu items from the Project pulldown menu are as follows:

New This item deletes the program in memory so you can

begin work on a new program. The Amiga displays a

requester asking whether or not you want the program

currently in memory saved.

Open This item lets you call programs into memory without
running them.

Save Save can always be accessed if a program being saved has

been saved before. The Amiga stores the program

automatically under the same name. However, the Amiga

overwrites the old program.

Save As Save As lets you resave an edited program under a new

name. The original program remains undisturbed under the

old name and can be called back into memory if needed.

Quit A requester appears which tells you the program still in

memory has not been saved to diskette. If you left BASIC

in spite of this, then you would lose this data. So

AmigaBASIC gives you the option of either saving the

program before you continue, leaving BASIC without

quitting, or cancelling the Quit item.
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3.5 Four BASIC programs

All statements that you'll come across in the following listings can be

found in your Amiga's BASIC manual. Each program starts with a

description of the problem that the program is supposed to solve. This

way you understand exactly what the program is trying to achieve, and

you may also want to try to write your own program to solve the

problem and test your skill. This task is eased by the fact that all

statements required in the program to solve the problem are listed in

this description. Don't judge the success of your own program by how

closely it coincides with the book version, but rather by whether it

delivers the correct solution. If you don't want to solve the problem on

your own, simply go on to the program listing. Explanations follow

the listings to show the logic behind the program structure. Should you

encounter any statements that you aren't familiar with, look them up in

your BASIC manual. Sometimes the manual has sample programs to

clarify a statement's use.

The I symbol in the following programs signifies when the <Return>

key should be pressed. Program lines that must be typed in on one line

in AmigaBASIC may apper on two lines in this book. The SI symbol

will clarify when the <Return> key should be pressed.

117



3. AmigaBASIC Amiga for Beginners

3.6 Graphic program

Problem:

Solution:

The first problem involves the correct use of AREA and AREAFILL

statements. The three-dimensional image comes from the proper use of

the available colors.

Draw an image of a three-dimensional cube, using the Amiga's standard

colors only. The program requires the COLOR, AREA and areafill

statements.

Cube:91

COLOR 3,091

AREA (199,149)

AREA (399,49)

AREAFILL91

COLOR 2,091

AREA (199,49)

AREA (449,39)

AREAFILL9I

AREA (199,149)

AREA (199,139)'

AREAFILL91

COLOR 1,05

AREA (399,49)

AREA (449,139)

AREAFILL9I

: AREA (399,149)91

AREA (199, 49) SI

AREA (399, 49) SI

AREA (249,39)91

: AREA (149,149)91

AREA (449,39)91

: AREA (399,149)91

This version of the program draws the cube in the approximate center of

the screen using the AREA statement. COLOR 3, 0 sets the drawing

color to orange (3) and the background color to blue (0), providing that

the Workbench default color settings are used.

Four AREA statements set the four comers of the front side of the cube.

The following AREAFILL statement then draws this front side onto the
screen.

The COLOR 2, 0 statement sets the drawing color to black (2) while

the background color remains blue. The Amiga draws the top of the

cube next. Again, the four corner points are placed to make the cube

look three-dimensional. The second area drawn here is the shadow on

the left side of the cube. This requires a three-sided area only, since part

of the shadow is hidden behind the cube.

In the last section the COLOR 1, 0 statement returns the colors to their

standard setting (white on a blue background). This portion stands at the

end of the program so that the text output after the program appears in
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the standard color settings after the program runs. With four vertices the

program defines the white side panel of the cube. Thus, the imaginary
light source stands to the very right of the cube. Again, the four corners

are offset, creating the illusion of perspective. Feel free to experiment

further with these statements before you go on to the next problem.
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3.7 Animation program

The advantage of this program is that you just wrote half of it (the

cube). Now you just have to add the new section to the end of the

existing program. The most difficult thing to understand in this

program is the calling and reading of the bobs (movable objects). The

statements used to actually move the bob are quite simple, since they

are variations of the OBJECT. statement. You just have to take the

time to learn the individual versions of the OBJECT. statement family.

You'll have already taken the first step toward writing the solution to

out next problem.

Expand the above cube program to work with a bob called ball. Read

Problem: this ball in three times, so that three balls jump out of the inside of the
cube. In addition to the statements required to form the cube, use the

following statements in this program: OPEN.. .FOR INPUT AS;

OBJECT . SHAPE; CLOSE; OBJECT. X; OBJECT . Y; OBJECT . HIT;

OBJECT .AY; OBJECT .AX; OBJECT . ON; OBJECT . START.

Cube:5

COLOR 3,05

AREA (199,149) : AREA (399,149)1

AREA (399,49) : AREA (199,49) SI

AREAFILL5

COLOR 2,05

AREA (199,49) : AREA (399,49)5

AREA (449,39) : AREA (249,39)5

AREAFILL5

AREA (199,149) : AREA (149,149)5

AREA (199,139)5

AREAFILL5

COLOR 1,05

AREA (399,49) : AREA (449,39)5

AREA (449,139) : AREA (399,149)5

AREAFILL5

Balls:5

OPEN "Extras:BASICdemos/ball" FOR INPUT AS

.15

Ball$=INPUT$(LOF(l),1)5

FOR x=l TO 35

OBJECT.SHAPE x,Ball$5

NEXT x5

CLOSE 15

FOR x=l TO 35

OBJECT.X x,2995
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OBJECT.Y x,41I

OBJECT.HIT x,0,0S[

OBJECT.AY x,-21

NEXT xl

SI

OBJECT.AX 1,-21

OBJECT.AX 3,25

FOR x=l TO 3J

OBJECT.ON xl

OBJECT.START xl

NEXT xl

SI

FOR x=l TO 1400

FOR x=l TO 3

NEXT xl

OBJECT.AY x,2 : NEXT xl

FOR x=l TO 7000 : NEXT xl

The program section Balls : contains all the new program code. First

Solution: the program reads the ball from the BASICDemos drawer located on
the Extras diskette. If you change the Extras diskette icon's name,

you must also change the name in this program from Extras to the

new name as well.

The program opens the bob file ball FOR INPUT so that it can be

read into memory as data file number 1. This file's contents go into the

variable Ball$:. INPUT$ (LOF (1), 1) handles the INPUT$ of the

file number one. The following FOR...NEXT loop assigns the contents

of Ball$ to OBJECTS one through three, using OBJECT.SHAPE.

The file closes.

The next section's FOR...NEXT loop counts from one to three. Here the

following values are assigned to the three objects:

1) their X-position (OBJECT .X x, 2 9 9) 299 for all three objects

2) their Y-position (OBJECT. Y x, 41) 41 for all three objects

3) OBJECT.HIT x, 0, 0 ensures that no collision interrupts occur

when the balls collide with each other.

4) their acceleration. Each of the three bobs receives a vertical

acceleration of -2 with the OBJECT.AY statement. This means that

each ball starts to move toward the top of the screen, moving an

additional two pixels faster each second.

The third program block assigns the first and third bobs horizontal

movement. Bob number one moves up and to the left, 2 pixels faster

per second (-2). Bob number three moves to the right at the same rate

(+2). Bob number two moves from bottom to top, without horizontal

movement.
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Another FOR...NEXT loop from 1 to 3 occurs. The three bobs turn on

simultaneously and become visible (OBJECT.ON), while

OBJECT.START starts the bob movement.

Next is a wait loop: FOR x=l TO 140 0 : NEXT x. This loop gives

the bobs enough time to get out from behind the upper screen border.

Once the first delay loop ends, the vertical (Y-) movements of the bobs

"reverse." They are all set to positive (+2). The result: The original

movement goes the opposite direction. The balls run slower, until the

direction of flight changes again.

Another delay loop appears: FOR x=l TO 7 0 0 0 : NEXT x.
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3.8 Speech program

The speech programming of the Amiga is built on one statement which

must be given with several numerical parameters. Because of this, the

most important thing is discovering exactly which numerical values

deliver a nearly human voice. Once youVe mastered that, you'll mostly

be dealing with having your Amiga speak.

Write a program to simulate a conversation between an Amiga and an

Problem: another 68000-based computer. Make the other machine speak slower
and in a monotone. The necessary statements for this program: DATA;

READ; SAY; TRANSLATE $.

Preparations: SI

FOR x=0 TO 8SI

READ Amiga%(x)SI

NEXT xSl

FOR x=0 TO 8SI

READ Other%(x)SI

NEXT xSI

SI

DialogrSI

FOR x=l TO 5SI

READ Amigatext$ (x) SI

READ Othertext$ (x) SI

SAY TRANSLATE$ (Amigatext$) , Amiga%SI

SAY TRANSLATE$ (Othertext$) , Other%SI

NEXT xSI

SI

Vocaldata:SI

SI

REM Amiga voiceSl

DATA 120, 0, 173, 0, 22338, 64, 8, 0, OSl

REM "other" voiceSl

DATA 232, 1, 84, 0, 17301, 64, 9, 0, 0SI

SI

REM Text:SI

DATA "Hello, I'm your Amiga. "SI

DATA "Hello, I am one of the other sixty

eight thousand based computers. I can speak

too. "SI

DATA "That's interesting. How do you

feel?"SI

DATA "Speaking is very difficult. "SI

DATA "Well, I don't think so. Besides, it's

very helpful to the user."SI
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DATA "Wait a moment/ I seem to be having

memory trouble."51

DATA "You are? Multitasking speech

synthesis is no problem for me."91

DATA "I don't know the word multitasking.

Please explain."SI

DATA "But what can your user do with you if

you don't do multitasking?"^

DATA "Excuse me, I feel some cherry bombs

coming on."

The most important commands are the different voice values for the two

Solution: computers.

Preparations : reads the voice values for the Amiga and other

voices. The values of these voices may take some experimentation (see

AmigaBASIC Inside and Out, Chapter 6).

The array called Amiga % contains the Amiga voice parameters. The %

extension means that this array contains only integer values. The SAY

command requires integer parameters.

READ and DATA read in the values; the Amiga values appear in the

listing under REM Voice of Amiga.

The array called Other% contains the other computer's voice

parameters. The other computer values appear in the listing under REM

Voice of "other" computer.

The main section of the program carries the name Dialog:.

The FOR...NEXT loop gives the number of exchanges between the

Amiga and the other computer. FOR x=l to 5 means 5 statements

from the Amiga, and 5 from the other computer.

READ reads in the AmigaText $, then Othertext$.

TRANSLATES translates the text into phonemes. The array names after

the comma give the voice array. SAY says the text. The program

accesses the Workbench file translator.library before saying

anything; be sure your Workbench diskette is accessible.
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3.9 Sound program

This program is a bit more difficult than the others so far. This is

because of the mathematical problems surrounding waveforms, as well

as the use of a new programming technique—event trapping. Reading

pulldown menus and the mouse are among the Amiga's best features,

but not the easiest to program.

Write a program which produces sine waves, square waves and white

Problem: noise. The notes must be accessible through a mouse in a sort of scale.
Mouse buttons must be pressed, and the mouse must be movable from

top to bottom. The three waveforms should be accessible from

pulldown menus.

Preparations:SI

DIM Square%<255), Noise% (255) SI

SI

MENU 1,0,1, "Program"SI

MENU l,l,l,"->End<-"SI

MENU 2, 0,1, "Waveform"SI

MENU 2,1,2," Sine"SI

MENU 2,2,1," Square"SI

MENU 2,3,1," Noise"SI

MENU 3, 0,0, ""SI

MENU 4, 0,0, ""SI

SI

FOR x=0 TO 255SI

IF x<128 THEN Square%(x)=127 ELSE

Square% (x) =-128SI

Noise% (x) =RND*255-128SI

IF INT(x/4)=x/4 AND x<190 THEN LINE

(200,x)-(400,x)SI

NEXT xSI

WAVE 0,SIN : Wform=lSI

ON MENU GOSUB MenucontrolSI

ON MOUSE GOSUB MousecontrolSI

MOUSE ONSI

MENU ONSI

SI

Mainprogram: SI

GOTO MainprogramSI

SI

MenucontrolrSI

Men=MENU(0)SI

Item (MENU (1) SI

IF Men=l AND Item=l THEN CLS: ENDSI
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If Men=2 THEN?

MENU 2,Wform,If

Wform=Item9I

MENU 2,Wform,2SI

IF Item=l THENSI

WAVE 0,SIN!

ELSEIF Item=2 THENSI

WAVE O,Square%Sl

ELSEIF Item=3 THEN9I

WAVE 0,Noise%5

END IFI

END IFJ

RETURNS

91

Mousecontrol:I

Mousevalue=MOUSE(0)I

WHILE Mousevalue(0)S[

Mousevalue=MOUSE (0) SI

Sound 1200-(4.85*MOUSE(2)),H

FOR d=l TO 90 : NEXT dl

WENDSI

RETURNSI

The Preparations : section sets up two arrays, Square% and

Solution: Noise%. These wave data arrays must have at least 255 elements.

The MENU statements define the menu bar and the two titles:

Program (menu 1) and Waveform (menu 2). The second

parameter in the MENU statement (0=menu name, l-3=menu entry) and

the third position can be either a 0,1 or 2.

0 produces a ghost item; 1 produces a normal menu item; and 2 marks

the menu item with a checkmark.

The next FOR...NEXT loop fulfills a number of parameters at once: It

computes the contents of the waveform data arrays. The first 127 array

elements of Square* receive the value 127, and the remaining

elements receive -128. The wave amplitudes can be between 127 and -

128 for a pulse wave.

Noise% fills with random numbers for the white noise waveform.

The program draws horizontal lines on the screen, four pixels apart, to

help with selecting notes and mouse movement

The condition IF INT (x/ 4) =x/ 4 THEN... applies to any multiple of

4.

The third possible waveform (sine) appears automatically from

AmigaBASIC from the WAVE 0, SIN statement. Sine waves aren't

automatically created. The variable Wform states which of the three
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waveforms is active. This checkmark display in the pulldown menu

shows the active waveform.

The program works with event trapping. Menu events operate through

the program section MenuControl:, while MouseControl:

handles mouse events.

MainProgram: consists of an endless loop.

The user calls MenuControl: when he selects a menu item. The

variable Men contains the menu number, according to the BASIC

function MENU (0). This can be 1 when the selected item is in the

Program menu, or 2 when found in the Waveform menu.

The variable Item gives the number of selectable options within the

specified menu.

If Men=l and ltem=l, the user selected the first item in the first

menu, ending the program. The screen clears with CLS and the program

stops at END.

The next block is a typical set of nested IF...THEN constructs. If the

second menu is selected (IF Men=2 THEN...), the checkmark must be

reset in the second menu. The first three program lines in the large

IF...THEN-ENDIF structure means that the variable Wform contains

the last active waveform option (this is set to 1 when the program

starts). The third value in the MENU statement sets this menu item

from 2 to 1. Then Wform becomes the selected menu item. This

option is marked by a checkmark through MENU 2, Wform, 2 (the 2 in

the third place is additional).

Then the program checks the selected item and sets it with WAVE 0 and

the waveform for voice 0. The ELSEIF command means: When the

last condition is unfulfilled, look for another condition.

TWO ENDIFS Close the IF...THEN...ENDIF loop.

RETURN closes the subroutine.

The Mousecontrol: variable Mousevalue reads MOUSE (0).

This BASIC function checks the current status of the mouse buttons.

The following executes through WHILE...WEND: As long as

Mousevalue is less than 0, a negative number occurs (this means

that the mouse button is pressed at the time), and a tone sounds with

SOUND. The variable Mousevalue must also be read within the

WHILE...WEND loop, since this recognizes whether the mouse buttons

change or not.
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The frequency used by the SOUND command comes from the vertical

mouse position (MOUSE (2)). The formula gives values between 130

and 1200, which roughly matches the first four octaves of the Amiga's

musical range. Sound duration is 1 (approximately 1/18 second), and

the AmigaBASIC volume and channel parameters are used

(volume=127, channels [both left channels]).

The delay loop FOR d=l to 90: NEXT supplies the sound duration in

increments of 1/18 second. If the user holds the left mouse button down

for 1/60 of a second, the note plays for 1/18 second. If the user holds

the left mouse button down for 1.001 seconds, the note plays for 1 and

1/18 seconds.

P
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3.10 Lotto program

Lotto programs are very popular in computer books for beginners.

There's a good reason for this: A lottery program generates random

numbers, numbers which appear at random. The last few sections have

covered AmigaBASIC graphics and sound. This Lotto program does

something simpler—six random numbers appear on the screen.

Preparations:SI

RANDOMIZE TIMERSI

DIM digits (49) SI

FOR x=l TO 49SI

digits (x)=0SI

NEXT xj

SI

Arraydesign:SI

FOR x=l TO 7SI

FOR y=l TO 7SI

LOCATE (3*y), 16+6*xSt

PRINT x+7*(y-l)SI
LINE (159+48*(x-1),8+24*(y-1))-

(159+48*x, 8+24*y), l,bSI

NEXT ySI

NEXT xSI

SI

Drawing: SI

X=INT(7*RND)+1SI

y=INT(7*RND)+lSI

Occ=0 : colour=3 : IF Right=6 THEN

colour=2SI

IF digits (x+7*(y-1))=0 THENSI

PAINT (160+48*(x-1),9+24*(y-

1)), colour, 1SI

SOUND (x+7*(y-l))*8+440,1SI

FOR delay=l TO 50 : NEXT delaySI

PAINT (160+48* (x-1), 9+24* (y-1)) , 0,1SI

Occ=lSI

END IFSI

IF Occ=l AND w>10 THENSI

PAINT (160+48*(x-1),9+24*(y-

1) ), colour, 1SI

digits (x+7* (y-1) )=1SI

IF Right=6 THEN digits (x+7* (y-1) ) =2SI

Right=Right+l : w=0 : Status=x+7* (y-1) SI

SOUND (x+7*(y-l))*8+440,8SI
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FOR delay=l TO 4000 : NEXT delaySI

END IFSI

SI

IF Right <7 then DrawingSI

SI

Ending: SI

LOCATE 1,1 : COLOR 3,0SI

PRINT "The winning"SI

PRINT "number of the week:"SI

COLOR 1,0 : PRINTS!

FOR x=l TO 49SI

IF digits (x)=l THEN PRINT xSI

NEXT xSI

PRINTSI

PRINT "Extra number:";SI

PRINT StatusSI

PRINT : COLOR 3,0SI

PRINT "GOOD LUCK!": COLOR 1,01
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4. AmigaDOS

DOS

Throughout this book you have been accessing disks again and again.

You learned how to load and save Notepad texts and BASIC

programs. This chapter discusses diskettes and the general commands

and programs used in communicating with diskettes.

It is not essential that you understand this chapter completely. If you

want to program in AmigaBASIC, or plan to access commercial

software only, then you don't need this chapter. However, you may

want to learn a few of the basic principles of diskette access. This helps

you become more familiar with the computer and its processes.

The controlling program used in diskette access is the disk operating

system, or DOS for short. Like the operating system in a computer, the

DOS controls general housekeeping tasks for diskettes. AmigaDOS is

the Amiga's disk operating system. You can operate AmigaDOS

through the Command Line Interface (CLI) first mentioned in Chapter

2.

This chapter describes how to access the CLI, and how to send

commands to AmigaDOS. Also, there are descriptions of the

AmigaDOS commands you'll use most often for disk access.
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4.1 CLI

The CLI is another user interface, similar to the Workbench. The major

difference between the Workbench and the CLI is that the CLI offers

more complex dialogue between the user and the Amiga. That is, you

have no mouse in the CLI, only the keyboard. When you want the

Amiga to do something, type in the command and press the <Return>

key.

This section discusses the most important AmigaDOS commands only.

If you wish to become better acquainted with AmigaDOS, see the

AmigaDOS manual from Commodore Amiga. Once you see some of

the possibilities offered by AmigaDOS as shown in the following

pages, you may want to learn more about DOS.

• Start your Amiga, if it isn't already on.

Double-click the Workbench diskette icon.

Open (double-click) the System drawer in the Workbench

window.

A number of diskette icons appear. If an icon named CLI appears in the

System window, skip to the section on the next page Opening the

CLI.

If the CLI icon isn't in the System window then the CLI is

inaccessible from Intuition. You make it visible through

Preferences. This was done by the developers for the Amiga's

protection as well as the user's protection. If the CLI icon isn't in the

System window, do the following:

• Click the close gadget in the System window.

• Double-click the Preferences icon in the Workbench

window.

• Click the On gadget next to the word CLI.

• Click on the Save gadget

Open the System drawer in the Workbench window.

The CLI icon should now be in the System window.

There are two ways to access the CLI: From the Workbench

window, and as the Workbench loads.
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Start up your Amiga according to the instructions in Section 1.4.

When the blue screen first appears during the booting process,

press and hold the <Ctrl> key and press <d>.

**BREAK - CLI appears along with the CLI prompt 1>.

Open the CLI from the Workbench window by double-clicking on

Opening the its icon, just as you opened the Notepad or AmigaBASIC.

CLI

• Double-click on the CLI icon.

The disk drive runs, and a new window named New CLI appears. This

New CLI window has most of the gadgets that other windows have:

Sizing gadget, drag bar, front gadget and back gadget (note that the

New CLI window has no close gadget).

• Drag the New CLI window's sizing gadget down and right. Make

the window as large as you can.

One of the most important differences between the AmigaBASIC
windows and the CLI window is a 1> character and the cursor. The >

character appears whenever the CLI is awaiting input. The 1 preceding

the > indicates that this is the first CLI window. The BASIC cursor is
just a narrow line, but the CLI cursor is a small block. It's possible to

open several CLI windows at the same time.

Enter the following into the New CLI window:

newcliSI

Another window opens, also named New CLI. In addition, New

NEWCLI CLI TASK 2 appears in this new window. This text scrolls off the
top of the screen once the window fills with commands or data. The
CLI offers multiple windows because the Amiga is multitasking (can

perform several tasks simultaneously). Therefore, if you have two disk
drives, you can display the directory (diskette contents) of the internal
drive in one CLI window, and the external drive's directory in another

CLI window.

The 1 or 2 preceding the > character indicates the CLI window currently

in use. For this section, however, one CLI window is all you'll need.

• Enter the following into the New CLI 2> window:

endcliSI

This command closes the New CLI window currently in use. You can

ENDCLI type AmigaDOS commands in uppercase or lowercase letters, or even a
mixture of the two. Filenames can also be entered in uppercase and

lowercase.
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Enter the following into the New CLI window:

dirSI

DIR is the abbreviation for DIRectory. In computing, a directory is the

DIR list of a diskette's contents. Since the disk drive contains a copy of the

Workbench diskette, the display should appear as follows:

Trashcan (dir)

c (dir)

Demos (dir)

System (dir)

1 (dir)

devs (dir)

s (dir)

t (dir)

fonts (dir)

libs (dir)

empty (dir)

utilities (dir)

The word .info appears immediately after some of these names, then

other filenames appear, from Clock to Trashcan. You should

recognize some of the lists of names. For example, Demos was the

name of a drawer in the Workbench window. You can easily open

this drawer and read the files inside it from the CLI.

• Enter:

dir demos SI

By requesting the directory of the Demos drawer, you call a

subdirectory, a directory of a directory. The Amiga displays the names

of the demo programs in two columns: Once under the names under

which they were saved, and once followed by a suffix . info.

If you can see the demo program names, perhaps they can be started
from here.

• Enter:

linesSI

m The CLI displays the message Unknown command lines. You can

Running ^^ programs from the CLI, but you must specify the program and the
programs subdirectory or subdirectories. You read in Chapter 3 that a slash (/)

from the specifies the subdirectory in addition to the filename when saving a
CLI BASIC program (SAVE drawer/program_name). This is the same

with the CLI. You must specify the program name and the drawer
containing that program.
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• Enter:

demos/linesSl

The program executes. Up to now, the only difference from opening

programs from the Workbench is that you must type in the filename

from the keyboard. The CLI has no icons. The advantage of CLI

commands lies in letting you view any file, directory or subdirectory.

The CLI quits as Lines executes. You can enter commands, but the

CLI ignores them. This is because any program started from the CLI

occupies the CLI during program execution. To avoid this, you can

open another window beforehand, or enter a special command to make

your Amiga do the extra work:

• Click on the Lines window's close gadget.

• Enter:

run demos /1ines SI

The Amiga starts another task (CLI 2) and runs Lines in that

window'. Your original CLI remains active as Lines runs.

The biggest advantage of using CLI is having access to information

that you can't view from the Workbench.

The directory fonts, which appeared after the dir command above,
wasn't in the Workbench window. However, you used fonts

when you worked with the Notepad, so it's on the Workbench

diskette.

• Enter:

dir fontsSI

The font names you know from the Notepad appear. These fonts are

in different sizes on the Notepad, though, like Sapphire 14 and

Sapphire 19.

• Enter:

dir fonts/sapphiref

The CLI displays the numbers 14,19 on the screen underneath this

command. These are the same sizes you found in the Sapphire item

of the Notepad■ s Fonts pulldown menu.
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4.2 Amiga diskettes

Each Amiga diskette can be viewed as a filing cabinet. The cabinet

contains drawers, the drawers contain files and the files contain data.

Diskette operations often take place with several diskettes, not just one.
The Amiga tries managing these as quickly and as carefully as possible.

To permit this with a large amount of data, a hierarchy exists in

AmigaDOS, i.e., a certain order for stacking programs or information

on diskette.

For example, say a program wants to find out what the font

Sapphire 19 looks like. The process is as follows:

The Amiga receives the message that the Sapphire 19 font is

required. AmigaDOS then searches for a drawer labeled fonts. If there

is no such drawer, then the Amiga has the wrong diskette and tells the

user with a requester.

AmigaDOS finds and opens the fonts drawer. Inside are several files.

The Amiga then searches until it finds the drawer named Sapphire.

The Amiga opens the Sapphire drawer and searches for the file

named 19. Once found, the Amiga gives the program the desired

information and closes the file. The Amiga turns to other tasks again

until it receives a new inquiry.

This is just what you did. You read the names of available drawers.

Then you opened the fonts drawer to see what was inside. You

selected the Sapphire font file, and read the names of the two

Sapphire font sizes.

Perhaps Sapphire has no more sizes, and opening the file reveals all

that it contains. But how do you find out whether more data exists in

the Sapphire file?

Look at the words . info and (dir) next to some of the names in a

Suffixes directory. These are suffixes. These suffixes help the Amiga determine
the function of a specific file. All files with the suffix . info contain

data corresponding to the filename preceding the suffix. Thus the file

dots. info provide the Amiga with all the data required to display the

Dots icon and write the name Dots in the Demos window. It is rarely

necessary to specify a suffix when calling a given file from the CLI.

However, files with suffixes can also be read. For example, consider the

suffix (dir). All names with this suffix are subdirectories, not

programs.

Enter:
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dirf

The Amiga displays a list of all the directories. Take another look at the

Demos directory.

• Enter:

dir demosSI

The Amiga displays .info followed by the four program names,

info Those names followed by the . info suffix are viewable from the
Workbench. Any names not followed by . info will not be seen on

the Workbench. Take a look at the Fonts directory.

• Enter:

dir fontsSl

The font names appear. Each name has a (dir) following it. This
means that each font has additional files enclosed. Remember how to

access this from accessing the lines demo?

• Enter:

dir fonts/diamonds

This gives you the subdirectory of the diamond font directory. There

are no other subdirectories, nor are there font sizes other than 12 and 20.
You'll note that these fonts have no . info files. Without an . info

file, a file remains invisible to the Workbench.

It obviously takes time to input all these commands for directories,
subdirectories and sub-subdirectories. Also, when a second disk drive or
the RAM disk is marked for access you must supply the drive specifier.

For example, to read the second disk drive's directory from the CLI,

you enter:

dirdfl:

For aRAM disk, the directory access is as follows:

dir ram:

The CD command saves a lot of this typing. CD allows you to change

CD the second drive to the default drive, or a specific directory to the default
directory. Normally when you enter dir, the Amiga displays a main
directory. CD changes the specified directory into the default directory.

• Enter:

cd demos 91
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The disk drive runs briefly.

• Enter:

The Amiga displays the subdirectory demos instead of the main
directory. Now you can start a program directly.

• Enter.

linesSI

The program promptly starts without your specifying demos first.

However, if you now want to start a program located in the main

directory, the Amiga won't be able to find it This is because the CLI
is still in the demos directory.

• Click on the Lines window's close gadget.

• Enter:

run preferences?

The Amiga opens another CLI in which to run Preferences, but

then breaks off and displays the Unknown command preferences

error message. The Amiga can't find the program because it's not

located in the current directory. When the Amiga can't find a file, it

looks in the list of DOS commands stored on the diskette (more on this

later). If the command doesn't exist, the Amiga responds with an error

message. So remember: When a program won't start, even though

you're certain that it's on the diskette, it's always possible that

something could have been switched around with the CD command.

What if you're not certain that it's on the diskette? Well, here's a way to

see everything on a diskette. You must be in the main directory to view

the entire diskette. Before you continue, you need two more CD

options.

• Enter:

cdSI

As soon as you press the <Return> key, the message Workbench

1.2: Demos appears. Depending upon how far into the directory you

are, more and more of these messages appear. For instance, if you're in

the Sapphire directory of the Fonts directory on the Workbench 1.2

diskette, the message following the CD command reads:

Workbench 1.2 : Fonts/Sapphire
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CD /

CD:

LIST

This CD command variation returns you to the next directory up (you

must put a space between the CD and the slash):

cd /

The CD: command takes you directly to the main directory (again,

include a space between the CD and the colon).

If you're in the main directory, the command below displays the entire

contents of the disk directory.

• Enter:

cd:I

• Enter:

dir opt a SI

Each directory name appears, followed by its files and subdirectories.
You can stop the names from scrolling off the top of the screen by
pressing the spacebar, and continue the scrolling by pressing the
<Return> key. Continue in this way until you have reached the font

you want.

You may be wondering why you don't see all these filenames as icons
in the Workbench window. Consider what would happen if
everything was displayed. Youll never use all of these options. Most of
them supply information to programs, so they don't require icons. The
only data made visible is that required by the user. Anything else only
leads to confusion, which is why most of these names stay unseen by

Intuition.

LIST is a very comprehensive command with many options. We'll
show you the three most important parameters.

• Enter:

list?

LIST alone results in a sorted list of names and characters. If the top
line is about to scroll off the top of the screen, press the spacebar to
pause the listing. Pressing the <Return> key continues the listing. The

title appears in the format:

Directory of ' : ' on Tuesday 2 6-Nov-87

The date, of course, depends on the system clock, set in
Preferences. Everything else should be exactly the same. A

number of names and characters follow. Here are two sample LIST

entries:

141



4. AmigaDOS

Preferences

Fonts

58152

Dir

rwed

rwed

Amk

14-Apr-87

14-Apr-87

5AFC

10

10

►r Begin

:37:46

:37:46

The first item is the name of the program or file. The number
following the filename indicates the file's length in bytes. For example,
Preferences, with 58512 bytes, is one of the longest programs on
the Workbench diskette.

Note that Fonts has no numbers, just the word Dir. Directories have

no lengths. They exist to keep files in order. You can always tell at a
glance whether an entry is a program or a directory. The entry "empty"
may also replace the byte size or the Dir entry. This means that a
program contains no data.

The next item specifies the program's file status (rwed=Read/ Write/
Execute/ Deleteable). This item shows whether the file can be read (r),

whether the user can write to it (w), whether the file can be run or
executed (e), and whether the file can be deleted (d).

All these options can be specified in the Info window, accessible
from the Workbench screen.

The date and time display refer to when the file was created or changed.

LIST DATE A listed day refers to the most recent day. That is, Thursday refers to
last Thursday. AmigaDOS always calculates and displays the dates up

to one week before. The number of files or programs processed in the

last week determine the number of files labeled with a specific day, e.g.

Thursday. If you prefer the exact date, LIST provides other parameters.

• Enter:

list datesfl

This displays all the files with their dates, and the actual day if the file

was created in the last week. Thus, the date of saving a particular

version or file is easily found.

To simplify finding out "What I did when" you can specify dates to the

Amiga from and/or up until you wish to see all the files.

• Enter:

list since 01-jan-87f

This displays just the files created or edited from January 1, 1987 on.

LIST The number of program names appearing depends on how much or how

SINCE little has been stored on the Workbench since the 1st of January 1987.

The actual dates on which these program names were written don't
appear.
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LIST

TO

• Enter:

list since thursdayfl

The Amiga automatically displays everything stored since the previous
Thursday. If nothing has been stored since Thursday, then the 1>

prompt reappears.

There is also a special option for finding out everything stored before a

UP given date.

• Enter:

list up to 24-apr-87SI

Now the Amiga displays everything entered on the diskette until this
date. Thus, LIST offers a wide range of facilities for scanning through
files according to given criteria. This option is available only in the
CLI window. There is no facility in the Workbench for ascertaining the

date or time of the data stored.

One more point about using UPTO and SINCE. You must enter single-
digit dates (e.g., 1 January) as two digits (e.g., 1 becomes 01).
Otherwise, the Amiga ignores the UPTO or SINCE command.

If you have memory expansion for your Amiga 500, you also own a
NOTE: battery operated clock. This clock is not set in the factory, so if no one

else has already set if for you, it's probably wrong. This wouldn't be so
bad if the Preferences clock didn't set itself after the battery

powered clock.

Do the following:

• Run Preferences from the CLI as explained above.

• Set the Preferences clock to the correct time.

• Click on the Save gadget

• Enter the CLI command:

setclock opt saveSt

• If you receive the error message UNKNOWN COMMAND, enter the

CLI command settime-i instead.

The RENAME command is another important CLI command. This has a

RENAME twofold purpose. First, it renames files. You can change one font to

another name.

• Enter:
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cd fonts?

rename ruby.font to luby.fontSI

The disk drive runs and renames the font.

• Enter:

dirfl

The font name Ruby is now Luby.

• Enter:

rename luby to rubySI

cd :I

The closing cd: changes the original directory to the default directory.

RENAME has a second function.

• Enter:

dir demosSI

rename demos/boxes to trashcan/boxesSI

rename demos/boxes.info to

trashcan/boxes.infof

dir demosSI

The Boxes demo moves from the Demos directory.

• Enter:

dir trashcanSI

RENAME can be used for renaming programs and files, as well as

transferring them from one directory to another.

• Reduce the CLI window as far as possible with its sizing gadget.

• Double-click the Demos drawer from the Workbench window.

• Double-click the Trashcan icon.

As you can see, the Boxes demo program went from the Demos

drawer to the Trashcan icon. You can put everything back again

without re-entering the CLI.

• Using the mouse pointer, drag the Boxes icon from the

Trashcan window back to the Demos window.
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Now you are familiar with a few of the AmigaDOS commands, and you
have some insight into the number of programs operating in the

background handling windows, pointers and menus.
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4.3 CLI tricks and tips

Printer

drivers

NOTE:

The CLI allows you to do some things that are impossible through the

Workbench alone. For one, larger and more complex programs can be
copied only through the CLI.

One of these programs is the printer driver. The Extras diskette contains
several additional printer drivers. If you need one of these programs,

there are instructions below for copying it to your Workbench.

Second, the CLI can help single drive owners get around some tight

situations when dealing with the CLI. These problems arise because

the Amiga must access all CLI commands from diskette as needed. You

can solve the diskette switching problem using a short DOS program

called a batchfile (more on this in a moment).

Third, when you work with BASIC, single drive system owners would

find it much more convenient to have a bootable BASIC diskette. A

bootable BASIC diskette contains a copy of the Workbench, along with

the program material you need.

If you find the material below useful, or you find that you enjoy

working with the CLI more than anything else so far, you can find

more extensive information in the Abacus book Amiga Tricks and
Tips.

If you tried selecting a printer driver from the Change Printer

screen of Preferences and didn't find your printer, look on the

Extras diskette. There are more printer drivers on that diskette.

If you find your printer listed there, here's how to copy your particular

printer driver to the Workbench.

There are some rules you should follow when performing the procedure

listed below:

Please perform the following operation with backup copies

ONLY of the Workbench and Extras diskettes, since you'll be

erasing files you might need at a later time. Delete from and

copy onto your backups only!

This operation requires a great deal of memory. If you own a

2S6K Amiga 1000 in particular, be sure that no extra windows

are open and that absolutely no programs are running in the

background.
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NOTE:

Make sure you know the exact name of your Extras diskette.

Better yet, RENAME and label the Extras diskette Extrasd, if it

doesn't already have that name.

Most printers work under the Epson driver. If your printer doesn't

appear in the Extras diskette printer driver list, try the Epson driver.

Insert the Workbench diskette in the disk drive.

• Close all windows and make sure no extra programs are running.

• Double-click on the Workbench diskette icon.

• Double-click on the System drawer icon.

• Double-click on the CLI icon.

• Enter the following:

cd devs/printers SI

dirfl

A group of printer names appears. They are the same ones found in
Preferences. Using the CLI delete command, deletes all the

printer drivers you won't be needing.

For example, Enter:

delete OKIDATA_292

This deletes the Okidata 292 printer driver from this file.

• Delete as many printer drivers as you can, except the one you need.

The following command must use the name of your Extras diskette. If
you have a different name from Extrasd, use that name. The best bet is

to rename your Extras diskette to Extrasd to avoid confusion.

• Enter the following:

cdextrasdrdevs/printers

Remember the colon following extrasd. The Amiga requests the

Extras diskette.

• Insert the Extras diskette and enter

copy #? to ram:

• When the Amiga asks, insert the Workbench diskette.
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WARNING:

Batch files

Again, remember the colon following ram. The keys #? make up a

wildcard. This particular wildcard tells the operating system to copy

every directory entry from the Extras diskette to the RAM disk.

Insert the Extras diskette when the appropriate requester appears.

As the Amiga copies the printer driver to the RAM disk the filename is

displayed in the window.

When the Amiga is ready, remove the Extras diskette and insert the
Workbench diskette.

Now copy the printer driver from the RAM disk to your Workbench

diskette.

• Enter:

copy ram: (printername) to dfO :devs/printersSI

Insert your printer name for the above parameter

(printername).

• When the process finishes, enter:

dir df0 :devs/printers SI

You'll see your printer driver in the disk directory of the Amiga's

internal drive.

• Delete the RAM disk by entering:

delete ram:#?SI

Make absolutely sure that the above command reads exactly as it

appears above BEFORE you press the <Return> key. Otherwise, the

wildcard instructs the Amiga to delete all the entries in the directory

most recently accessed (the diskette in drive df 0:).

Install your printer driver according to the instructions for setting

Preferences in Section 2.10.

There are some problems that single disk drive users have when using

the CLI. Every time you input a DOS command, the Amiga requests

the Workbench diskette. This is because AmigaDOS gets all its

commands from that diskette. The result can be having to switch around

two or more diskettes at a time. You can avoid some inconvenience by

copying the DOS commands to the RAM disk.

Instead of copying these commands over by hand, you can tell the

Amiga to copy them over using just one command. A series of

commands executed using just one command is called a batchfile.
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AmigaDOS has an editor named Ed, accessible from the CLI. Ed is

harder to use than the AmigaBASIC editor, but it works.

There's an easier way to write batch files: using the Notepad from the

CLI.

• Open the CLI, if you haven't already done so.

Enter:

cd utilitiesSl

notepads!

Once the Notepad finishes loading, enter the following:

if exists ram:c$

echo "Deleting the DOS commands from the RAM

disk. "SI

assign c: sysicSl

delete ram:c all11

elsell

echo "Copying DOS commands to the RAM disk. "11

makedir ramrcll

copy sys:c to ramie allil

assign c: ram:c1l

echo "The DOS commands are now in the RAM disk."11

endifU

When you've typed in all these commands, select the Save item

from the Project pulldown menu.

• Click on the Save requester's string gadget, enter the name

df 0 : s/ctoram and press the <Return> key.

Select the Quit item from the Project pulldown menu.

This batch file relocates all the AmigaDOS commands to drive c:, or

the RAM disk. This frees up your internal disk drive for other tasks,

instead of accessing the CLI through the Workbench diskette. Also,

this RAM disk DOS set is only temporary; you can install and remove

it as needed.

Enter the following next to the CLI prompt:

execute ctoramSI

The Amiga requires about 200K of memory for storing the DOS

commands. You should only use this batch file when copying diskettes,

or for other CLI tasks. This batch file is written in such a way that

when you execute it a second time, it deletes the DOS set from the

RAM disk.
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The first line of the batch file checks for the existence of directory c in
the RAM disk:

if exists ram:c

If directory c exists, the lines directly beneath this line execute.

The next line uses the echo command, which works something like

BASIC'S PRINT command. This displays the contents in quotation

marks on the screen:

echo "Deleting the DOS commands from the RAM disk."II

The assign command is somewhat more complex than echo. It acts

here as an equivalent of BASIC'S IF /THEN. For example, this line

looks for directory c and for DOS commands already in the RAM disk:

assign c: sys:c

If the DOS commands already exist, the next line executes. However, if

the DOS commands aren't in directory c, the batch file goes on to the

section following the else command.

The key line of this section is the line which deletes the files:

delete ram:c all

The program code following the else (alternate case) starts by

displaying a message on the screen:

echo "Copying DOS commands to the RAM disk. "SI

The file creates a directory for the DOS commands:

makedir ram:cSI

The DOS files all copy over to this directory.

copy sys:c to ram:c

This assign command assigns all these files to the RAM disk

directory c:

assign c: ram:cf

The CLI displays a message through an echo command:

echo "The DOS commands are now in the RAM disk."!

And the program ends here:

endifSI
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You can also make bootable Workbench diskettes using the CLI and

BASIC two disk drives. Using CToRAM, the CLI copies the Workbench to a
Workbench formatted diskette.

Execute CToRAM if it isn't already active.

Insert a blank formatted (initialized) diskette into your external disk

drive.

• Make sure the Workbench diskette is in drive dfO:

Enter the following set of CLI commands:

copy sys:c to dfl: 91

copy sys:l to dfl: SI

copy sys: system to dfl: SI

copy sys:devs to dfl: allSI

makedir dfl:sSI

copy sys:s to dflrsSl

copy sys:t to dfl:SI

copy sys:fonts to dfl:SIall

copy sys:libs to dfl:allSI

The blank diskette now contains all the necessary Workbench files. The

diskette copying process takes quite a while with the one disk drive.

You need one more command to create a bootable diskette—install.

This makes a normal diskette which contains all the necessary

Workbench programs into a booting Workbench diskette.

• Enter:

install dfO:

The procedure ends; you now have a bootable diskette.

Insert the Extras diskette in drive dfD: and enter:

copy df0:amigabasic to dfl:

You now have a bootable BASIC diskette.

151





Appendices





Abacus Appendices

Appendices

These Appendices contain information you may not find elsewhere in

this book.

Appendix A is a short course in troubleshooting your Amiga. Most of

these solutions apply to your first time assembling and turning on your

Amiga. The problems consist of the little things that can go wrong

when your starting out.

Appendix B is a list of terms. Most of these terms already appeared in

the book, and may need more explanation. There are also words here

that didn't appear in the book at all, and are listed here with definitions

for later reference.

Appendix C depicts each icon type used by Intuition, together with

descriptions of these icons.

Appendix D offers instructions for using IconEd (the icon editor) for

creating your own icons, or editing the icons that already exist on your

diskettes.

Appendix E contains a few general technical notes about the Amiga and

its internal features (circuitry, video and sound, etc.).

155



Appendices Amiga for Beginners

First aid

PROBLEM: No screen display.

SOLUTION: There could be several reasons for this. You have forgotten to plug the

monitor into the wall socket, or you didn't connect the monitor to the

computer. If your using the Amiga monitor (i.e., the Commodore RGB

monitor), make sure that the VIDEO MODE switch under the door is

switched to RGB. The switch should be in the far right position. This

could also happen on other RGB monitors.

PROBLEM: No sound.

SOLUTION: First, check the volume control on your monitor; it may be all the way

off. Second, make sure that the Amiga sound output is connected to a

monitor or stereo system (see Section 1.1 of this book for connecting

instructions).

PROBLEM: The BASIC window, CLI and Notepad reject any input.

SOLUTION: This most often occurs when you run a BASIC program and click the

pointer on the LIST window. Now you can't enter any data in the

BASIC window until you click on the BASIC window again.

This fault can also occur on the Amiga 1000 or 2000 if the keyboard

cable becomes disconnected.

PROBLEM: Computer ignores mouse input

SOLUTION: Be sure your mouse is plugged into JOYSTICK 1. If the mouse still

doesn't work, open the mouse and make sure that the mouse's ball

moves freely. You may need to open the mouse to free up the ball (see

Section 1.2 for instructions on opening the mouse).

PROBLEM: Newly formatted diskette window's disk gauge says that the diskette is

full.

SOLUTION: If the disk gauge says that the diskette is full, and you just copied or

formatted it, or it only contains a few files, then you're in trouble. You

probably removed the diskette from the drive while the disk drive LCD

was still on. That act destroys diskette data. The only way to make the

diskette usable again is to reformat it (see Section 2.5 for instructions

on formatting). You might be able to recover some of the files using

the diskdoctor from the CLI (see the next Solution).

156



Abacus A. First Aid

PROBLEM:

SOLUTION:

PROBLEM:

SOLUTION:

PROBLEM:

SOLUTION:

READ/WRITE ERROR displayed on screen.

Occasionally disks may not be running at top efficiency. This is when

READ/WRITE ERRORS occur. That is, the Amiga can no longer access

the diskette. One day a diskette may load fine, the next it may not ever

work again. There are some ways around this problem.

• Format a blank diskette.

If you only have one disk drive, copy directory c over to the RAM

disk.

Start the CLI and enter:

diskdoctor df 0 :5

The Amiga tells you which track has the problem, then attempts to

recover the files on that track.

When the diskdoctor finishes, it requests that you COPY

NECESSARY FILES TO NEW DISK. Enter:

copy dfO:#? to empty: all

Replace the name empty with your own diskette name. This target

diskette must be empty.

Accidentally deleted programs.

This happens frequently: You accidentally delete something you didn't

want to delete. It doesn't matter whether you do this from the

Workbench or from the CLI. Don't save anything else to that diskette

right now, or else you might overwrite the deleted program.

Go to the CLI and activate the diskdoctor.

After the diskdoctor finishes, enter:

Your missing files may or may not be in the directory.

• Enter the following to exit the CLI:

endcliSI

Keys repeat too fast.

Adjust the key repeat rate in Preferences (see Section 2.10 for

instructions).
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PROBLEM: Text display is unreadable.

SOLUTION: You can also solve this by using Preferences. Certain color

combinations make text unreadable (white on white, for example). If

this occurs in Preferences, click on the Reset All gadget. This

changes the Amiga back to its original Workbench colors. If this

problem occurs in BASIC, restart the program. The screen values reset

at the beginning of every BASIC program. As soon as the program

restarts, stop the program by selecting the Stop item from the Run

pulldown menu. Remember to correct the program before you run it

again.

PROBLEM: Icons appear out of nowhere.

SOLUTION: Sometimes, especially just after programming in BASIC, a program

icon which should be in the BASICDemos drawer appears in the

Workbench window instead. You must specify exactly where this

program should be saved. To return the icon where it belongs, drag the

icon to the correct drawer or diskette icon.

PROBLEM: Hies disappear.

SOLUTION: The program may be stored in the wrong drawer. Look through all the

drawers and windows. If you still haven't found the program, you've

managed to bypass all the built-in safety features of the Amiga, and

erased the program without saving it.

PROBLEM: Program constantly produces software errors.

SOLUTION: Software errors can be caused by almost anything within a program.

There's one problem, however, that often can be solved by the user.

Some programs cannot run on an Amiga with more than 512K of

memory. If you have memory expansion going above 512K, double

click the NoFastMem icon in the System drawer before running the

problem program. This cuts the additional memory off, allowing the

program to run properly. If this still doesn't work, contact the software

manufacturer or dealer and ask about updates or error reports for the

program. After all, it's possible that other people have encountered the

same problem, and that it has been resolved in the meantime.

PROBLEM: Problems not mentioned above.

SOLUTION: See your dealer. First try to determine whether it is a hardware or

software failure. For example, if the Amiga consistently rejects the

Workbench diskette, the fault probably lies in the software. Take the

diskette to the dealer. Only visit the dealer when all else fails.
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B Icons

This is a summary of the most important icons in the Amiga operating

system. Look for the icon you want information on; the description

appears below the icon.

Drawers in Intuition correspond to directories in AmigaDOS. The

easiest way of creating drawers on your own diskettes is dragging the

Empty drawer icon from the Workbench window to your own

diskette window, and rename the drawer in your window.

Double-click the Preferences icon to change almost any aspect of

the screen display, such as color, pointer speed and time setting. You

can also set your printer driver and output parameters from

Preferences.

This is the Clock icon. You can display the clock in analog or digital

format (with or without hands), and in 12-hour or 24-hour format. The

Amiga clock also has an alarm. Set the clock time from

Preferences (see Section 2.9 for more information).
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The Trashcan icon is your area for file disposal. You can remove

icons from the Trashcan if you haven't selected the Empty Trash

item from the Disk menu in the Workbench (see Section 2.8 for

more information).

Disk icons represent diskettes in the Amiga disk drives. Double-

clicking a diskette icon opens diskette windows.

This is the icon for starting AmigaBASIC. Double-clicking produces a

BASIC window and a LIST window ready for programming.

This icon represents an AmigaBASIC program. Double-clicking this

icon executes the program if AmigaBASIC is also available.
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All files bearing this icon are data files used by programs (for example,

files generated by IconEd or ObjEdit).

Double-clicking this icon opens a CLX window in which DOS

commands can be entered (see Chapter 4 for more information on the

CLI).

This icon opens IconEd, used for editing and changing icons in the

Amiga operating system (see Appendix £ for information on using

IconEd).

Notepad is a program for writing short messages. It also permits the

use of various fonts and typestyles (see Section 2.6).
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This is an icon for a Notepad text. It represents any files created

using the Notepad utility (see Section 2.6).

This icon represents the Amiga Calculator, which lets you perform

simple arithmetic (see Section 2.6 for further information).

This icon represents a diskette copying program. Use it to make backup

copies of all important diskettes (see Section 2.5 for instructions).

This icon represents the Say program, which enables the Amigafs

speech capabilities.
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Double-clicking this icon sends a hardcopy of the current screen

contents to a printer.

This icon calls a program for setting the Amiga's keyboard layout.

When you need a different keyboard setup, you can set the keyboard

from the SetMap info window then double-click the SetMap icon

(see Section 2.5 for more information on SetMap).

This icon signals an expanded Amiga 500 to block out the additional

512K of memory without turning off the memory expansion. The

reason for this is that some programs cannot run with more than S12K

of memory.
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Brief computer glossary

Alert

Assembler

BASIC

interpreter

Bit

Block

Byte

CAD

Central

processing

unit

Chips

This is a type of requester that appears at the top of the screen when the

Amiga has a major error. Alerts display in red, with a blinking border,

red lettering and a black background. Follow the Amiga's instructions

to get out of it (see also Guru meditation).

An assembler lets you enter and run programs in machine language.

Machine language is quicker than BASIC because there is no need to

translate the command through an interpreter (see BASIC interpreter).

However, machine language is very difficult to learn.

This program continuously runs in the computer once you load

AmigaBASIC. It enables the computer to interpret and execute

commands entered by a user in the BASIC language.

Bit is an abbreviation for Binary digiT. This is the smallest data unit a

computer can process. A bit can have a value of either 1 or 0, which

reduces the likelihood of data transmission errors. As the numbers get

larger, the numbers of 0s and Is increase. 8 bits equal 1 byte.

Memory on diskette is measured in blocks. For example, a file of about

543 bytes in length takes up about 2 blocks on diskette. Blocks appear

in Info windows.

Every memory cell in the Amiga consists of one byte (eight bits). The

highest figure a byte can represent is 255, since 255 in the binary

number system = 11111111. A byte can also represent a letter or

character. The internal memory capacity of the Amiga 500 comprises a

maximum of 524,288 such characters.

C is another programming language. It is very fast, and once mastered,

offers the user no end of opportunities on the Amiga. C is very difficult

to learn.

CAD stands for Computer Aided Design. This process speeds up the

design aspects of many fields, from architecture to auto manufacturing.

The most common use of this term refers to the main chip of a

computer (for example, the 68000 micorprocessor in the Amiga). This

book uses central processing unit to describe the Amiga itself.

Everything in the computer depends on the chips. Each chip contains

hundreds of electronic circuits. These circuits control the sound, graphic

and logic systems of the Amiga.
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Cinch cable The Amiga has 2 cinch outputs for connecting its audio output to

stereo equipment. Another term for cinch cable is RCA cable.

Cold start You perform a cold start when you turn on the Amiga (see also Warm

start).

Compatible Something is compatible if it operates or agrees with something else. If
your printer works with the Amiga, then it's compatible. If your hard

disk doesn't work with your Amiga, it's incompatible.

Computer Computers simulate animation by continually erasing and redisplaying

animation dots on the screen. This is best explained in the animation demo in
Section 3.7. The quality of the animation depends on the speed of the

computer and the quality of the picture.

Cursor The cursor is an entry marker. Different cursors appear on the Amiga
screen, according to whether you are programming in BASIC or

entering DOS commands. The Amiga system also has the mouse

pointer (the arrow moved by the mouse).

Diskette Diskettes are small plastic boxes containing magnetic media. This

magnetic media holds data placed on it by a disk drive, and can be

recalled by the Amiga at any time.

DOS Short for disk operating system. This is the program which controls all

operations between the computer and the disk drives. It has its own

interpreter, allowing you to enter commands direct. The Amiga's DOS

is accessible through the CLI.

Editing Editing is the process of changing text or program code within the

computer. For example, a program can be edited, or the mouse pointer

can be edited from Preferences.

Expansion This is the external computer connector which permits adding memory

port andperiphals.

File Files are any computer data stored on diskette. The word can refer to

programs, graphics or data.

Guru When the Amiga stops working because of software problems, system

meditation crashes (see Section 2.5) etc., an alert appears at the top of the screen,

calling the error a Guru Meditation. There's nothing you can do

about this when it happens; just follow the instructions in the alert.

Hardware The computer, the chips inside and the keyboard are hardware. Printers

and external disk drives are also sometimes called hardware, but are

usually referred to as peripherals.

Modem Short for MODulator/DEModulator. This device converts Amiga

signals into electrical impulses and transmits these impulses over

telephone lines, and converts received impulses back into signals

understandable by the Amiga.
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Multitasking This is the name given to the Amiga's ability to perform several tasks

simultaneously.

Operating A computer has to know certain facts automatically. If the Amiga starts

system without a diskette inserted, the system notices this and requests the

Workbench diskette. The operating system ensures that the Amiga

performs its initial tasks and checks for keyboard or mouse input.

Peripheral All external units connected to the Amiga. External disk drives,

printers, modems, etc. are peripherals.

Pixel Pixels are the individual dots on the screen. Coordinate (0,0) of the

Amiga screen represents one pixel. The more pixels a computer can

display, the better the resolution. The resolution defines the maximum

number of dots into which a screen can be divided. The higher the

resolution, the better and more reliable the display.

Printer Printers convey data to paper. The Amiga accepts a wide range of

printers (see Section 2.10 for the current printer list). Two types of

printers are most common: dot-matrix printers and daisywheel printers.

Dot-matrix printers can print graphics, and daisywheel printers cannot

Until recently the main advantage of a daisywheel printer was that it

produced letter quality type. A daisywheel printer is simply a typewriter

connected to a computer. Manufacturers have recently produced printers

that can print Near Letter Quality (NLQ) print

RAM Random Access Memory. RAM is the free memory of the computer,

the area used by you and your program. This memory can be read from

and written to, and erases when you turn the computer's power off.

ROM Read Only Memory. ROM is the opposite of RAM: memory which

allows you no access. The ROM contains the operating system. ROM

cannot be erased when you turn the computer's power off.

Software Any programs located on diskettes or in other forms.

Warm start Warm starting the Amiga means restarting it without turning it off.

Pressing <CtrlxCommodore logo> (or left <Amiga>) right <Amiga>

executes a warm start. Note for Amiga 1000 owners: When you

perform a warm start, the Amiga 1000 doesn't need your Kickstart

diskette—it goes right on to the Workbench phase of startup.
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D The icon editor

The icon editor lets you create stunning icons for any program. For

instance, in the lotto program, you could make an icon of little balls

instead of the usual BASIC program icon. A videocassette database
program could have a camera icon, a statistical graphics program could

have a bar graph icon, etc.

Every time you load, edit and save a program in AmigaBASIC, an icon

created before this editing session self-destructs and returns to the
normal BASIC program icon. You'll save time and effort by creating a

new icon after you finish the editing phases of the program. You also

might want to store your favorite icon designs in a separate drawer for

later use.

Double-click the System drawer icon in the Workbench

window.

• Double-click the IconEd icon.

Once the editor loads, a large white window appears. This window

contains general data about the icon types available. Throughout this

book you've seen that the Amiga has a separate information file for

each program. Think of all the data displayed in the info window. One

important piece of information is the program's source (BASIC,

Notepad, etc.). The Amiga stores this information in a file that has

the same name as the program itself, except for the addition of an

. info suffix on the end of its name.When you create new icons, make

sure you use icons of the same or similar type as the new program.

Here's an overview of the various icon types:

Tvpe

diskette

directoiy

tool

project file

Example

Workbench icon

empty drawer

icon ed. icon

notepad project icon

• Click on the OK gadget.

Now the icon editor displays the editor icon itself, in a large frame (the
Editor window) and in nine smaller frames. The small frames could
each contain different icons, since the icon editor lets you process up to

nine icons at once.

Before you load an icon to be changed, you must specify the frame of

the icon you want changed.
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• Click on the third frame of the top row.

This frame turns black, indicating that this frame is active.

• Click on the top left small frame.

• Press and hold the right mouse button.

A menu bar appears at the top of the screen:

Color Copy Move Text Disk Misc HiLite

Move the pointer to the Disk menu title, and select the Load

Data item.

Now a black requester appears. A string gadget below the heading Load

Icon Image Data lets you type in the name of the icon you want

loaded.

• Click on the string gadget.

• If the field already contains text, use the <Backspace> key to erase

everything to the left of the cursor, and the <Del> key to erase

everything to the right of the cursor.

• Enter:

df0:trashcan

• Click the Load Icon Image gadget.

The Trashcan icon appears in the large frame and the upper left small

frame.

You already know from the section on AmigaDOS that the Amiga has

subdirectories. If, for example, you wish to load a program called

Dialog from the BASICDemos drawer (subdirectory), then you must

also specify this:

df0:BASICDemos/Dialog

The disk drive must always be specified as well. It is essential that you

already know the name of the icon you wish to change, because the
editor has no DIR or LIST command available.

Whenever you wish to load other icons, you must activate a new frame

into which the icon goes. Anything else in this frame erases.

The Color pulldown menu enables you to specify the color in which

Color you wish to draw. Select the color you want. The active color has a
checkmark to the left of the color bar.
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This menu moves icons between icon frames. The Undo Frame item
Copy cancels all changes made to an icon, provided the original icon is still

on diskette. The Snapshot Frame item stores the image currently in
the Editor window. Selecting Undo Frame restores the original

icon.

Select the Snapshot Frame item from the Copy pulldown

menu.

From Frame relocates an icon from one frame into the currently active

frame. The window from which the copy comes is indicated by a set of

number options.

Move the pointer onto the From Frame item of the Copy

pulldown menu (do not release the right mouse button).

A set of number options appears, numbered 1 to 9.

• Move the pointer onto the option number 4 and release the right

mouse button.

The Trashcan icon disappears. From Frame transfers the old icon

to the Editor window, and erases the old icon from its original
frame. However, you clicked Snapshot Frame earlier, so you can

easily restore the Trashcan icon.

Select the Undo Frame item from the Copy pulldown menu.

You can also copy the Trashcan icon using this method:

• Click the upper right frame.

Press and hold the right mouse button and move the pointer onto

the Copy pulldown menu.

Move the pointer onto the From Frame item.

Move the pointer onto option number 1 and release the right

mouse button.

You now have a duplicate of the Trashcan icon.

The Merge With Frame item lets you merge two icons in one

frame.

Select 2 from the Merge With Frame item.

This displays the icon editor icon on top of the Trashcan. However,

the colors have changed. The Trashcan remains almost the same

except that part of its black line has disappeared. But the icon editor is a
completely different color. The reason is that certain color conditions
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apply to the editor. The following explanation assumes that your
Amiga system uses the default Workbench colors:

When blue overlaps any other color, the other color appears instead.
When orange overlaps white or black, orange appears.

Keep these color combinations in mind when merging different icon
frames.

You can now perform one of the basic items of the editor, drawing with
the mouse cursor, just as you learned with the Pointer
Editing window in Preferences (see Section 2.10).

• Drag the pointer into the Editor window field.

• Press and hold the left mouse button and move the mouse.

This draws lines in the Editor window. The lines here are finer,
which lets you create higher quality graphics.

Select another color from the Color pulldown menu.

Move the pointer into the Editor window again.

Press and hold the left mouse button and move the pointer around.

This line appears in the selected color.

• Select the Undo Frame item from the Copy pulldown menu to
display the original Trashcan icon.

The Move pulldown menu has two items. The In-Frame item
Move moves icons within the Editor window.

• Select the In-Frame item from the Move pulldown menu.

A black requester named Move Image In-Frame appears. This
requester contains four arrow gadgets (up, down, right and left) and a

blank box in the center of these arrows. The icon moves in the direction
of the arrow you click. If you click the up arrow gadget, the icon moves
up, and so on. The box in the center of the arrow gadgets restores the
icon to its original position in the Editor window.

This requester defaults to the Single gadget, which moves the icon in
single steps. If you click on the Repeat gadget, the icon moves in the
direction selected for as long as you hold the left mouse button. Click
on the OK gadget to accept the new icon position, or the Cancel

gadget to exit this requester and return the icon to its original position.

Click on the Cancel gadget.
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The Exchange With Frame item exchanges the active icon frame

with the icon frame selected from the numbered option.

This menu lets you enter text on the icon. Do not confuse the text on

Text the icon with the name below it; the Amiga assigns this program name
to the icon. The Text menu has just one item, Write Into

Frame.

• Select the Write Into Frame item from the Text pulldown

menu.

A string gadget appears, into which any text can be entered.

• Click the Text string gadget and enter text.

The Amiga limits you to the amount of text you can enter. The screen

flashes if the text is too long.

The Foreground gadget specifies the text color, and the
Background gadget specifies the background color.

• Click the Foreground gadget until you see a Workbench color

you like.

• Click the Background gadget until you see a Workbench color

you like.

The Font gadget specifies the font size. There are only two options:
TOPAZ_SIXTY and TOPAZ_EIGHTY.

The Mode gadget offers four types of text display. JAM 1 displays the
text directly on the icon (i.e., in the foreground color). JAM 2 displays
the text in the selected background color. COMPLEMENT displays the
exact complement of the background color for the text. That is, a blue
text appears on an orange background. However, if there is a black dot
within the orange area, the text there appears in white. INVERSE

reverses the colors and interchanges the text and background colors.

The Position gadget specifies the location of the text. When you
click on Position, the requester displayed is almost the same as the
requester from the In-Frame item of the Move pulldown menu.

Click on the Po s ition gadget

• Look at the requester, then click on its Cancel gadget.

The Reset gadget resets the text window to its initial values. The
Cancel gadget stops the process without changing the icon text, and
the OK gadget accepts all the changes in the Editor window.
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The Disk pulldown menu has items for saving and loading data.
Disk When you select the Save Data item, the Save Icon Image

Data requester displays the last icon name used.

This menu title is the abbreviation for Miscellaneous. The Clear

Mi S C This Frame item erases the contents of the Editor window. The
Flood Fill item fills in enclosed areas.

• Select the Flood Fill item from the Misc pulldown menu.

This displays Flood Fill Activated in the title bar. If you now

click within an area such as the Trashcan icon's lid, the entire area

fills with the selected color. Remember to select the color before
performing this operation.

• Click within the Trashcan icon's lid.

Flood Fill deactivates immediately after use.

The Set Bottom Border item sets the spacing between the bottom

of the icon and the icon's program name. The option offers 0 (no space)
or 1 (one space).

This last menu title specifies whether the icon should appear in
HiLite Inverse (black becomes white, etc.) or Backfill (different

background color).

• Select the Save Data item from the Disk pulldown menu.

A requester containing a string gadget and three other gadgets appears.

The string gadget accepts filename input This gadget retains the last

icon name used for loading data or saving data. The <Backspace> and
<Del> keys erase text

The Save gadget saves the icon to diskette. The Cancel gadget exits
the requester without saving the icon data.

The Frame and Save gadget lets you select the size of the area
around your icon before saving.

Click the Frame and Save gadget.

• Click in the upper left corner of the Editor window icon.

• Move the mouse down and to the right of the icon.

A rectangular frame moves with the pointer.

• Surround the icon with the frame and press the left mouse button.

The Amiga saves the icon you have designed.
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E Technical data

Processor

User RAM

System ROM

Mass storage

Graphics

Motorola MC 68000 with a clock speed of 7.16 MHz.

512 kilobytes available, internally expandable to 1 megabyte, externally

expandable to 8 megabytes (Amiga 1000: 256 kilobytes available,

expandable to 512 kilobytes).

256 kilobytes of ROM, containing startup data (Amiga 1000 uses the

Kickstart diskette instead of system ROM).

Built-in floppy disk drive, uses 3.5" double-sided, double density floppy

diskettes, with a capacity of about 900 kilobytes per diskette. External

floppy disk drives are available.

Interfaces

Serial keyboard connector with coiled cable (Amiga 1000 only).

RS-232 (serial) interface for connection to a modem, etc.

Centronics (parallel) interface for connection to printers.

Dual joystick/mouse/paddle jacks.

Two audio outputs for connection to a stereo system.

RGB for connection to an RGB monitor.

MONO for connecting to monochrome monitor.

Video display modes:

320x200 pixels with 32 possible colors, using a scan frequency

of 60 Hz (interlaced). Two colors displayed require about 10

kilobytes of memory. 32 colors require 50 kilobytes.

320x400 pixels with 32 possible colors, using a scan frequency

of 30 Hz (interlaced). Two colors displayed require about 20

kilobytes of memory. 32 colors require 100 kilobytes.

640x200 pixels with 16 possible colors, using a scan frequency

of 60 Hz. Two colors displayed require about 20 kilobytes of

memory. 16 colors require 80 kilobytes.
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640x400 pixels with 16 possible colors, using a scan frequency
of 320 Hz (interlaced). Two colors displayed require about 40
kilobytes of memory. 16 colors require 160 kilobytes.

There are a possible 4096 colors available on the palette. The graphic
processor can have all 4096 colors on the screen in hold and modify

mode (HAM), but your screen design is limited in this mode.

The processor can build two different screen displays simultaneously

with 8 different colors (not to be confused with window colors).

In addition, 8 sprites can be simultaneously displayed, with a 16 pixel

horizontal resolution and an unlimited vertical resolution. The graphic
processor (blitter) can use any part of RAM for display memory, and

can rapidly transfer other data quickly through the DMA.

Sound 4 channel synthesizer uses a variable waveform with 8-bit resolution at

0 to 7000Hz. Can also generate speech from phonetic interpretation of
text.
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Amiga

Books
Great introductory book!

Amiga for Beginners
A perfect introductory book if you're a new or prospective Amiga

owner. Amiga for Beginners introduces you to Intuition (the

Amioa's graphic interface), the mouse, the windows, the versatile

CLI—this first volume in our Amiga series explains every

practical aspect of the Amiga in plain English. Includes clear,

step-by-step instructions for common Amiga tasks. Amiga for

Beginners is all the info you need to get up and running with

your Amiga 500,1000 or 2000. Topics include: -Unpacking and

connecting the Amiga's components -Starting up your Amiga

•Windows -Files -Customizing the Workbench -Exploring the

Extras disk -Taking your first steps in the AmigaBASIC

programming language -BASIC graphics commands -BASIC

animation -AmigaDOS functions -Using the CLI to perform

"housekeeping" chores -First Aid appendix -Keyword appendix

•Technical appendix -Glossary. Available December 87.200

pages. (Optional program diskette not available).

(630) $16.95

"How-to" BASIC tutorial

AmigaBASIC—

Inside & Out
Above and beyond any BASIC tutorial you've ever seen. This

definitive 550-page volume will turn you into an AmioaBASIC

£X££TI- AmigaBASIC—Inside & Out teaches you Amioa

BASIC with a "hands-on," program-oriented approach, and

explains the language in a clear, easy to understand style. Topics

include: -Fundamental concepts of BASIC -Completely details

all AmigaBASIC commands, with syntax and parameters

•Graphic objects and color control -Interchange file format (IFF)

•Voice synthesis, sound & music -Sequential & random access

files -Complete Reference Section includes Glossary,

AmioaBASIC Reference Guide, error message descriptions.

After you've learned BASIC with AmigaBASIC—Inside &

Out, you'll have many useful, working programs: -Video titling

program for high-quality OBJECT animation on your VCR tapes

•IFF-compatible paint program (lets you load in graphics created

on other graphic programs) -Bar graph & pie chart program

•Simple music synthesizer -Speech synthesis utility program

•Full-featured database.

Available November 1987.550 pages.

(610) $24.95

(612) Optional program diskette $14.95

Insider's secretsl

Amiga Tricks & Tips
A superb collection of quick hitters for all Amiga owners.

Patterned after our best-selling Tricks & Tips books for the

Commodore 64 & Commodore 128, Amiga Tricks & Tips

contains dozens of programming techniques and program listings

that anyone with an Amiga computer can use, whether you're a

beginner or a seasoned programmer. Amiga Tricks & Tips is

easy to understand, and lists program examples in BASIC. It's

packed with vital Amiga info: -Details on windows and gadgets

•Using disk-resident fonts -Tips for printing hardcopy -Creating

yourown requesters •Accessing Amiga libraries fromBASIC

•Reserving important 68000 memory -CLI command overview

•Getting the most out of the ED editor •Customizing your own

Workbench •Controlling Intuition •AmigaDOS functions -Hints

for effective programming

Available January 88.300 pages.

(615) $19.95

(617) Optional program diskette

Guide to Amiga 68000 language

$14.95

Amiga Machine Language
The practical guide for learning how to program your Amiga in

ultrafast machine language. Used in conjunction with our

AssemPro Amiga software package, Amiga Machine

Language is a comprehensive introduction to 68000 assembler/

machine language programming. Topics include:

• 68000 microprocessor architecture -68000 address modes and

instruction set -Accessing the Amiga's RAM memory, operating

system and multitasking capabilities -Details the powerful Amioa

libraries for using AmioaDOS (input, output, disk and printer

operations) -Details Intuition (windows, screens, requesters,

pulldown menus) -Speech and sound facilities from machine

language -Many useful programs listed and explained.

Available January 88.225 pages.

(660) $19.95

(662) Optional program diskette $14.95

fP|Opf/o/ia/ Program Diskettes

contain all ofthe programsfound in these

books—complete, error-free and ready to run.

Save yourselfthe time and and trouble oftyping

in the program listings. Each diskette: $1495.

■ ■ i

More Amiga books

coming soon!



Selected Abacus Products for the Amiga computers

TextPro
The Ideal Word Processing

Package for the Amiga

TextPro Amiga is an full-function word processing

package that shares the true spirit of the Amiga: easy to

use, fast and powerful—with a surprising number of

"extra" features.

You can write your first TextPro documents without

even reading the manual. Select options from the

dropdown menus with your mouse, or use the time-saving

shortcut keys to edit, format and print your documents.

Yet TextPro is much more than a beginner's package. It

has the professional features you need for all of your

printed documents. Fast formatting on the screen: bold,

italic, underline, etc. Centering and margin justification.

Page headers and footers. Automatic hyphenation of text.

You can customize the TextPro keyboard and function

keys to suit your own style. Even merge IFF-format

graphics right into your documents. TextPro includes

BTSnap, & utility for saving IFF graphics that you can

use in your graphics programs. This package can also

convert and print other popular word processor files.

TextPro is output-oriented. This means you can print

your documents to exact specifications—and get top

performance out of your dot-matrix or letter quality

printer. (Printer drivers included on diskette let you

customize TextPro to virtually any printer on the

market). The complete tutorial and manual shows you

how it's all done, step by step.

TextPro sets a new standard for word processors in its

price range. Easy to use, packed with advanced features—

it's the Ideal package for all of your wordprocessing needs.

Backed by the Abacus 30-day MoneyBack

Guarantee.

Suggested retail price: $79.95

Features

Fast editing and formatting on screen

Display bold, italic, underline, superscript and subscript

characters

Select options from dropdown menus or handy shortcut

keys

Automatic wordwrap & page numbering

Sophisticated tab and indent options, with centering &

margin justification

Move, Copy, Delete, Search &Replace options

Automatic hyphenation

Customize up to 30 function keys to store often-used

text, macro commands

Merge IFF format graphics into your documents

Includes BTSnap program for saving IFF graphics from

any program

Load & save files through RS-232 port

Flexible, ultrafast printer output—printer drivers for

most popular dot-matrix & letter quality printers included

Comprehensive tutorial and manual

Not copy protected
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AssemPro

Machine Language Development

System for the Amiga

Bridge the gap between slow higher-level languages and

ultra-fast machine language programming: AssemPro

Amiga unlocks the full power of the AMIGA'S 68000

processor. It's a complete developer's kit for rapidly

developing machine language/assembler programs on your

Amiga. AssemPro has everything you need to write

professional-quality programs "down to the bare metal":

editor, debugger, disassembler & reassembler.

Yet AssemPro isn't just for the 68000 experts.

AssemPro is easy to use. You select options from

dropdown menus or with shortcut keys, which makes your

program development a much simpler process. With the

optional Abacus book Amiga Machine Language

{see page 3), AssemPro is the perfect introduction to

Amiga machine language development and programming.

AssemPro also has the professional features that

advanced programmers look for. Lots of "extras" eliminate

the most tedious, repetitious and time-consuming m/1

programming tasks. Like syntax error search/replace

functions to speed program alterations and debugging. And

you can compile to memory for lightning speed. The

comprehensive tutorial and manual have the detailed

information you need for fast, effective programming.

AssemPro Amiga offers more professional features,

speed, sheer power, and ease of operation than any

assembler package we've seen for the money. Test drive

your AssemPro Amiga with the security of the

Abacus 30-day MoneyBack Guarantee. Available

January 1988.

Suggested retail price: $99.95

Features
Integrated Editor, Debugger, Disassembler and

Reassembler

Large operating system library

Runs under CLI and Workbench

Produces either PC-relocatable or absolute code

Create custom macros for nearly any parameter (of

different types)

Error search and replace functions

Cross-reference list

Menu-controlled conditional and repeated assembly

Full 32-bit arithmetic

Advanced debugger with 68020 single-step emulation

Written completely in machine language for ultra-fast

operation

Runs on any Amiga with 512K or more and Kickstart

version 1.2

Not copy protected

Machine languageprogramming requires a solid understanding
of the AMIGA'snardware ana operating system. We do not

recommend thispackage to beginning Amigaprogrammers
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BeckerText

Powerful Word Processing
Package for the Amiga

BeckerText Amiga is more than just a word processor.

BeckerText Amiga gives you all of the easy-to-use

features found in our TextPro Amiga, plus it lets you
do a whole lot more. You can merge sophisticated IFF-
graphics anywhere in your document You can hyphenate,

create indexes and generate a table of contents for your

documents, automatically. And what you see on the

BeckerText screen is what you get when you print the

document—real WYSIWYG formatting on your Amiga.

But BeckerText gives you still more: it lets you

perform calculations of numerical data within your

documents, using flexible templates to add, subtract,

multiply and divide up to five columns of numbers on a

page. BeckerText can also display and print multiple

columns of text, up to five columns per page, for

professional-looking newsletters, presentations, reports,

etc. Its expandable built-in spell checker eliminates those

distracting typographical errors.

BeckerText works with most popular dot-matrix and

letter-quality printers, and even the latest laser printers for

typeset-quality output. Includes comprehensive tutorial

and manual.

BeckerText gives you the power and flexibility that you

need to produce the professional-quality documents that

you demand.

When you need more from your word processor than just

word processing, you need BeckerText Amiga.

Discover the power of BeckerText. Available February

1988.

Suggested retail price: $150.00

Features

• Select options from pulldown menus or handy shortcut

keys

• Fast, true WYSIWYG formatting

• Bold, italic, underline, superscript and subscript

characters

• Automatic wordwrap and page numbering

• Sophisticated tab and indent options, with centering and

margin justification

• Move, Copy, Delete, Search and Replace

• Automatic hyphenation, with automatic table of

contents and index generation

• Write up to 999 characters per line with horizontal

scrolling feature

• Check spelling as you write or interactively proof

document; add to dictionary

• Performs calculations within your documents—

calculate in columns with flexible templates

• Customize 30 function keys to store often-used text

and macro commands

• Merge IFF graphics into documents

• Includes BTSnap program for converting text blocks to

IFF graphics

• C-source mode for quick and easy C language program

editing

• Print up to 5 columns on a single page

• Adapts to virtually any dot-matrix, letter-quality or laser

printer

• Comprehensive tutorial and manual

• Not copy protected
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DataRetrieve

A Powerful Database Manager

for the Amiga

Imagine a powerful database for your Amiga: one that's

fast, has a huge data capacity, yet is easy to work with.

Now think DataRetrieve Amiga. It works the same

way as your Amiga—graphic and intuitive, with no

obscure commands. You quickly set up your data files

using convenient on-screen templates called masks. Select

commands from the pulldown menus or time-saving

shortcut keys. Customize the masks with different text

fonts, styles, colors, sizes and graphics. If you have any

questions, Help screens are available at the touch of a

button. And DataRetrieve's 128-page manual is clear

and comprehensive.

DataRetrieve is easy to use—but it also has

professional features for your most demanding database

applications. Password security for your data.

Sophisticated indexing with variable precision. Full

Search and Select functions. File sizes, data sets and data

fields limited only by your memory and disk storage

space. Customize up to 20 function keys to store macro

commands and often-used text. For optimum access speed,

DataRetrieve takes advantage of the Amiga's multi

tasking.

You can exchange data with TextPro Amiga,

BeckerText Amiga and other packages to easily

produce form letters, mailing labels, index cards,

bulletins, etc. DataRetrieve prints data reports to most

dot-matrix & letter-quality printers.

DataRetrieve is the perfect database for your Amiga.

Get this proven system today with the assurance of the

Abacus 30-day MoneyBack Guarantee.

Suggested retail price: $79.95

Features

Select commands and options from the pulldown menus

or shortcut keys

Enter data into convenient screenmasks

Enhance screen masks with different text styles, fonts,

colors, graphics, etc.

Work with 8 databases concurrently

Define different field types: text, date, time, numeric &

selection

Customize 20 function keys to store macro commands

and text

Specify up to 80 index fields for superfast access to

your data

Perform simple or complex data searches

Create subsets of a larger database for even faster

operation

Exchange data with other packages: form letters,

mailing lists etc.

Produce custom printer forms: index cards, labels,

Rolodex*cards, etc. Adapts to most dot-matrix & letter-

quality printers

Protect your data with passwords

Get Help from online screens

Not copy protected

• Max. file size

• Max. data record size

• Max. data set

• Max. no. of data fields

• Max. field size

Limited only

by your memory

and disk space



How to Order
AbacusKffl 5370 52nd Street SE Grand Rapids, Ml 49508

All of our Amiga products-application and language

software, and our Amiga Reference Library-are available at

more than 2000 dealers in the U.S. and Canada. To find out

the location of the Abacus dealer nearest you, call:

(616) 698-0330

8:30 am-8:00 pm Eastern Standard Time

Or order from Abacus directly by phone with your credit
card. We accept Mastercard, Visa and American Express.

Every one of our software packages is backed by the

Abacus 30-Day Guarantee—if for any reason you're not

satisfied by the software purchased directly from us, simply

return the product for a full refund of the purchase price.

Order Blank

Name:

Address:

Citv State Zio Country

Phone:

Otv Name of product Price

Mich, residents add 4% sales tax

Shipping/Handling charge

{Foreign Orders $12 per Item)

Check/Money order TOTAL enclosed

Credit Card#

Expiration date

1









The Amiga is a "us

its icon-based operating system, the Amiga is

ideal for the beginner. But many aspects of

the Amiga can be confusing to the first-time

computer user. Amiga for Beginners helps

you learn the essentials of the Amiga easily

and quickly.

Amiga for Beginners uses a hands-on

approach to teach the first time user every

detail, in clear easy to understand terms, so

you can get the most from your computer.

Amiga for Beginners introduces you to

Intuition (the Amiga's graphic user interface),

the mouse, windows, AmigaBASICk and

even the CLI (Command Line Interpreter).

The clear step-by-step instructions for

common Amiga tasks will get you up and

running fast. The glossary, "first-aid"

appendix, icon appendix and technical 0

appendix are invaluable to the beginner.

Amiga for Beginners topics include:

Unpacking and connecting your Amiga •

starting your Amiga • Windows • Files •

Customizing the Workbench • the Extras

diskette • AmigaBASIC programming • The

mysterious "CLI" • AmigaDOS functions

A complete guide

to learning and

applying the Amiga

Amiga for Beginners includes:

• Complete set-up instructions

• Backing up important diskettes

• The Extras diskette

• Setting Preferences

• Customizing the Workbench

• Introduction to AmigaBASIC

• AmigaDOS commands

• CLI tips and short-cuts

• Creating your own icons

Amiga for Beginners is the essential first

book for all Amiga owners.

ISBN 1-55755-021-5

Abaci 5370 52nd Street SE • Grand Rapids, Ml 49508




